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1 Starting with OpenTM2

e Before you start

e Working with the Translation Workbench
e Working with the Translation Environment
e Working with the OpenTM2 Editor


http://power/opentm2wiki/index.php/Before_you_start
http://power/opentm2wiki/index.php/Working_with_the_Translation_Workbench
http://power/opentm2wiki/index.php/Working_with_the_Translation_Environment
http://power/opentm2wiki/index.php/Working_with_the_OpenTM2_Editor

2 Using OpenTM2 in the Translation Business

2.1 Translation scenarios

OpenTM2 is designed to help you perform your daily translation work. As a flexible tool that can be adapted to your specific requirements it improves
your productivity regardless of the types of documents you translate and the size of your business.

The following scenarios give you an overview of how you can perform your translation tasks using OpenTM2. They show you how to:

¢ Translating a new document

¢ Translating updated documents

¢ Translating with one translator

¢ Translating with several translators

e Exchanging data with other people and systems


http://power/opentm2wiki/index.php/Translating_a_new_document
http://power/opentm2wiki/index.php/Translating_updated_documents
http://power/opentm2wiki/index.php/Translating_with_one_translator
http://power/opentm2wiki/index.php/Translating_with_several_translators
http://power/opentm2wiki/index.php/Exchanging_data_with_other_people_and_systems

3 Working with OpenTM2 components and functions

e General concepts
e Working with documents
e Working with folders


http://power/opentm2wiki/index.php/General_concepts
http://power/opentm2wiki/index.php/Working_with_documents
http://power/opentm2wiki/index.php/Working_with_folders

4 Working with Translation Memory databases

A Translation Memory is a database that contains existing translations. You use a Translation Memory to find and reuse these translations.
During analysis OpenTM2 splits a document into translatable segments, which usually correspond to sentences.

A Translation Memory contains pairs of such segments that consist of an original (source) segment and a translated (target) segment, which together
make up a Translation Memory segment. A Translation Memory can contain source sentences in one source language, and translated sentences in
several target languages.

4.1 Overview and terminology
Translation Memory databases are used during translation and analysis of documents.

¢ During translation in the Translation Environment ,OpenTM2 displays matching sentences as translation proposals for the current sentence.
You can then choose the translation proposal that represents the best translation of the sentence, and copy it into the document you currently
translate.The type of match is always evaluated by comparing a sentence in the source document with source sentences in the Translation
Memory.OpenTM2 proposes both exact matches and fuzzy matches. Exact matches are found if two source segments are completely
identical. Fuzzy matches are found if two source segments are almost identical. TAll types of fuzzy matches are indicated by a character
enclosed in brackets in front of the proposal. For example, [f] indicates a fuzzy match.If two source sentences differ by only a digit or a
number, OpenTM2 proposes this as a fuzzy match, with the number already replaced with the new value. Such a fuzzy replacement match is
indicated by [r]. The various types of matches are described in detail in Translation Memory matches.Whenever you translate a segment,
OpenTM2 automatically adds your translation to the Translation Memory associated with the current document. The Translation Memory is
therefore being continuously updated?the translation of one sentence may even be offered as a translation proposal for the next matching
segment.

¢ During document analysis, you can choose to have OpenTM2 automatically replace sentences with matches that already exist in the
Translation Memory. This substitution occurs only for exact matches.

¢ During document analysis, OpenTM2 can also extract segments with an exact or a fuzzy match from existing Translation Memory
databases and copy these segments into a new one. In this way, you can ?preload? a document-related Translation Memory.

When the same original sentence appears in several places in a document, OpenTM2 also allows you to store several different translations of the
sentence. In this way, you can translate a segment in different ways according to the context.

Translation Memory databases provide an efficient method of translating whenever you deal with similar or repetitive texts (for example revised
editions of manuals).

During translation, you can select automatic substitution. This option automatically copies existing translated segments into the translation document for
as long as it finds exact matches for the current source segments. Automatic copying stops when no exact match, or more than one exact match, has
been found for a source segment. Now you must continue translating the segment manually. Afterwards automatic copying can be restarted.

Translation Memory databases can be even combined with one another. Use the merge option to merge the contents of one Translation Memory
with another.

Translation Memory databases can have two formats:

¢ Internal, called OpenTM2 format. The internal format is used to work with Translation Memory databases within OpenTM2 .

¢ External. The external format is an SGML-based data exchange format that allows the data within Translation Memory databases to be
processed outside of OpenTM2. The data in an external Translation Memory is interspersed between SGML tags that describe the structure
of the Translation Memory as a whole and the data elements of each segment. This format allows you to edit a Translation Memory with a
text editor, for example to change or delete segments in a Translation Memory.

If you have translated documents that were translated outside OpenTM2, you can generate an Initial Translation Memory (/ITM), this means you can fill
a Translation Memory with existing translation segments. When you start the translation of a document that is similar to an existing one, you can
benefit from your previous translations that are now available in the Initial Translation Memory.

An exported Translation Memory in SGML format is also helpful for reusing existing translations. If you have previously saved files or databases in
another format, you can access them with OpenTM2 by using a program to convert them to the format of an external Translation Memory.

4.1.1 Translation Memory matches

During translation in the Translation Environment, OpenTM2 searches for matching segments, this means it checks whether the Translation Memory
contains a previous translation of the current segment.

The system differentiates mainly between an exact match, which is completely identical, and a fuzzy match, which is an almost identical match where
the fuzziness can have various degrees.

When OpenTM2 displays a matching segment in the "Translation" window of the Translation Environment, the type of fuzzy match is indicated by a
preceding flag in brackets, for example [f]. Exact matches do not have such a flag.

An exact match is found when the Translation Memory contains a segment identical to the current segment in the document to be translated and when
the segment translation was accepted by a human translator during translation. The segments must be identical with respect to text and punctuation but
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their tagging can differ.

If an identical source segment is placed in the Translation Memory by the EQFITM command or was imported as machine-generated translation, it is
not regarded as an exact match. It is flagged by a preceding [m].

If you choose a Translation Memory previously used for a BookMaster (®) document, for the translation of machine-readable information, all trailing line

feeds and blanks are removed when an exact match is found. This ensures that the target sentence has as many trailing line feeds as the source
segment.

By default, a fuzzy match is recognized if the two segments overlap more than 33%. You can customize this threshold for segment lengths, as described
in Viewing and changing the system preferences.

OpenTM2 can also show combinations of these types of matches. The following table shows the categories of matches and the flagging displayed in the
"Translation Memory" window.

Type of match Flag
Exact (not flagged)
Matches with minor deviations:
- Machine [m]
- Replacement [r
- Machine and replacement [mr]
Fuzzy matches:
- Fuzzy [f]
- Fuzzy and replacement [rf]
- Fuzzy and machine [mf]

- Fuzzy, machine, and replacement  [mrf]

4.1.2 What you can do with Translation Memory databases

Most of the tasks concerning Translation Memory databases begin from the "Translation Memory List" window.

4.1.2.1 Calling sequence

Select:

1. "Translation Memory List" window from the main window

2. A Translation Memory from the window

3. One of the enabled commands from the File or View menu
This usually takes you to another window, where you can specify the necessary options and parameters and where you can start the requested
procedure.

4.1.3 Creating a Translation Memory

Before you can use a Translation Memory, it must be initialized. To initialize a Translation Memory, you need to specify values for a number of
parameters.

The procedure described here creates an empty Translation Memory. This can subsequently be filled by translating in the Translation Environment,
by copying segments from other Translation Memory databases during analysis, or by importing external Translation Memory databases.

For a description of the other methods of creating and filling a Translation Memory, see:
e Creating an external Translation Memory
¢ Merging Translation Memory databases

4.1.3.1 Prerequisites

At least one language-support file must be installed.

4.1.3.1.1 Calling sequence

Select:

1. The "Translation Memory List"window in the main window
2. New... from the File menu
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The "New Translation Memory" window is displayed.
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Figure 90. New Translation Memory window

4.1.3.1.2 Options and parameters
e Name
Type a name for the new Translation Memory.
¢ Description

Type a description of the new Translation Memory. This description can be up to 40 alphanumeric characters long. It is for your personal use
and is not used by OpenTM2.

¢ Location of Translation Memory
Specify where you want the new Translation Memory to reside. You can keep it on a local disk drive (only you can use it) or on a shared disk
drive (several translators can work with it simultaneously). See Sharing Translation Memory databases to learn about the benefits of
Translation Memory databases residing on a shared disk drive. Local is the default selection. Note that a LAN drive is also considered as
local drive.

¢ Disk drive

Shows local or shared disk drives. Select one of the available disk drives as the drive on which you want the new Translation Memory to
reside. Remember that a Translation Memory grows in size over time, so ensure that the drive you select has sufficient free space.

¢ Source language
Select the source language from the list of languages displayed.

Click Create to create the new Translation Memory.

4.1.3.1.3 Results

The Translation Memory is created, but is still empty. You can now begin to fill it by translating text or by actions such as import, merge, or analysis.
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4.1.4 Creating an external Translation Memory

An external Translation Memory is a file that contains segment pairs from previous translations and SGML tags. The SGML tags are used to
distinguish between control information and the original and translated segments.

SGML format is used as the OpenTM2 data exchange format for Translation Memory databases.

If you have already a translation database in a format of your own and want to use the information in it with OpenTMZ2, you must first convert it into a file
in SGML format, for example, by a conversion program that understands your database format and the SGML format. This file can then be imported into
OpenTM2.

Besides generating an Initial Translation Memory (/TM), this is another method of filling a Translation Memory before beginning a translation.

When you export a Translation Memory, OpenTM2 creates a file in SGML format.

During import, you can also merge an external Translation Memory with an internal Translation Memory.

4.1.4.1 Format of an external Translation Memory

A Translation Memory in SGML-based format includes, in addition to the original and translation segments, SGML tags that describe the data structure
of each segment.

You can also use this format to create an external Translation Memory containing your own translation database data.

An external Translation Memory is an ASCII coded file. It starts with <NTMemoryDb> and ends with </NTMemoryDb>.

The starting tag is followed by a description of the Translation Memory, enclosed between <Description> and </Description> tags.

The description is followed by the segment pairs. The number of segment pairs is not limited. The individual segment pairs are tagged in the following
format:

Example

<Segment>nnnnnnnnnn ?7?7?
<Control> ?2?2°?

? 2?7
<?Control> ???
<Source>...<?Source> ???

<Target>...<?Target> ???
<?Segment> ???

The symbol ??? stands for the combination of the carriage return and the line feed characters. This character combination is usually generated when
you press Enter to return you to the beginning of the next line.

The following describes the SGML structure sequentially.

1. A segment begins with the <Segment> tag.
2. The segment identifier nnnnnnnnnn must immediately follow the <Segment> tag and must be 10 characters long. This identifier must be
unique within the Translation Memory

4. The next tag is <Control> , and is followed by ???.

5. The next line is a sequence of numbers representing the segment control information, which is described in ?Control information of a
Translation Memory segment?

6. The control information must be terminated by the </Control> tag and be followed by ???

7. .The next tag is <Source>, followed by the source segment. It is ended by </Source>, followed by ??? . If ??? appears in the source
segment, it is considered to be part of the source.

8. The next tag is <Target>, followed by the target segment. It is ended by </Target>, followed by a ???. If ??? appears in the target segment,
it is considered to be part of the target.

9. The last tag of a segment is </Segment>, followed by ??7?.

The Translation Memory format shows a small part of an external Translation Memory.

4.1.4.2 The Translation Memory format

The following shows part of an SGML-based Translation Memory containing two segments. The separator in the segment control information is
indicated by the symbol ?. The combination of the carriage return and the line feed characters ( ???) is not shown in this example.

<NTMemoryDb>
<Description>
This is a Translation Memory sample
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</Description>

<Segment>0000000001

<Control>
0000152020000000668798940?English (U.S.) ?German (national) ? ?EQFBOOK?DEMO. SCR
</Control>

<Source>The amount of data that you wish to process

</Source>

<Target>Die Datenmenge, die verarbeitet werden soll

</Target>

</Segment>

?

<Segment>0000000043

<Control>
0000032020000000668798783?English (U.S.) ?German (national) ?EVS?EQFBOOK?DEMO. SCR
</Control>

<Source>The IBM 9370 system includes a processor, I/0 devices and the appropriate
software to fulfill your data processing requirements. </Source>

<Target>Das System IBM 9370 umfalt den Prozessor, E/A Gerdte sowie die
entsprechende Software, um den Anspriichen bei der Informationsverarbeitung
gerecht zu werden. </Target>

</Segment>

</NTMemoryDb>

4.1.4.3 SGML tags for external Translation Memory databases

Start tag, end tag Description
<NTMemoryDb>, </NTMemoryDb> Start and end of a Translation Memory
<Segment>, </Segment> Start and end of a Translation Memory segment
<Description>, </Description> Start and end of a Translation Memory description
<Control>, </Control> Start and end of the segment control information
<Source>, </Source> Start and end of a source sentence
<Target>, </Target> Start and end of a target sentence

4.1.4.4 Control information of a Translation Memory segment

The control information for each segment consists of several pieces of information, each of a specific length. The maximum length of each data element
is contained in square brackets. The data elements must be separated by a character with the ASCII code 21 (X'15'), represented by the symbol §.

The control information has the following layout:
¢ Segment number [6]
The segment number forms a number (with leading zeros if required) representing the position of the segment within the document file from
which it originates. If you do not know this number, specify a number that is unique within this Translation Memory. The segment number is
used by the Translation Memory to rank segments with an identical source.
¢ Translation indicator [1]
This character can be 0 or 1:
0 0 - Indicates that the translation is a manual translation.
0 1 - Indicates that the translation of this segment originates from a machine translation system and has not been post-edited by a
translator. If more than one exact translation match is available in the Translation Memory, OpenTM2 ranks the human translation
higher than the machine translation.

¢ Time stamp [16]

In exported Translation Memory databases, this data element contains a time stamp in internal format. In Translation Memory databases
created outside of OpenTM2, use a value of 0.

¢ Source language [20]

Any language from the list of supported source languages.
¢ Target language [20]

Any language from the list of supported target languages.

e Author [15]



Contains the name of the translator as the author of the translation of this original segment. It is the only field that is optional.

e Markup table [8]
Any of the markup tables available.

¢ File name [12]
Contains the name of the source file from which this segment originates. If you do not know the file name, put any other identification in this
field. The Translation Memory uses the file name to rank segments originating from the same source. This means if a document with the
name XYZ is translated and several exact translation matches are found for a specific segment, then the exact translation with the file name
XYZ (if available) is ranked higher. The file name must be immediately followed by ???.

4.1.5 Renaming a Translation Memory

OpenTM2 enables you to give a Translation Memory a new name.

4.1.5.1 Prerequisites

The Translation Memory must exist.

4.1.5.1.1 Calling sequence
Select:

1. The Translation Memory from the "Translation Memory List" window
2. Rename from the File menu

4.1.5.1.2 Options and parameters
e Rename to
Type a new name for the Translation Memory.
e Adjust all references automatically

If you select this option, all references to the renamed Translation Memory are also changed.

4.1.5.1.3 Results

If you select Rename, the Translation Memory and, optionally, any references to it are renamed.

4.1.6 Deleting a Translation Memory

If you no longer need a Translation Memory, for example, if you have specified incorrect parameters or it has been filled with the wrong data, you can
delete it.

For learning how to delete a shared Translation Memory, see Deleting a shared Translation Memory.

4.1.6.1 Prerequisites

The Translation Memory must exist.

4.1.6.1.1 Calling sequence
Select:

1. The Translation Memory to be deleted
2. Delete from the File menu

Before OpenTM2 deletes the requested Translation Memory, a message window is displayed asking you to confirm that you want to delete the
Translation Memory.
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4.1.6.1.2 Options and parameters

0 If you select No, the Translation Memory is not deleted.
0 If you select Yes, the Translation Memory is deleted.

4.1.6.1.3 Results

If you select Yes, the Translation Memory is deleted, and the disk space is freed. Otherwise, the Translation Memory remains unchanged.
References to this Translation Memory may still exist in certain folders. Update the folder properties so that the deleted Translation Memory is no
longer referenced.

4.1.7 Exporting a Translation Memory

To make a Translation Memory available to another system or user, you can export it to create an external Translation Memory. An external
Translation Memory is in an SGML-based data exchange format that you can use to pass your Translation Memory data to users who do not work

with OpenTM2.

Exporting a Translation Memory can also be part of the conversion of a Translation Memory into Unicode. To convert a Translation Memory into
Unicode, you must first export it from OpenTM2 and then import it again. In both cases, you select SGML UTF-16 as export format or import format.

You can also export the memory using the Translation Memory exchange format TMX.

4.1.7.1 Prerequisites

The Translation Memory must exist.

4.1.7.1.1 Calling sequence
Select:

1. The Translation Memory to be exported
2. Export... from the File menu

The "Export Translation Memory" window is displayed.

Export TranslationMemory SHOWMEM |

Savein |E Egfzampl j ﬁl

(8] SAMPLEHTML.EXP:
Wiarkbat? doc

File narme: ISHDWMEM.EKF‘ Save

Save as hupe; I SGEML ASCI j Cancel

[T Open as read-only

Figure 91. Export Translation Memory window

4.1.7.1.2 Options and parameters
¢ Save in
Select the drive and directory to which the Translation Memory is to be exported.

¢ File name

10
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Contains the name of the Translation Memory to be exported. You can overwrite it with a new name.
¢ Save as type

Select the format in which the Translation Memory is to be stored. Select SGML UTF-16 if the export is part of your conversion of the
Translation Memory into Unicode. Select TMX (UTF-16) or TMX (UTF-8) to export the memory in the TMX format.

Click Save to begin exporting the Translation Memory.

If you selected a diskette drive and the data volume of the Translation Memory exceeds the capacity of the diskette, OpenTM2 informs you that it
cannot export the Translation Memory in this way. You then must export the Translation Memory in a folder. For more information, see Exporting a
folder.

4.1.7.1.3 Results

The Translation Memory is exported as a file that you can pass to other users or systems. The default file extension is EXP for SGML format export and
TMX for TMX format export. The internal Translation Memory remains unchanged.

4.1.8 Creating an Initial Translation Memory

You can generate a Translation Memory already before you start translating a document in OpenTM2. In this way, you can immediately benefit from
having a filled Translation Memory when you start translating, for example, updated versions of existing documents.

Such a Translation Memory is called an Initial Translation Memory (ITM). OpenTM2 lets you create an Initial Translation Memory based on existing
translations?both a source file, containing the original document, and a target file, containing the corresponding translated document, must be available.

OpenTM2 scans both files to find the corresponding target segment for each original segment, that is, it aligns the segments of the two files. You are
recommended to check the combinations of segments afterwards.

When you use an Initial Translation Memory during a translation, the proposals in the "Translation Memory" window are prefixed with [m] (created by
machine). Such machine proposals are treated as fuzzy matches, this means that they are not used during automatic substitution.

To generate an Initial Translation Memory, you can choose between two methods. You can start generating an Initial Translation Memory:
¢ From the command area

In this case you must type the EQFITM command and all required parameters in your system?s command area and press Enter. For a
complete description of the syntax of this command, see Creating an Initial Translation Memory from the command line.

¢ From the Initial Translation Memory icon
In this case you must double-click thelntial Translation Memory Tool icon in the " OpenTM2" group window.
Note: In both cases the SGML memory is written from ITM in UNICODE format
The following sections describe how to:
e Generate an Initial Translation Memory
e Check the results of the alignment process (the process of combining source segments with their matching target segments)
4.1.8.1 Prerequisites
¢ The original documents and corresponding translations must be available as separate files.
¢ The Translation Memory that is subsequently to be used as an Initial Translation Memory must already be initialized (see Creating a
Translation Memory)
¢ The markup table for the document files must be the same for source and target documents.
* The language support for the source language and the target language must be installed.
4.1.8.1.1 Calling sequence
Type egfitm in the command area of your system (next to the [C:\]prompt).

1. Press Enter to start the command.
2. Double-click the Initial Translation Memory Tool icon in the " OpenTM2"group window.

The "Create Initial Translation Memory" window is displayed:
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Figure 92. Create Initial Translation Memory window

4.1.8.1.2 Options and parameters

¢ Translation Memory

Select an existing Translation Memory to be filled with the matched segment pairs of existing translations (source segments and their

matching target segments).

e Markup

Select an existing markup table to be used for the file pairs you select.

¢ Selection of file pairs

Define one file pair (source and target) at a time, then click Add to add the file pair to the Filelist list box. Then specify the next file pair or add
all file pairs having the same name in the source file list and the target file list by clicking Add all matching files.

A source file is defined by the following parameters:

¢ Source language

Select the language of the original document file from the list of available languages.

¢ Source start path

Specify the path information that you do not want to become part of the document name when the original document is stored in the Initial
Translation Memory. For example, if your source file is stored in e : \tm\project\english and you do not want e: \tm\project to

12
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become part of the name under which it is stored, specify e: \tm\project in this field.

The path you specify here can differ from the target start path. However, if you specify a source start path, you must also specify a target start
path.

¢ Source file
You can:
0 Type the fully qualified file name in this field.
¢ Type only the file name but select the location of the file using the Browse button.
O If you first specify the file location using the Browse button or by typing in the location into the Current Directory field, select the
file name from the Files list box.

¢ Current directory

This field shows the drive and path currently selected, you can modify the path directly or you can click Browse to display the "Browse for
Folder" window on which you can select the appropriate path.

e Files

Contains a list of all the files in the current directory. Select the source file.
The target file is defined similar to the source file:

¢ Target language
Select the language of the target document from the list of available languages.

e Target start path
Specify the path information that you do not want to become part of the document name when the target document is stored in the Initial
Translation Memory. For example, if your target file is stored in e: \tm\project\german and you do not want e: \tm\project to

become part of the name under which it is stored, specify e: \tm\project in this field.

The path you specify here can differ from the source start path. However, if you specify a target start path, you must also specify a source
start path.

e Target file

If the Current Directory field contains the correct drive and path name, either select the source document from the Files list box or type it
directly into this field. Otherwise, first specify the correct drive and path information in the Current Directory field.

¢ Current directory

This field shows the drive and path currently selected, you can modify the path directly or you can click Browse to display the "Browse for
Folder" window on which you can select the appropriate path.

e Files
Contains a list of all the files in the current directory. Select the target file.
¢ Filelist

Displays file pairs selected for subsequent processing. All files must have the same markup. To change the selection of file pairs, use one of
the following buttons:

e Add
To save the specified file pair, click this button. The names of the source file and of the target file are added to the Filelist list box.
e Add all matching files
To add all files having the same name in the source and target file list as file pairs.
¢ Delete/Delete all
To remove a file pair, first select the file pair from the Filelist list box, then select Delete. To remove all file pairs, select Delete all.
e Create
Starts the creation of the Initial Translation Memory and presents its contents on the screen for you to review. After you saved the Initial

Translation Memory, the contained segments are treated as machine proposals, prefixed with [m]. To remove this prefix and enable the
segments to be used during the automatic substitution process, use EQFDMM.EXE.

13



e Align
When all file pairs have been added to the Filelist list box, click Align to begin filling the Initial Translation Memory. The aligning process
starts and connects each source segment with a corresponding target segment. The matched segments are written to the selected
Translation Memory (prefixed by [m]). Mind that these segment connections have not been checked yet. As it can take some time to join the
document file pairs together, a window is displayed showing the progress of the operation.

¢ Prepare

Same as Create... but no visual presentation of the Initial Translation Memory contents. The selected file pairs are prefixed by p. You can use
this option to create the Initial Translation Memory but view it later.

e Cancel
Stops the interaction with this window and returns you to the starting point. Any modifications you have made are not saved.
e Help
Gives information to help you interact with the current window.
When the generation of the Initial Translation Memory is completed, a message window appears containing the number of paired segments. If you

pressed the Create... button, the contents of the Initial Translation Memory is presented in a window on the screen. How you work with this window is
described in Revising an Initial Translation Memory.

4.1.8.1.3 Results

The Initial Translation Memory is filled with matching source and target segments, using the file pairs you selected.

It is recommended that you check the correctness of the matches made by OpenTM2. You can do this before you start translation work with this
Translation Memory as described in Revising an Initial Translation Memory, or online using the Initial Translation Memory specific editor (see Revising
an Initial Translation Memory). This editor is invoked by selecting the Create button in the "Create Initial Translation Memory" window.

If you start to use the Initial Translation Memory without any further checking, it is recommended to treat the machine-generated matches (prefixed by
[m]) in the same way as fuzzy matches (prefixed by [f]). When you copy these proposals into your translation, check whether they need to be adapted
and change them where necessary.

If you choose to use automatic substitution during analysis, machine-generated matches are not used.

4.1.9 Importing a Translation Memory
If you receive an external Translation Memory, you can import it into OpenTM2.
During the import, you can also merge the data from an external Translation Memory into a Translation Memory that already exists in OpenTM2.

Importing a Translation Memory can also be part of the conversion of a Translation Memory into Unicode. To convert a Translation Memory into
Unicode, you must first export it from OpenTM2 and then import it again. In both cases, you select SGML Unicode as export or import format.

4.1.9.1 Prerequisites
¢ The Translation Memory to be imported must exist.

¢ |f you want to merge the data from the external Translation Memory into an existing Translation Memory, both Translation Memory
databases must have the same source language.

4.1.9.1.1 Calling sequence
Select:
1. The "Translation Memory List"window from the main window
2. Optionally the Translation Memory into which to import the external Translation Memory

3. Import... from the File menu

The "Import Translation Memory" window is displayed.
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Memory Import
Lock in: | m

|D031_IPHB-D000-0LEXP
2 PViNews-03-5W-GE.EXP
PiNews-03-5\-GE-reimport. EXP

File name: | Import
Format: | SGML ANSI (".EXP) | Cancel
To memory:; |,’-'-, j

Figure 93. Import Translation Memory window

4.1.9.1.2 Options and parameters
e Look in
Select the directory where Translation Memory to be imported is currently stored.
¢ File name
Enter the file name of the Translation Memory to be imported or select one or more entries in the list box.
¢ Format
Select the format of the Translation Memory to be imported
0 SGML ANSI for the import of external memory databases in the SGML (.EXP) format in ANSI encoding
0 SGML ASCI! for the import of external memory databases in the SGML (.EXP) format in ASCII encoding
¢ SGML UTF16 for the import of external memory databases in the SGML (.EXP) format in Unicode (UTF-16) encoding
0 TMX for the import of external memory databases in the TMX (Translation Memory Exchange) format
0 TMX (Trados) for the import of external memory databases in the TMX (Translation Memory Exchange) format which have been
exported using the Trados translation tool, for this special import format any RTF tagging contained in the imported segment data is
removed
¢ To memory
Contains the name of the Translation Memory to be imported. You can overwrite this name or select one from the list box.If you specify a
Translation Memory that does not exist yet, the "New Translation Memory" window is displayed for you to create it (see Creating a
Translation Memory).

If you select or specify an existing Translation Memory, the contents of the Translation Memory to be imported are merged into it.

When you have specified your input, click Import.

For information on importing Translation Memory databases from other OpenTM2 products, see Exchanging data with other OpenTM2 products.

4.1.9.1.3 Results

The Translation Memory data is imported into the selected target Translation Memory and you can begin to work with it. The external Translation
Memory remains unchanged.

4.1.10 Merging Translation Memory databases

If several translators are working on a large document, each of them uses and updates a separate Translation Memory.
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For the translation of subsequent releases of the document, it is useful to merge these to create a single consolidated Translation Memory.
You can merge Translation Memory databases in two ways:

e While importing an external Translation Memory (see Importing a Translation Memory).
e By merging two internal Translation Memory databases

The merging of two Translation Memory databases is described using two sample names, TMEMO01 and TMEMO02.

4.1.10.1 Prerequisites
¢ The two Translation Memory databases to be merged must exist.
¢ They must have the same source language.
4.1.10.1.1 Calling sequence
Select:
1. The "Translation Memory List" window
2. The Translation Memory to be merged, for example, TMEMO1

3. Select Merge... from the File menu

The "Merge Translation Memory" window is displayed.
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Source: itmtesto_txt Target: itmtestt_txt

Da=s i=t =in Test. a||Thi= i= a te=st.
Da= i=t =in Test.

Da= i=t =in Test. Thi= i= a test.
Da= 1=t =in Test. Thi= 1= a test.
Da=z 1=t ein Test . Da=s i=t ein Test . Da=s 1=t ein Test . Da=s ist Thi=s 1= a te=st.
ein Test . Das 1=t =in Test.Das i=t ein Test . Da=s 1=t ein Test. Thi=s 1= a te=st.

|

| Segments: b | Irregular: 1:1

Figure 94. Merge Translation Memory window

4.1.10.1.2 Options and parameters

The Into Translation Memory list box displays all available Translation Memory databases. Select the Translation Memory, for example TMEMO02,
into which to merge the previously selected Translation Memory TMEMO1.

When you have selected the target Translation Memory, click Merge to begin merging the Translation Memory databases.
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4.1.10.1.3 Results

The contents of TMEMO1 is merged into the target Translation Memory TMEMO2. The Translation Memory TMEMO1 remains unchanged. You can
begin to use the extended Translation Memory TMEMO02.

4.1.11 Archiving a Translation Memory

When you have finished a translation project you can archive the translated documents in another or a new Translation Memory. You then have a
clean Translation Memory without redundancies.

4.1.11.1 Prerequisites

At least one segment of the document or documents you want to archive must have been translated.

4.1.11.1.1 Calling sequence

Select:
1. The "Folder List" or "Document List"window, depending on whether you want to archive a single or all documents in a folder.
2. The folder or document.

3. Build Archive Translation Memory... from theUtilities menu.

The "Build Archive Translation Memory" window is displayed.

i Build Archive Tranzlation Memory

Documents being zearched

DEVICE.HTML
TRAMS HTML

Archive inta Translation Menman: SAMPLEHTMIES

[~ Use as folder Translation Memary

Build | Eanu:ell Help |

Figure 95. Build Archive Translation Memory window

4.1.11.1.2 Options and parameters
¢ Documents being searched
This box lists the documents that are searched for translated segments to be included in the Translation Memory.
¢ Archive into Translation Memory
Select an existing Translation Memory or type the name for a new Translation Memory in which the documents are to be archived.
¢ Use as folder Translation Memory

Select this option if you want to use the Translation Memory as the new folder Translation Memory.

4.1.11.1.3 Results

The documents are stored in the specified Translation Memory. If you specified an existing Translation Memory, you are asked whether you want to
overwrite its contents or merge the new entries with the existing ones.
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4.1.12 Organizing a Translation Memory

Occasionally OpenTM2 prompts you to organize a Translation Memory. A Translation Memory must be organized to delete obsolete segments, to
repair a defective Translation Memory, or to upgrade a backlevel Translation Memory.

4.1.12.1 Prerequisites

The Translation Memory to be organized must exist.

4.1.12.1.1 Calling sequence
Select:
1. The "Translation Memory List"window
2. The Translation Memory to be organized

3. Organize from the File menu

Organizing begins immediately. As it may take some time to organize a large Translation Memory, a window is displayed showing you the progress.

4.1.12.1.2 Options and parameters

None.

4.1.12.1.3 Results

The Translation Memory is now organized and the new number of segments in the Translation Memory is displayed. You can continue to use it.

4.1.13 Revising an Initial Translation Memory

To increase the reliability of the automatically generated Initial Translation Memory, it is necessary to check the correctness of the relation between
source and target segments.

With the Initial Translation Memory editor you can see the contents of the Initial Translation Memory at a glance to verify the correspondence between
source and target segments. When a target segment does not correspond to a source segment, you can perform the necessary changes.

The original segments are displayed in the "Source" window, the corresponding translations in the "Target" window. The segment pairs are
synchronized with each other. That means that a target segment is displayed at the same level on the screen as the source segment and with the same
background color. The following describes how to work with the Initial Translation Memory editor.

4.1.13.1 Prerequisites

The "Create Initial Translation Memory" window must be invoked and filled in.

4.1.13.1.1 Calling sequence
Select:
* The Create button from the "Create Initial Translation Memory" window.

The "Edit Initial Translation Memory" window is displayed. It consists of two windows. One window shows source segments, the other window shows the
corresponding target segments.
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Figure 96. Edit Initial Translation Memory window

4.1.13.1.2 Options and parameters

For information on how to work with the Initial Translation Memory editor see The Initial Translation Memory editor.
4.1.13.1.3 Results

You are now ready to verify the correctness of the automatically generated pairs of source segments and their translated equivalents. When you leave
the editor the segment pairs are stored in the Translation Memory.
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4.1.14 The Initial Translation Memory editor

On the menu bar of the "Edit Initial Translation Memory" window you can select the following items:

e File

To save changes in the "Initial Translation Memory" window and to exit.

e Edit

To find and replace, split and join, cut and paste, delete, and do other operations on the text.

e Align

To manipulate the relation between source and target segments.

¢ Options

To change the view of the "Source" and "Target" windows and to modify colors and fonts.

e Cursor

To move and change the cursor position in the "Source" and "Target" windows, to mark segments, and to set bookmarks.

o Style

To change the display of markup information.

e Help

To get information that helps you interact with the current window.

4.1.14.1 File menu

Menu or key
Save (F2)
Quit (F3)
End-Save (F4)

Toggle window (Ctrl+t)
4.1.14.2 Edit menu

Menu or key
Find and replace... (Ctrl+f)

Cut (Ctrl+x)

Copy (Ctrl+c)
Paste (Ctrl+v)
Undo

Split line

Join line

Toggle initial caps

Add an abbreviation (Ctrl+a)

4.1.14.3 Aligh menu

Menu or key
Connect segments (Ctrl+0)

Delete connection (Ctrl+d)

Ignore segment (Ctrl+i)

Undo Ignore (Ctrl+u)

Function

Saves the current segment connections. If you have selected another pair of files, the segment connections
resulting from these files will be displayed next.

Quits the "Edit Initial Translation Memory" window without saving changes.

Quits the "Edit Initial Translation Memory" window and saves any changes to the selected Translation
Memory.

Activates the opposite window ("Source" or "Target").

Function

Locates a term in the source or target document, depending on where the cursor is located, and changes it
as specified. You can only change a term if the Initial Translation Memory can be edited.

Copies a marked text section to the system clipboard and removes text afterwards.
Copies a marked text section to the system clipboard for later pasting.

Inserts text from the clipboard into the active segment at the current cursor position.
Restores the original state as it was before an action was performed.

Splits the line at the current cursor position.

Combines the current line with the following line.

Changes the initial caps to small initials.

Adds the term where the cursor is positioned to the list of abbreviations associated to the current source
language.

Function
Relates the marked source segment to the marked target segment.

Removes a connection between a source segment and a target segment. Either of the segments must be
marked.

Removes a marked segment from the ITM which you do not want to be connected with another segment, or
that does not have a match in the opposite file. The ignored segment remains visible but gets a different
background color.

Makes a previously ignored segment available for connection with a matching
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Join segments (Ctrl+j)

Split joined segments (Ctrl+s)

4.1.14.4 Options menu

Menu
Colors...
Fonts...

Arrange

Parallel

Automatic linewrap

Visible white spaces

4.1.14.5 Cursor menu

Menu

Next connection (Ctrl+Shift+Down)
Previous connection (Ctrl+Shift+Up)

Next unaligned (Alt+Down)

Previous unaligned (Alt+Up)

Next irregular (Shift+Alt+Down)

Previous irregular (Shift+Alt+Up)

Synchronize (Ctrl+Enter)
Mark segment (Ctrl+m)
Unmark segment (Ctrl+n)
Go to line...

Query line

Set bookmark

Go to bookmark
Clear bookmark

4.1.14.6 Style menu

Menu
Protect
Unprotect
Hide

Shrink
Compact

Compact+1

segment in the opposite file. Note that the segment must be marked before you use.
Combines the currently active segment with the following one.
Splits a previously joined segment at the current cursor position.

Function
Lets you define the colors for the segments in the "Source"and "Target"windows.
Lets you set the font and font size for the "Source"and "Target" windows in the "Set Fonts" window.

Changes the arrangement of the "Source" and "Target" windows. You can arrange them (the target
document is positioned next to the source document on the right half of the screen) or (the target document
is positioned below the source document on the lower half of the screen).

Positions the segments in the "Source" window parallel to their matches in the "Target" window. That
means that lines may be inserted in either the "Source"or the "Target" window to achieve that a segment is
presented at the same position as its counterpart.

Wraps the text at the end of a line.

Replaces blanks in the text with a dot and displays a § sign at the end of a segment or in an empty line to
make them visible.

Function
Moves the cursor to the next connected segment pair.
Moves the cursor to the previous connected segment pair.

Moves the cursor to the next segment for which no matching segment has been found. This can be either
in the same or in the opposite window.

Moves the cursor to the previous segment for which no matching segment has been found. This can be
either in the same or in the opposite window.

Moves the cursor to the next and marks it. An irregular match can be one of the following:

¢ A 1:2 match, where one source segment is connected to two target segments

¢ A 2:1 match, where two source segments are connected to one target segment
¢ A 2:2 match, where two source segments are connected to two target segments
¢ An unaligned sentence (the default color is red)

¢ A sentence that is ignored (the default color is gray)

Moves the cursor to the previous irregular match and marks it.

Positions the current segment and its match in the opposite window beside one another at the same level.
Marks the segment where the cursor is positioned. A segment must be marked to connect and to remove it.
Removes the marking from a segment. Only one segment in a window can be marked.

Enables you to specify the number of the line to which you want to move your cursor.

Informs you in which line your cursor is located.

Sets a bookmark at the current cursor position. This makes it easier for you to return to this point in the
Initial Translation Memoryat a later point of time. You can set several bookmarks, for example, at all
those alignments that you want to check again later.

Moves the cursor to the position where you set a bookmark.
Removes a bookmark from the segment where the cursor is located.

Function
The markup tags are shown but cannot be overwritten (see the example given in Figure 2).
The markup tags are shown and you can overwrite and change them.
The markup tags are not shown.

All markup tags outside segments are not shown. A replacement character is shown instead (see the
example given in Figure 2).

All markup tags are replaced with a replacement character to indicate the position of each tag (see the
example given in Figure 2).

Markup tags are shown up to a length of 10 characters and cannot be changed. Longer markup tags are
followed by three dots (?), for example [Style=@Out?

The status bar at the bottom of the window displays the following information from left to right:

1. The total number of segments in the source window compared to the total number of segments in the target window.
2. The number of segments in the source window that have an irregular match in the target window compared to the number of segments in the
target window that have an irregular match in the source window.
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3. The number of segments in the source window that have no match in the target window compared to the number of segments in the target
window that have no match in the source window.

4. The number of ignored segments in the source window compared to the number of ignored segments in the target window.

5. The relation of source segments to target segments. For example, 2:1 means that two source segments have been connected to one target
segment.

4.1.15 Revising a Translation Memory

To improve the quality of your translations, you may wish to check the contents of a Translation Memory from time to time, and modify or remove
translations that are stored there. Doing these changes directly in the Translation Memory lets you benefit from polished translations the next time you
use this repository.

Therefore, OpenTM2 offers a Translation Memory that can be manipulated. You can browse its contents, make changes to existing translations, or
delete complete entries from it. You can work on a Translation Memory contents in an editor window as if you were editing normal text. The original
segments are displayed in the "Original" window, the corresponding translations in the "Translation" window.

You make your changes in the "Translation" window. Translation Memory files can be huge. To make it easier for you to find a certain translation, you
have the choice to narrow down what you are looking for. For example, you can search for a certain translation segment, or for translations made within
a certain time frame. The following describes how to open a Translation Memory in order to work with it.

Note: Use this function with care. A Translation Memory that has grown over a period of time is an essential asset for all your translations. Therefore it is
good practice to avoid any uncontrolled changes. There is no Quit or Undo function. All changes become effective immediately.

4.1.15.1 Prerequisites

The Translation Memory you want to work with must exist.

4.1.15.1.1 Calling sequence
Select:

1. The "Translation Memory List" window from the main window
2. The Translation Memory you wish to edit
3. Open from the File menu or double-click the Translation Memory name

You are first prompted with the "Translation Memory Editor" window to specify what you are looking for in the selected Translation Memory. For more
information on how to work with this window see Searching a translation. After you specified the search criteria, the "Edit Translation Memory" window
(see Figure 97) is displayed. It consists of two windows. The "Original" window lets you view the original text, in the "Translation" window you can make
your changes. By pressing Ctrl+Enter you can move from segment to segment.
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Figure 97. Edit Translation Memory window
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4.1.15.1.2 Options and parameters

For information on how to use the Translation Memory editor functions, see The Translation Memory editor.

4.1.15.1.3 Results

You open a Translation Memory to work on the translations that are stored in it. In the "Edit Translation Memory" window you can browse the original
texts and revise the corresponding translations. If you need to change or remove translated text, you can do this in the "Translation" window where you
are assisted by an editor. How you use this editor is explained in The Translation Memory editor.

4.1.16 Searching a translation

Translation Memory files can be huge. You can search for a certain translation segment or for specific translations. In the "Translation Memory Editor"

window you specify the individual search criteria. The Look up... button starts the search in the Translation Memory and displays the found Translation
Memory contents in the "Edit Translation Memory" window. The following describes how to specify the search criteria.

4.1.16.1 Prerequisites

The Translation Memory you want to work with must exist.

4.1.16.1.1 Calling sequence

Select:
1. The "Translation Memory List"window from the main window
2. The Translation Memory you wish to edit

3. Open from the File menu

The "Translation Memory Editor" window is displayed.

Translation Memory Editor |

Tranzlation b ernony: SAMPLEHT L1

Search far zegment number: I

Search sting or zentence:

-
[~

— Type of zearch

[V Use ™ and'?' for wideard search Case: © Respect Searchin * Source
% |gnare " Targst
Markup: EQFHTMLY =]
— Optionz
[ Find anly matches with mare than one tanslation
™ Use date range: (/882 Y20 aelect...
[T Use document(s]: s Seleet.

Festrict zearch to [ M-flagged segmentz anly [ Segments wéo M-flag
t axirum number of zegrments to load: |3|:||:|I:|I:| St £ I SEAEnts

Look up... Cancel | Help |

Figure 98. Translation Memory Editor window
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4.1.16.1.2 Options and parameters
¢ Search for segment number

Each segment in the Translation Memory has a number. It is displayed in the status bar of the "Edit Translation Memory" window as part of
the document name. Instead of specifying the segment to be searched, or part of it, you can type its number here.

¢ Search string or sentence

Type the term or sentence you are looking for. You can also use wildcard characters (Use ™' and '?' for wildcard search). For example, if
you are looking for a product name beginning with ?Star? and you are not sure about the product?s exact name, you can type Star*.

e Case

Specify whether the search for the requested text string is to be case-sensitive (respect case sensitivity). The default setting is ignore case
sensitivity.

e Search in
Specify whether the search is to be performed on the original entries (Source) or on the translations (Target). The default setting is Source.
e Markup
Specify the markup language of the text you are looking for.
¢ Find only matches with more than one translation
Specify whether you want to retrieve only original segments with more than one translation. If there is only one translation for an original
segment, this segment will be ignored during the search in the Translation Memory and not displayed. Use this option to revise translation
variants.
¢ Use date range
Specify the period of time when translations were stored in the Translation Memory selected. Only the original segments of those translations
that were added to the Translation Memory during the specified period are displayed in the "Edit Translation Memory" window. The default
setting for the time span is January 1992 until the present time. Select Select... to alter this time span.

¢ Use document(s)

Type the name of the document from which the translation is to originate. Select Select... to type the name of a document. You may use * as
wildcard character.

¢ Restrict search to

Specify whether you want to restrict your search to segments that were translated by machine (m-flagged segments only) or segments that
were not translated by machine (segments w/o m flag).

e Maximum number of segments to load

The segments are loaded into the editor in stages. Specify the maximum number of segments that you want to be loaded into the Translation
Memory editor at one time. You can specify a number between 5 and 99999. The default setting is 99999.

Click Look up... to start the search.

4.1.16.1.3 Results
The Translation Memory is searched according to the search criteria specified in the "Translation Memory Editor" window. The found matches are

loaded into the editor and displayed in the "Edit Translation Memory" window where you can revise them. How you revise Translation Memory entries is
described in The Translation Memory editor.

4.1.17 The Translation Memory editor

To revise the entries in a Translation Memory, you are assisted by an editor. The functions of this editor support you when changing the Translation
Memory entries.

The editor consists of two windows. The "Original" window shows original segments, the "Translation" window shows the corresponding translations. By
pressing Ctrl+Enter you can move from segment to segment.

From the menu bar of the "Edit Translation Memory" window you can select the following items:
¢ File
To save changes, to exit the editor, to load more segments, to switch between "Translation" and "Editor" window.
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o Edit
To find and replace, to split and join, to cut and paste, to delete, and do other operations on the text.
¢ Options
To change colors and fonts, and to arrange the editor windows.
o Style

To change your view of markup tags.

4.1.17.1 File menu

Menu or key Function
Loads another collection of segments into the editor if more segments are found in the Translation Memory
Next : " : S
than the number set in the "Translation Memory Editor" window.
Previous Loads the previous collection of segment pairs into the editor.

New query (F5) Saves any changes made in the Translation Memory. Returns you to the "Translation Memory Editor

window.
Quit (F4) Saves any changes made in the Translation Memory editor and returns you to the OpenTM2 main window.
Toggle windows (Ctrl+t) Activates the opposite window ("Original"or "Translation").

4.1.17.2 Edit menu

Many of the editor functions are tied to the "Translation" window only. If a function on the Edit menu cannot be performed in the "Original" window, the
function is disabled whenever the "Original" window becomes active. If a keystroke editor function does not apply to the active window, the system
beeps.

Menu or key Function

Locates a term and replaces it as specified. Works in "Translation"and "Original" window. Changes in the

Find and replace... (Alt+F6) original text are not allowed.

Cut Copies a marked text section to the system clipboard and removes text afterwards.Works in "Translation"

window only.
Co Copies a marked text section to the system clipboard for later pasting.Works in "Translation" and "Original”
Py window. Text cannot be pasted into "Original"window though.
Paste Inserts text from clipboard into active segment at current cursor position.Works in "Translation" window
only.
Undo Restores the original state as it was before an action was performed.Works in "Translation" window only.
Unmark block (Alt+m) Removes marking from a text section.Works in "Translation" and "Original" window.
Split line (Alt+s) Splits line at current cursor position.Works in "Translation" window only.
Join line (Alt+)) Combines current line with following line.Works in "Translation" window only.
Lets you choose either of the following options:
Current segment (Ctrl+d)
Delete Removes only the currently active segment from the Translation Memory.
All segments
Removes all segments from the Translation Memory (those that were loaded in the editor). Works
in "Translation" and "Original" window.
Lets you choose one of the following options:
Delete one m flag
Deletes the m flag contained in the current segment.
Delete all m flags
Set m flag Deletes all m flags contained in the Translation Memory.

Set one m flag
Displays the m flag for the current segment.

Set all m flags
Displays the m flags for all machine translations in the Translation Memory that are currently
loaded into the editor.
The following key combinations let you manipulate text in both the "Original" and "Translation" windows. Note that the two windows are synchronized
with each other. That means, whenever you activate a segment in the "Translation" window, it becomes active in the "Original" window too, and vice
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versa. The matching segment in the opposite window is presented beside the active one at the same level.

Keys Function

Ctrl+Shift+Left Marks previous word from cursor position to beginning of word.

Ctrl+Shift+Right Marks next word from cursor position to end of word including the blank space.

Ctrl+Insert Copies marked block to system clipboard.

Cirl+Delete Dgletes all characters from current cursor position to end of line in active segment.Works in "Translation"
window only.

Ctrl+Home Moves cursor to first segment in window.

Ctrl+End Moves cursor to last segment in window.

Ctrl+left Moves cursor to beginning of previous word.

Ctrl+right Moves cursor to beginning of next word.

Ctrl+Enter Activates next segment or segment where cursor is positioned.

Ctrl+t Toggles between "Original" window and "Translation" window.

Shift+left Extends text marking by one character to the left.

Shift+right Extends text marking by one character to the right.

Shift+Up Extends text marking to the previous line.

Shift+Down Extends text marking to the next line.

Shift+Insert Inserts text from clipboard at current cursor position in active segment.

Alt+F6 _Locates _a_term and changes it as specified.Works in "Translation" window and "Original" window. Changes
in the original text are not allowed.

Alt+Delete cIZ))r(]aII;ates all characters from current cursor position to end of active segment. Works in "Translation" window

Alt+j Joins current line with following line.Works in "Translation" window only.

Alt+s Splits line at current cursor position.Works in "Translation" window only.

Alt+n Loads next collection of segments.

Alt+p Loads previous collection.

Alt+m Removes marking from a text section.

Up Moves cursor one line up.

Down Moves cursor one line down.

Right Moves cursor one character right.

Left Moves cursor one character left.

Home Moves cursor to beginning of current line.

End Moves cursor to end of current line.

Page Up Moves text one page up.

Page Down Moves text one page down.

Delete If a text section hgs bee_r_1 mark_ed, the marked text is removed. If no text has been marked, the character
where the cursor is positioned is removed.

Backspace Moves cursor back by one character in the active segment and deletes this character.

Switches from insert mode to overtype mode and vice versa. When you insert text in insert mode, the
Insert existing text is moved to the right to make room for the new text. If you want to type over the existing text,
switch to overtype mode.

F3 Quits the Translation Memory editor and returns you to the workbench.
Fa4 Saves any changes made in the Translation Memory and returns you to the "Translation Memory Editor"
window.
Enter Moves to next line.
Double-click left mouse button Marks entire segment beginning from the cursor position.
Double-click right mouse button Removes marking from a segment.
4.1.17.3 Options menu
Menu Function

Lets you change foreground and background colors. Note that if you change colors in the "Translation"
Colors... window or the "Original" window, it will change colors in the translation editor windows accordingly. See
also to learn how to work with the "Set Colors" window.

Fonts... Lets you change fonts and their sizes. Note that if you change a font or a font size in the "Translation"
window or the "Original"
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window, it will change the font or font size in the translation editor windows accordingly. See also to learn
how to work with the "Set Fonts" window.

Lets you arrange windows. Horizontal positions the "Translation" window below the "Original" window.

Arrange positions the "Translation" window next to the "Original" window on the right half of the screen.

4.1.17.4 Style menu

Menu Function
Protect Markup tags cannot be overwritten.
Unprotect Markup tags within a currently active translation can be overwritten.
Hide Markup tags are not shown (they are there, but invisible).
Compact Markup tags are replaced by a special character indicating the position of the tag.

The status bar at the bottom of the editor window displays the following information (from left to right):
o M flag
Shows whether or not the Translation Memory contains any m flags (On or Off).
e Document
Displays the name of the document where the active translation segment originates from and the line number of the segment.
¢ Date
Displays the date at which the translation was added to the Translation Memory.
e Segment n of m
Displays the number of the currently active segment (n) and the total number of segments loaded into the editor (m).
¢ Loaded

Displays how much of the Translation Memory has been loaded into the editor.

4.1.18 Revising external Translation Memory databases

An external Translation Memory contains segments in their original sequence. That is, the segments are placed in an external Translation Memory in
the sequence in which they occur in the documents.

You can edit the external Translation Memory with an editor of your choice as follows:

1. Remove all segments that have no corresponding source or target segment.

2. To show that a segment pair has been checked for correctness by a human translator and that it is no longer a machine-generated match,
change the character that indicates machine translation in the external Translation Memory. To see where this character is located in the
segment control information of the external Translation Memory and how to change it, refer to Format of an external Translation Memory.

4.1.19 Viewing the properties of a Translation Memory
The properties of a Translation Memory are:
¢ Memory Name
The name of the Translation Memory.
¢ Full Memory Name
The name of the Translation Memory including its location.
¢ Description
The description of the Translation Memory.
¢ Source language
The source of the Translation Memory, this means, the language of the terms (headwords).
e Drive

The drive where the Translation Memory resides.
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e Last update

The date and time of the last update of the Translation Memory.
¢ Size of index file

The total size of the Translation Memory, in bytes.
o Different Segments

The total number of different segments stored in the Translation Memory, which have different translations, which are from different
languages or which have different markup tables.

e Markup
A list of all markup tables used by the segments of this Translation Memory.
e Documents

A list of the documents for which segments are stored in this Translation Memory.

4.1.19.1 Prerequisites

The Translation Memory must exist.

4.1.19.1.1 Calling sequence
Select:

1. A Translation Memory from the "Translation Memory List" window.
2. Porperties Summary... from the File menu

4.1.19.1.2 Results

A document in HTML format is displayed containing a summary of the Translation Memory properties is displayed.
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Memory Properties

+ Memory Name: SANPLANI
« Full Memory Name: D EQOFMJERDS AWPLANIL THD
» Description: Translation Memory for & Fro
« Source Language: English(TT. %)
o Drive: [:
« Lastupdate: 25 10 2000 12:04:35
+ Size of index file: 65536
« Segments: 25
» Markup:
EQFAMIT
+ Documents:
DEVICE SAM
TEATTS SAT

Figure 99. Memory Properties document

If you want to view more properties or change the properties of a Translation Memory, refer to Changing the properties of a Translation Memory.

4.1.20 Changing the properties of a Translation Memory

All properties of a Translation Memory can be viewed, but only the description can be changed.

4.1.20.1 Prerequisites

The Translation Memory must exist.

4.1.20.1.1 Calling sequence
Select:
1. The "Translation Memory List" window
2. The Translation Memory from the list of Translation Memory databases

3. Properties... from the File menu

This takes you to the "Translation Memory Properties" window.
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Translation Memory Properties

M arme; SHOWHEMHTML
Short niame: SHOW k000

D' ezcription: |.£'-. Cluick Tour
Location: Local

Dizk. drive: l:

Saource language: Englizh(L1.5.]

Different segments: 1

File zize: ] =ta =tk

Last update: 28.01.2005 22: 3236
Documents: SHOWME WP

M arkupz: EQFHTHLA

Change Cancel Help

Figure 100. Translation Memory Properties window

4.1.20.1.2 Options and parameters

The "Translation Memory Properties" window lists the characteristics of the selected Translation Memory. Only the Description field can be
changed.

e Name
The name of the Translation Memory.
¢ Short name
The short name of the Translation Memory.
¢ Description
The description of the Translation Memory. It can be up to 40 characters long.
e Location
Can be local (only one translator can use it at a time) or shared (several translators can use it simultaneously).
e Disk drive
The drive where the Translation Memory resides.
¢ Source language
The source of the Translation Memory, this means the language of the terms (headwords).
o Different Segments
The total number of different segments stored in the Translation Memory which have different translations, which are from different

languages or which have different markup tables.
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¢ File size
The total size of the Translation Memory, in bytes.
e Last update
The date and time of the last update of the Translation Memory.
e Documents
A list of the documents for which segments are stored in this Translation Memory.
e Markups

A list of all markup tables used by the segments of this Translation Memory.

4.1.20.1.3 Results

If you select Change, the Translation Memory description is changed according to your specification. Otherwise, it remains unchanged. You are
returned to the previous window.

4.1.21 Viewing the details of a Translation Memory

In the "Translation Memory List" window, you can display additional information about a Translation Memory. You can define which details you want
to be displayed and in which order.

The Translation Memory details are:
e Name
The name of the Translation Memory.
¢ Description
The description of the Translation Memory.
e Size
The size of the Translation Memory (number of bytes).
e Drive
The drive on which the Translation Memory resides.
e Owner
Shows who created the Translation Memory if it is a shared one. If it is a local Translation Memory, n/a is displayed.
¢ Source Language
The language of the source segments.
You can toggle between two display modes:

e Display the Translation Memory names only
e Display selected details

You can change the arrangement of the Translation Memory details in the "Change Details" window described in Viewing and changing the details of a
list item.
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5 Working with dictionaries

A dictionary is a database that contains terms, their translations, and other related information.
OpenTM2 provides a set of bilingual dictionaries with general vocabulary for English, German, French, Spanish, and ltalian.

You need dictionaries to look up the translations of individual terms or have these terms displayed automatically in the "Dictionary" window during
translation.

A dictionary entry contains all data relating to a term (or headword). The dictionary entry structure describes which data elements can be stored for a
term in a dictionary.

OpenTM2 provides a general dictionary structure that you can use as a model for building a dictionary serving your own purposes. Headword and
Translation are mandatory fields. Certain entry fields, for example Synonym and Related term, are reserved for search criteria available during lookup in
a dictionary.

OpenTM2 can handle dictionaries with simple and complex structures.

The general dictionary entry structure in OpenTM2 is divided into four embedded levels to contain, for example, verb and noun entries, different
meanings (senses), and translation variants.

In OpenTM2 a dictionary can have two formats:
¢ An internal dictionary is a dictionary that exists in OpenTM2 .
¢ A dictionary in external format is an SGML-based data file. SGML is the data exchange format required for importing dictionary data into
OpenTM2 . When a dictionary in the internal format is exported, it is automatically converted into SGML. When you import an external
dictionary, it is automatically converted to the OpenTM2 format.
All dictionary data in other text-processor or database formats needs to be converted into SGML by, for example, a program or database macro.
You can create your own dictionaries from existing terminology imported into OpenTM2, or from scratch while you are translating.

For more information on the dictionary structure and on how to construct an SGML-based file, see:
e Dictionary entry structure
e Creating an SGML-based dictionary

5.1 Dictionary entry structure

A dictionary entry is divided into the following levels:
e Entry

This level contains general or administrative information, such as the date, author, or origin of an entry, and the headword itself. This
information applies to all other levels of the dictionary entry.

e Homonym

This level contains grammatical and syntactic information, such as which part of speech a headword is or how it is to be abbreviated and
hyphenated.

* Sense
This level contains semantic variations of a headword, such as different areas of meaning and usage.
e Target

This level contains all information applying to one translation variant of a headword, such as definition or usage. For example, if a headword
can be translated in two different ways, there is target level information for both translation variants.

The entry level can have any number of homonym levels. For example, there are separate homonym levels for the noun copy and the verb copy.

A homonym level can also have any number of sense levels depending on the individual definition of a headword or contextual information. For
example, the noun bank can mean both the river bank or a financial institution.

A sense level can have any number of target levels depending on the individual translation variants. For example, the German word Schnecke has two
English translations, snail and slug.

The entry fields and how they are distributed over the four levels is only suggested by OpenTM2. The entry fields Headword and Translation are

mandatory. All other predefined fields can be deleted or renamed. You can even omit particular levels. For example, you can omit the homonym and
sense level if you want to have only headwords and translations in your dictionary.
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You can also add new fields to any of the levels. You can do this when creating a new dictionary in the "New dictionary” window by selecting Add
fields? or by including them in the SGML dictionary file.

For the list of all predefined entry fields and their corresponding SGML tags see List of dictionary-entry fields and their SGML tags.

5.1.1 Dictionary search criteria
To search for one or more dictionary entries, the specified term can be used as one of the following search criteria:
e Headword
The dictionary entry for the specified term is retrieved.
¢ Synonyms
All entries that have the specified term in the synonym field of the dictionary entry are retrieved.
¢ Related terms
All entries that have the specified term in the related terms field of the dictionary entry are retrieved.
e Abbreviations
All entries that have the specified term in the abbreviation field of the dictionary entry are retrieved.
¢ Neighborhood

If the specified term exists, it is listed together with terms preceding and following it in alphabetical order. If not, the terms that would precede
and follow it are listed.

e Compounds

All compounds that begin with the specified term are retrieved and displayed as a list. For example, if you search for the term data, the
possible compounds that would be retrieved are data processing, data model, and data processing division.

The first four entry fields can only be used as search criteria when they exist at the entry level shown in the following table. The entry fields are:

Entry field Level
Headword Entry
Synonym Sense
Other Related

Sense
Terms

Abbrev./Fullform Sense

In the OpenTM2 default entry structure, these fields are defined at these levels.

If you are importing an SGML dictionary file and want to use any of the above search criteria, see List of dictionary-entry fields and their SGML tags for
the SGML tags required.

5.1.2 Overview and terminology
Dictionaries are used during analysis and translation:

¢ During the analysis of a document one or more dictionaries can be searched. This is useful to find new terms (terms in the document that are
not in the selected dictionaries) or to find found terms (terms in the document that are already in the referenced dictionaries). The new terms
can be added to the dictionary to be used during translation. The found terms can be used to fill a dictionary with entries extracted from other

dictionaries.
e During the translation of a document, the "Dictionary"window displays either all translations that are found in the folder dictionaries for the
terms in the current segment or only the first translation found. This depends on whether you marked the box on the "Display" page of the

"Customize Translation Functions" window.

The properties of a dictionary are its main characteristics such as the source language, the dictionary structure, information on its location, and a brief
description of its contents. You can specify them in the "Dictionary Properties" window.

Parts of these properties can also be displayed as details (or view details) in the "Dictionary List" window.
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5.1.3 What you can do with dictionaries

OpenTM2 offers several lookup functions for terms in dictionaries and their data:
e You can search for terms using general search criteria and filters defined by yourself (Look up a Term function).
e You can display all data of a dictionary entry or parts of it (Lookup Entry function).

e You can add and change dictionary entries (Edit an Entry function).

OpenTM2 dictionaries can be printed to a printer or to a file. You can select the entry fields to be printed and how to arrange them in the printout. This
layout is defined in a print format file. You can also use filters to print selected entries only.

A dictionary can be shared with other users by means of the dictionary export function, or if it has been defined to reside on a shared disk when it was
created. If you receive an exported dictionary, you can import it into your system.

During import, you can also merge the contents of one dictionary into another. In addition, you can create dictionaries tailored to suit your own needs. To
create a new dictionary, you must determine the dictionary structure, this means, which data elements in a dictionary are important to you. You can start
using the OpenTM2 default structure or using other existing dictionary structures that you can subsequently change.

OpenTM2 dictionaries can be protected with a password against unauthorized changes if necessary. Most of the processing functions OpenTM2 offers
for dictionaries can be started from the "Dictionary List" window.

5.1.3.1 Prerequisites

The dictionary must exist (except if you import a dictionary).

5.1.3.1.1 Calling sequence

Select:
1. The "Dictionary List" window in the OpenTM2 main window.
2. A dictionary with which you want to work.Skip this step when importing or creating.
3. An action from the File menu.

The "Dictionary List" window is displayed.

This window displays a list of the existing dictionaries. When you select a command from one of the menus, you are taken to another window where you
can specify processing options.

5.1.4 Creating an SGML-based dictionary
An SGML-based file contains dictionary data and SGML tags describing the data structure and the relation between the data elements.
SGML-based dictionaries can be created by:
¢ The OpenTM2 dictionary export function
¢ Data conversion programs or database macros
¢ Editing a file (only recommended for small data volumes)
If you have dictionary data in a format other than SGML, you must convert it before you can import it.
Importing the SGML-based file into OpenTM2 (which can be either ASCII, Ansi or Unicode) converts the dictionary into the internal format recognized by
OpenTM2.
5.1.4.1 The structure of an SGML-based dictionary
An SGML-based dictionary is divided into the following:
1. A header section containing general dictionary information such as source language, target language(s), and creation date.
2. A maptable section specifying the structure of a dictionary entry. That is, all the entry fields that make up a dictionary entry and the relation
between these entry fields.

3. An entry section with dictionary entries appearing one after another.

The dictionary is enclosed by a dictionary start tag <dict> and a dictionary end tag </dict> .

5.1.4.1.1 Header section
The header section contains general information about the dictionary such as:

e Type (for example, bilingual)
¢ Source language (for example, English (U.S.))
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¢ Date when it was created
¢ Codepage encoding

The dictionary header is marked with a header start tag <header> and a header end tag </header> .
The only information that you must provide in the header section is the source language of the dictionary. You can specify any of the languages for
which you have a language support file installed (if you need to specify another language, see What you can do for other languages). OpenTM2 needs

this information for reducing terms to their stem form when looking them up in the dictionary.

The header section can have the following tags:

Start tag End tag Description
<type> </type> Type of dictionary
<source> </source> Source language
<ltarget> </ltarget> Target language

<descript> </descript> Description of the dictionary, up to 255 characters long.
<createdate> </createdate> Date when dictionary was created

<CodePage> </CodePage> SGML-Format, can be UTF16, or ASCll=cp, or ANsi=cp
Example of a header section

<header>

<type>Bilingual</type>

<source>English(U.S.)</source>

<ltarget>German (national)</ltarget>

<descript>Basic Dictionary - English -> German</descript>
<CodePage>ASCII=850</CodePage>
<createdate>31/05/94</createdate>

</header>

5.1.4.1.2 Maptable section

The maptable section determines how a dictionary entry is structured. It serves as a model for the structure of an entry. The fields you defined in the
maptable section are reflected in the dictionary entries.

The maptable contains the total of all allowed fields (up to a maximum of 38) in a dictionary entry. If a dictionary entry contains entry field tags not
included in the maptable section, the information between the tags is not imported during dictionary import and only the entry fields listed in the
maptable are taken into account. The information between a start tag and its end tag contains the name you want to give the entry field of the dictionary.
You find these names displayed when you look up or edit a term in a dictionary.

For example, if you specify <hdterm> Source Term </hdterm>, the terms you look up in the dictionary are shown under Source Term. If you want to use
another name, rename Source Term into any other name you would like to use instead.

The following is an example of a maptable section:

Example of a maptable section

<maptable>
<hdterm>Source term</hdterm>
<hom>
<epos>English category</epos>
<sense>
<edef>Formal English definition</edef>
<target>
<trans>NL term</trans>
</target>
</sense>
</hom>
</maptable>

The maptable begins with the start maptable tag <maptable> and ends with the end maptable tag </maptable>. The <hom>, <sense>, and <target> start
tags with their respective end tags mark the homonym, sense, and target levels.

If you want to use the search criteria described in Searching for a dictionary entry, use the following start and end SGML tags:

Searching for ? Level Tags

<hdterm> and

Headwords Entry </hdterms

Abbreviations Sense <eabbr> and
</eabbr>

Synonyms Sense <esyn>and
</esyn>

Related terms Sense <erel> and </erel>

If you use the tags listed above, OpenTM2 establishes a correct relation between the entry field name and the term you want to look up in the dictionary.
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If you want OpenTM2 to add date information automatically to your dictionary entries, add the Creation Date and Update fields to the maptable.

If you want OpenTM2 to show style indicators in the dictionary lookup window, add the Style and the Trans Style fields to the maptable.

You can add any number of individually defined entry fields to any level. The entry field names are numbered and automatically mapped to an entry field
name denoted by you in the maptable. Entry fields you add to the entry, homonym, or sense level start with the tag <euser id=xxx> and end with the tag
</euser>, where xxx is the running number. Entry fields you add to the target level start with <tuser id=xxx> and end with </tuser>.

You can control the display panel (the panel on which a field is displayed in the "Lookup Entry" window) using the displevel= attribute. Use displevel=1
for fields to be displayed in panel 1, displevel=2 for fields to be displayed on panel 1 and 2 and displevel=3 for fields to be displayed on panel 1, panel 2,
and panel 3. To omit fields from the display in the "Lookup Entry" window use displevel=0.

The size of a dictionary field in the "Edit Entry in Dictionary" window is controlled using the entrytype attribute. Specify entrytype=1 for single line fields
and entrytype=2 for multi-line fields.

In order to display the contents of a dictionary field as additional dictionary data in the dictionary proposal area of the TranslationEnvironment specify the
autlookup attribute for the field.

Example of date-information fields and user-defined fields

<maptable>
<hdterm>?</hdterm>

<ecrdate>Creation date</ecrdate>
<hom>
<sense>

<euser id=1 displevel=2 entrytype=1 autlookup>Entry code</euser>
<elupdate displevel=3 entrytype=1>Last update</elupdate>

<target>

<trans>?</trans>

<tcrdate displevel=3 entrytype=1>Translation creation date</tcrdate>
<tlupdate displevel=3 entrytype=1>Translation update</tlupdate>
<tuser id=2 displevel=3 entrytype=2>Related definition</tuser>
</target>

</sense>

</hom>

</maptable>

5.1.4.1.3 Entry section

The entry section lists the actual entries in the dictionary one after the other. Each entry starts with an <entry> tag and ends with an </entry> tag. Each
entry contains the same entry field tags as used in the maptable section. Whereas the maptable contains the general description of the structure of an
entry, the entry section contains real data.

The levels below the entry level can be repeated as often as necessary, for example, to contain multiple senses or translations.

For an example of an SGML-based dictionary see Sample of an SGML-based dictionary.

5.1.4.2 List of dictionary-entry fields and their SGML tags

The following table shows a list of all dictionary-entry field tags as they are predefined in the -Master- model dictionary.

Level Entry field name Start tag End tag
Entry Headword <hdterm> </hdterm>
Entry Reliability Code <erlcode> </erlcode>
Entry Author <eauthor> </eauthor>
Entry Creation Date <ecrdate> </ecrdate>
Entry Status Code <estatcode> </estatcode>
Homonym Part of Speech <epos> </epos>
Homonym Morphology <emorph> </emorph>
Homonym Hyphenation <ehyph> </ehyph>
Sense Source of Headword <esrc> </esrc>
Sense Abbrev./Fullform <eabbr> </eabbr>
Sense Author of Update <eauthupdate> </eauthupdate>
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Sense Last Update <elupdate> </elupdate>
Sense Definition <edef> </edef>
Sense Source of Definition <esdef> </esdef>
Sense Synonym <esyn> </esyn>
Sense Other Related Terms <erel> </erel>
Sense Context <econtext> </econtext>
Sense Source of Context <escontext> </escontext>
Sense Comments <comment> </comment>
Sense Note on Usage <eusage> </eusage>
Sense Idiom <eidiom> </eidiom>
Sense Style <estyle> </estyle>
Target Language <tlanguage> </tlanguage>
Target Translation <trans> </trans>
Target Company/Subject Code <tsubjcode> </tsubjcode>
Target Source of Translation <tsrc> </tsrc>
Target Abbrev./Fullform <tabbr> </tabbr>
Target Reliability Code <trlcode> </trlcode>
Target Author <tauthor> </tauthor>
Target Author of Update <tauthupdate> </tauthupdate>
Target Creation Date <tcrdate> </tcrdate>
Target Last Update <tlupdate> </tlupdate>
Target Status Code <tstatcode> </tstatcode>
Target Part of Speech <tpos> </tpos>
Target Morphology <tmorph> </tmorph>
Target Hyphenation <thyph> </thyph>
Target Definition <tdef> </tdef>
Target Source of Definition <tsdef> </tsdef>
Target Synonym <tsyn> </tsyn>
Target Other Related Terms <trel> </trel>
Target Context <tcontext> </tcontext>
Target Source of Context <tscontext> </tscontext>
Target Comments <tcomment> </tcomment>
Target Note on Usage <tusage> </tusage>
Target Idiom <tidiom> </tidiom>
Target Trans Style <tstyle> </tstyle>

5.1.4.3 Sample of an SGML-based dictionary

The following is an example of an SGML-based dictionary containing a header section, a maptable, and two entries. The text to the right of the vertical
line is explanatory information or comments to the tags. All explanatory information must be omitted when you actually create an SGML-based
dictionary.

<dict> start of dictionary
<header> start of header section
<source>English (U.S.)</source> source language (required)
<descript>Basic Dictionary - English -> German</descript>
</header> end of header section
<maptable> start of maptable section

<hdterm>Source term</hdterm>
<eauthor>Created by</eauthor>
<ecrdate>Term Creation Date</ecrdate>
<hom>

<epos>Category</epos>

<sense>

<edef>Definition</edef>

<euser id=210>Private glossary</euser> user—-defined entry field
added to sense level
<target>

<tsubjcode>Subject code</tsubjcode>
<trans>Translation</trans>

<tuser id=1>Project code</tuser> user-defined entry field
added to target level

</target>

</sense>
</hom>
</maptable> end of maptable section
<entry> start of first entry
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<hdterm>file</hdterm>
<eauthor>Fred Miller</eauthor>
<ecrdate>940401</ecrdate>
<hom>
<epos>n</epos>
<sense>
<target>
<tsubjcode>EDV</tsubjcode>
<trans>Datei</trans>
</target>
</sense>
</hom>
</entry>
<entry>
<hdterm>abend</hdterm>
<eauthor>Peter G.</eauthor>
<ecrdate>940501</ecrdate> c
<hom>
<epos>v</epos>
<sense>
<target>
<tsubjcode>EDV</tsubjcode>
<trans>abnormal beenden</trans>
<tuser id=4>AS400</tuser>

headword: file

author: Fred Miller
creation date: 4/01/94
start of homonym level
part of speech: noun
start of sense level
start of target level
subject code
translation

end of target level
end of sense level

end of homonym level
end of first entry
start of second entry
headword: abend
author: Peter G.
reation date: 5/01/94
start of homonym level
part of speech: verb
start of sense level
start of target level
subject code
translation
user—-defined entry field
not in maptable, field
is ignored when this
dictionary is imported

</target> end of target level
</sense> end of sense level
</hom> end of homonym level
<hom> start of homonym level
<epos>n</epos> part speech: noun
<sense> start of sense level
<target> start of target level
<tsubjcode>EDV</tsubjcode> subject code
<trans>abnormale Beendigung</trans> translation
</target> end of target level
</sense> end of sense level
</hom> end of homonym level
</entry> end of second entry
</dict> end of dictionary

5.1.5 Creating a dictionary
OpenTM2 offers you several ways of setting up a new dictionary.

¢ If you do not have any existing terminology in machine-readable form, you must create a completely new dictionary. You do this by
determining the dictionary properties. In particular, you must define a dictionary structure. You can use a default structure offered by
OpenTM2, or you can use the structure of an existing dictionary in OpenTM2 and change it. A newly created dictionary is empty at first but
you can add entries from a new terms list built during document analysis or at any stage during the translation process. In this way you can
create dictionaries that contain specific terms related to your translation projects.

¢ During analysis, OpenTM2 can generate a found terms list that contains all terms of the document that exist in the referenced dictionaries.
OpenTM2 can also copy the entry data of these terms into a separate dictionary.

¢ If you have a terminology file in a format of your own, you must generate an external SGML-based dictionary and you must import it into
OpenTM2 . In this case, a new dictionary is created with your terminology and the entry structure as defined in the SGML file is taken.

If you create a new dictionary via the "New Dictionary" window in OpenTM2 and you do not use the modeling option, the following entry fields are
offered as default fields:

Entry field Level

Headword *) Entry

Part of Speech Homonym
Abbrev./Fullform *) Sense
Definition Sense
Synonym *) Sense
Other Related Terms *)  Sense
Context Sense
Translation Target

Company/Subject Code Target
The entry fields marked with *) can be used as predefined search criteria in the "Look up a Term" window (see Searching for a dictionary entry).

If you are working with a more comprehensive structure and require more entry fields, select -Master- in the "Use Existing Dictionary as Model" window,
which offers an extensive dictionary structure. You can rename or delete any fields from this set of entry fields and you can also add new user-defined

fields to it. OpenTM2 adds and updates time stamp information automatically, provided the following date fields are selected in the "New dictionary"
window from the -Master- model dictionary.

Entry field Level Contents
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Creation Date entry The date when a headword was added to a dictionary.

Last Update  sense The date when information at the sense level of an entry was added or modified.
Creation Date target The date when a translation for a headword was added.

Last Update  target The date when a translation entry field was last updated.

5.1.5.1 Prerequisites

None.

5.1.5.1.1 Calling sequence
Select:

¢ The "Dictionary List" window
¢ New... from the File menu

The "New Dictionary" window is displayed.

Mew Dictionary |

M arne: |

Description; |

— Location of dictionany
& Local

™ Shared

Dizk drive:

=

Source language:

Ilge exigting dictionary az model; Yes..
Change entry fields: “es
LCreate Protect. .. Cancel Help

Figure 101. New Dictionary window

5.1.5.1.2 Options and parameters
* Name
Type a name of your choice for the new dictionary. This name can be up to eight alphanumeric characters long.
¢ Description
Type a description for the new dictionary. The description can be up to 255 alphanumeric characters long.

¢ Location of dictionary

Specify where to place the new dictionary. It can be on a local disk drive (only you can use it) or on a shared disk drive (several translators
can use it simultaneously). See Sharing dictionaries to learn about sharing dictionaries.Select the drive on which you want the new dictionary
to reside. A dictionary grows with time, so select a drive with enough space.

¢ Source Language
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Select a source language from the list of installed languages displayed in the list box.
¢ Use existing dictionary as model
If you do not want to determine the dictionary entry structure yourself, you can use the structure of an existing dictionary as a model by
clicking Yes?. This takes you to the "Use Existing Dictionary as Model" window where you can select a dictionary as model. Click Select or
Cancel to return to the "New Dictionary" window. For more information on this option see Using an existing dictionary as model.
5.1.5.1.3 Change entry fields
If you want to change the dictionary entry structure (add, delete, or rename entry fields), click Yes?, which takes you to the "Change Entry Fields"
window where you can define your changes. Click Select or Cancel to return to the "New Dictionary" window. For more information on this option see
Changing dictionary entry fields.
To avoid unauthorized modification of a dictionary, you can protect it by clicking Protect?, which takes you to the "Protect Dictionary" window where you
can type a password of your own. Click Protect to return to the "New Dictionary" window. From now on, the dictionary can only be modified when the

correct password is supplied. For more information on how to protect and unprotect dictionaries see Protecting a dictionary.

Click Create to create the new dictionary.

5.1.5.1.4 Results

The dictionary is created but still empty. When the dictionary has been created, its entry structure is fixed and can no longer be changed. You can now
start to fill it by importing an SGML-based file, by entering terms from a new terms list, or by editing dictionary entries.

5.1.6 Using an existing dictionary as model

All dictionaries have a dictionary entry structure. In OpenTM2 you can use the given default structure, use an existing dictionary structure with or without
changes, or define a new structure based on all the available entry fields.

5.1.6.1 Prerequisites

Decide on which dictionary entry fields your dictionary is to contain.

5.1.6.1.1 Calling sequence
Select:

1. The "Dictionary List" window.
2. New from the File menu. The "New Dictionary" window is displayed.
3. Yes... next to the Use existing dictionary as model option.

The "Use Existing Dictionary as Model" window is displayed.

Usze Exizting Dictionary az Model |

EREIFRER
ENGLGERM
FREMENGL
GERMENGL
M azter-
SAMPLE
SHOWDICT =

Select Cancel | Help |

Figure 102. Use EXxisting Dictionary as Model window

5.1.6.1.2 Options and parameters

The list of existing dictionaries is displayed in the list box. Select a dictionary with the structure you want to use as a model from this list or select
-Master-, which contains all the entry fields predefined by OpenTM2.
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Click Select to return to the "New Dictionary" window where you can view and change the selected entry structure by selecting the Change entry fields
option.
5.1.6.1.3 Results

You have determined which entry structure to use as a base for the new dictionary.

5.1.7 Changing dictionary entry fields

Select this function to make modifications to a dictionary entry structure. You can delete entry fields, rename entry fields, or add new user-defined entry
fields. You can determine the size of the entry field and what entry field data you want to have displayed on which panel of the "Lookup Entry" window.

5.1.7.1 Prerequisites

Decide on which dictionary entry fields your dictionary is to contain.

5.1.7.1.1 Calling sequence
Select:
1. The "Dictionary List" window.
2. New... from the File menu. The "New Dictionary" window is displayed.

3. Yes... next to the Change entry fields option.

The "Change Entry Fields" window is displayed.

Change Entry Fields |

‘Headwn —Display———— ~Lewvel
Part af Speech - Ent
Abbrev /Fulliom & Panel 1 iy
Definition ™ Panal 2 Hamarym
Synonym

Other Belated Tems " Panel 3 SENEE
Contest _ Ot T
Tranzlation

Company/Subject Code

I st Loatun Change name...

o Add field..
" Large
' Small Delete field

Change | Cancel | Help |

Figure 103. Change Entry Fields window

5.1.7.1.2 Options and parameters
¢ Entry fields
This list box contains all the entry fields defined for this dictionary. Select one entry field at a time and define your settings for this field.
¢ Display

If you want this entry field to be displayed in one of the panels of the "Lookup Entry" window, decide on which one. This means choose
between Panel 1 (for the most relevant data), Panel 2, and Panel 3.

Select Omit if you want the entry field and its data not to be displayed on any of the lookup panels. The entry field is not deleted from the entry

structure. Select Aut. Lookup to display the complete entry field information in the window showing the found dictionary proposals during
translation.
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e Level

To specify the level you want the entry field to belong to, select a corresponding entry field so that the required level is active. It can be Entry,
Homonym, Sense, or Target.

* Size
Select one of the two choices:

O Small
Is adequate for an entry field of about a line in length (the maximum is 255 characters).

’ Il_sarzge?aded for an entry field consisting of several lines of data.Select this size only if absolutely necessary because the use of too
many large fields decreases the performance of OpenTM2.
For each selected entry field you can clicke of the following:
e Change Name?
To rename the entry field. See Renaming a dictionary entry field for details.
¢ Add Field?
To add a new user-defined entry field to the list of entry fields. For more detail see Adding a user-defined entry field.
e Delete field

To remove the entry field from the entry structure.

When all of the entry field settings are complete, click Change. This takes you back to the "New Dictionary" window.

5.1.7.1.3 Results

The entry structure of the selected dictionary is changed according to your specifications, this means the dictionary can have more or fewer entry fields,
changed entry field names and sizes, and changed lookup display options.

5.1.8 Renaming a dictionary entry field

In OpenTM2, all entry fields are automatically assigned a name. You can change the field name to any other name. The changed names are used in all
windows where dictionary entry data is displayed. For example, you may want to change Headwordto Term, or Part of speech to Category. You can

also change the field names to another language of your preference.

You can change the entry field names of an existing dictionary when you create a new dictionary.

5.1.8.1 Prerequisites

Decide which dictionary entry field names you want to use in your dictionary.

5.1.8.1.1 Calling sequence
When creating a new dictionary, select:
1. The "Dictionary List" window.
2. New... from the File menu. The "New Dictionary" window is displayed.
3. Yes... next to the Change entry fields option.
4. The entry field you want to rename in the "Change Entry Fields" window.
When changing the properties of an existing dictionary, select:
1. The "Dictionary List" window
2. The dictionary to which you want to make changes
3. Properties... from the File menu
4. The entry field you want to rename in the "Dictionary Properties" window

The "Change Entry Field Name" window is displayed.
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5.1.8.1.2 Options and parameters

Type the new field name in the Displayed as field. Click Change to rename the selected field.

5.1.8.1.3 Results

The selected dictionary entry field is renamed. You are returned to the "Change Entry Fields" window when you create a new dictionary or to the
"Dictionary Properties" window when you change the properties of an existing dictionary.

5.1.9 Adding a user-defined entry field

The predefined entry fields in OpenTM2 dictionaries are only examples of possible fields you can use when you create a new dictionary and determine
its structure.

You can add your own user-defined fields to any of the four levels that make up the dictionary structure.

You can only add user-defined fields when you create a new dictionary. When the dictionary already exists, you cannot change its structure.

5.1.9.1 Prerequisites

Decide which dictionary entry fields you want to add to your dictionary structure.

5.1.9.1.1 Calling sequence
The "Dictionary List" window
1. New... from the File menu
2. Yes... next to the Change entry fields option in the "New Dictionary" window

3. An entry field belonging to the level to which you want to add a field

The "Add Entry Field" window is displayed.

5.1.9.1.2 Options and parameters

Type a name for the entry field you want to add in the Displayed as field. Click Add to add the new field to your structure.

5.1.9.1.3 Results

The entry field is added to the dictionary structure at the same level as the entry field you have selected before clicking Add field?. You are returned to
the "Change Entry Fields" window.

5.1.10 Defining a dictionary filter
A dictionary filter is a means by which data in a dictionary can be selected so that only entries that meet specified conditions are displayed or printed.

In OpenTM2 filters can be used in combination with printing (see [Working with dictionaries#Printing a dictionary|Printing a dictionary]]) or dictionary
lookup (see Looking up a dictionary entry). You can use an existing filter, change an existing one, or create a new one.

In OpenTM2 a filter condition consists of:filterconditions
¢ An entry field (such as Headword, Translation)
* An operator (such as = or >)
¢ An operand (such as a*)
For example, the condition Headword LIKE = 'a* selects all (and only) the entries beginning with the letter a.

There are two types of operators:

1. (=, <>, <, >, <=, >=, LIKE, BETWEEN and IN form expressions (for example, Headword = 'Test').
2. AND, OR, (,) and NOT) join valid expressions to form a larger expression (for example, Headword = 'Test' AND Translation = 'Test').

The operators have the following meanings:
L

The field must contain exactly the value specified.

<>
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The field must not contain the value specified.
<
The field can contain only values that are less than the value specified, for example, preceding the specified value in alphabetical sequence.
*>
The field can contain only values that are greater than the value specified, for example, following the specified value in alphabetical sequence.
o <=
The field can contain only values that are less than or equal to the value specified.
°o>=
The field can contain only values that are greater than or equal to the value specified.
¢ LIKE
The field can contain values that are similar to the value specified, for example, they start with the specified value.
e BETWEEN
The field can contain values that are in a range between one value and another.
¢IN
The field can contain values that match up to six different values.
e AND
This operator joins two expressions so that both expressions must match in order to let the entry pass the filter.
*OR
This operator joins two expressions so that one or both expressions must match in order to let the entry pass the filter.
* NOT
This operator specifies that the filter let pass only those entries that do not match the specified value.
e(and)
These operators are used to group expressions. Expressions in parentheses are processed before expressions without parentheses.

Note: All filters depend on the dictionary entry structure. This means that a filter created for one dictionary possibly refers to entry fields that are not
contained in another dictionary. In such cases, it is recommended to create a new filter for each dictionary.

5.1.10.1 Prerequisites

Either the "Look up a Term" window or the "Print Dictionary" window is active.

5.1.10.1.1 Calling sequence

1. Select the Use filter option.
2. Click Edit....

The "Edit Dictionary Filter" window is displayed.
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Figure 104. Edit Dictionary Filter window

5.1.10.1.2 Options and parameters
The dictionary-filter parameters are as follows:
e Name
Lists the name of all available filters. If you specified or selected an existing filter in the Print Dictionary or "Look up a Term" window, the

name of this filter is displayed first in the list. If you specified a new filter in either of these windows, this field is empty and the new name is
only displayed in the Save to box.If you want to change an existing filter, select this filter. If you want to create a new filter, skip this box.

e Description
Displays the description of a filter if one was entered. For a new filter, type a descriptive text.
e Available fields

Lists the name of all entry fields that a dictionary entry consists of.If you want all entry fields to appear in the printout or in the "Lookup Entry
window (depending on which window you came from) but do not specify any conditions for the entry fields, you can skip this box. If you want
specific entry fields to appear in the printout or in the "Lookup Entry" window but do not want to specify any conditions for them, double-click
these entry fields. They will appear in the SELECT box. If you also want to specify conditions for one or more entry fields using one of the
operators =, <>, <, >, <=, >=, LIKE, BETWEEN, and IN, double-click the entry field and then double-click the operator. The "Set Dictionary
Condition" window is displayed in which you can specify one or more values, depending on the operator that you selected. The condition that
you specify is displayed in the WHERE box after you leave the "Set Dictionary Condition" window.

Note: The operators AND, OR, NOT, (, and ) can only be selected for the WHERE box.Lists the entry fields defined for the selected
dictionary.

¢ Operators

Lists the available operators that can be used with an entry field to specify a filter condition.
¢ Condition

Displays the defined filter condition:

0 SELECT
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Lists the entry fields that you selected in the Available fields box. Only those listed here will appear in the printout or in the "Lookup
Entry" window, depending on which window you came from.To add more entry fields, double-click them in the Available fields box.
To include all fields, leave this box blank or type an asterisk (*).
0 WHERE

Contains the condition that you specified and that a dictionary entry has to match in order to pass the filter. A condition expression
consists of an entry field, an operator, and a value.To add an expression, double-click an entry field in the Available fields box and
then double-click one of the operators =, <>, <, >, <=, >=, LIKE, BETWEEN, and IN. The "Set Dictionary Condition" window is
displayed in which you can specify one or more values, depending on the operator that you select. The expression that you specify
is displayed in the WHERE box after leaving the "Set Dictionary Condition" window. To join expressions, move the cursor between
the expressions to be joined and then double-click the operator AND, OR, or NOT. For example, Headword = 'Test' AND
Translation = "Test'. To group expressions, move the cursor to the beginning or end of an expression and then double-click the
operator ( or).

¢ Save to

Displays the filter name that you specified or selected in the Print Dictionary or "Look up a Term" window or selected from the Name list. You
can type a new name or select the name of an existing filter. In the latter case, the existing filter is overwritten.

Select Save to create the new or changed filter. Select Delete to delete the displayed filter.
For example, if you want to create a filter that selects only those entries in the dictionary that begin with the letter a, define the filter as follows:
1. Click the field name Headword in the Available fields list box to mark it.
2. Double-click the LIKE operator in the Operators list box. The "Set Dictionary Condition" window appears.
3. Type a* or A* at the cursor position and click Set. The input can be in uppercase, lowercase, or mixed-case characters.
4. The condition is displayed in the WHERE field.

5. Enter a name for the filter (for example,ONLYA) in the Save to combination box.
6. Click Save to create the filter.

5.1.10.1.3 Results

The changed or new filter is saved and can be used for dictionary lookup or printing. You are returned to the previous window.

5.1.11 Renaming a dictionary

OpenTM2 enables you to give a dictionary a new name.

5.1.11.1 Prerequisites

The dictionary must exist.

5.1.11.1.1 Calling sequence
Select:

1. The dictionary from the "Dictionary List" window
2. Rename from the File menu

5.1.11.1.2 Options and parameters
e Rename to
Type a new name for the dictionary.
¢ Adjust all references automatically

If you select this option, all references to the renamed dictionary are also changed.

5.1.11.1.3 Results

If you select Rename, the dictionary and, optionally, any references to it are renamed.
5.1.12 Deleting a dictionary

Deleting a dictionary can be useful when you have exported it or archived it outside of OpenTM2 and no longer need it, and you require free space on
your disk. For deleting a shared dictionary, see Deleting a shared dictionary.
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5.1.12.1 Prerequisites

Make sure that you have a backup copy of the dictionary before deleting it if it contains important data.

5.1.12.1.1 Calling sequence
Select:
1. "Dictionary List" window

2. The dictionary you want to delete
3. Delete from the File menu

5.1.12.1.2 Options and parameters
A confirmation message appears before the dictionary is deleted.
If you select No, the delete function is canceled.

If you select Yes, the dictionary is deleted.

5.1.12.1.3 Results

If you select Yes, the dictionary is deleted. References to this dictionary may still exist in certain folders. Update the folder properties so that the deleted
dictionary is not referenced anymore.

5.1.13 Editing a dictionary entry

Individual dictionary entries can be changed, for example, a new translation can be added or an existing obsolete translation deleted.

You can edit a dictionary entry at any time before, after, or during translation.

5.1.13.1 Prerequisites

The dictionary must exist.

5.1.13.1.1 Calling sequence
There are several ways to get to the "Edit Entry in Dictionary" window:
e To add, change, or delete a dictionary entry outside the Translation Environment, select:
1. The "Dictionary List" window
2. The dictionary you want to open
3. Open from the File menu
4. The term to enter in the "Look up a Term" window
5. Headword search type and click Edit...
¢ To add, change, or delete a dictionary entry in the Translation Environment, select:
1. The document for translation in the "Document List" window
2. Open from the File menu
3. The term in the document to add or modify by marking it
4. Edit a term... in the Translate menu
¢ Or select:

1. The term in the "Dictionary"window and double-click it
2. Edit in the "Lookup Entry" window

In all cases, the "Edit Entry in Dictionary" window is displayed.
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Figure 105. Edit Entry in Dictionary window

5.1.13.1.2 Options and parameters

The entry displayed in the "Edit Entry in Dictionary" window is split up into templates. A template is the complete dictionary entry information related to
one translation. This window shows one template at a time.

If the term does not exist, only one empty template is displayed.|f, on the other hand, the term exists, the first template (translation) is displayed.
e Template 1 of 1

The term in the sample window has one translation. This box displays all data related to this translation, this means, each entry field with its
name and its contents.

e Template
The following options let you scroll through all templates of an entry or change complete templates.
Select:

O Next
To select the following template.

0 Previous
To select the previous template.

0 Add
To add an empty template for a new translation variant.

¢ Copy
To copy the contents of the currently displayed template into a new one where you can type over the contents to add the new
translation. You would use Copy instead of Add in cases where only minor changes need to be made to a translation variant.

0 Delete
To delete the currently displayed template.
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¢ Clipboard

By selecting options in this box, you can move data from the current template to the clipboard and vice versa, for example, you can insert
context information from the document in the Translation Environment.

¢ Copy
To copy a marked text to the clipboard.

0 Paste
To copy a previously saved text from the clipboard to the current cursor position.

To delete the entire entry from the dictionary, click Delete at the bottom of the window.
Click Save to save your changes to the dictionary displayed in the Save to dictionary list box. In the Translation Environment, you can choose

between any of the dictionaries opened for translation (defined as a folder property). Outside the Translation Environment, you can only save the data
to the dictionary you explicitly selected.

5.1.13.1.3 Results

A new term is added to the dictionary, or an existing term is changed or deleted.

5.1.14 Exporting a dictionary
There are two ways to export dictionary data, within a folder in the internal OpenTM2 format or as an external dictionary in SGML format.

Export a dictionary if you want to pass the dictionary on to other OpenTM2 users or to create a backup copy of a dictionary. Protected dictionaries must
be exported in a folder. For more information on folder export, see Exporting a folder.

Exporting a dictionary into an SGML-based file is required if you want to use the dictionary data in environments other than OpenTM2.

Exporting a dictionary can also be part of the conversion of a dictionary into Unicode. To convert a dictionary into Unicode, you must first export it from
OpenTM2 and then import it again. In both cases, you select SGML Unicode as export or import format.

5.1.14.1 Prerequisites

Sufficient disk space for the exported dictionary is available.

5.1.14.1.1 Calling sequence
Select:
1. The "Dictionary List" window
2. The dictionary you want to export

3. Export... from the File menu

The "Export dictionary" window is displayed.
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Figure 106. Export Dictionary window

5.1.14.1.2 Options and parameters
e Save in
Select the drive and directory to which the dictionary is to be exported.
¢ File name
Contains the name of the dictionary to be exported. You can overwrite it with a new name.
¢ Save as type

Select the format in which the dictionary is to be stored. Select SGML Unicode if the export is part of your conversion of the dictionary into
Unicode.

Click Save to begin exporting the dictionary. If you specified a new directory name, you are prompted to confirm whether you want to create this new
directory.

5.1.14.1.3 Results

An SGML-based dictionary file is created at the specified location and can be given to other users or programs for further usage.

5.1.15 Importing a dictionary
You can import a dictionary as an external dictionary (SGML-based) or within a folder in the OpenTM2 format.

If you want to work with terminology created outside OpenTM2, create an SGML-based file (for more details, see Creating an SGML-based dictionary)
and import this file into OpenTM2. You can either import the file into a new dictionary or merge the data into an existing dictionary.

Dictionaries imported in a folder are in OpenTM2 format. If the dictionary does not exist, a new dictionary is created; if it does exist, the folder dictionary
is merged into the existing one. For more information on folder import, see Importing a folder.

When merging two dictionaries, the dictionary structure of the destination dictionary is maintained. Data in entry fields that exist only in the source
dictionary and not in the destination dictionary will not be regarded and data may be lost. Entry fields not contained in the external dictionary will be
empty in the dictionary after importing.

If you select to import an external dictionary under a new dictionary name, the "New Dictionary" window is displayed where all the properties are shown
as they are coded in the SGML-based file. You can change certain properties if you want to, although this is not always advisable as the changed
properties may be different from what is specified in the SGML file.

Importing a dictionary can also be part of the conversion of a dictionary into Unicode. To convert a dictionary into Unicode, you must first export it from
OpenTM2 and then import it again. In both cases, you select SGML Unicode as export or import format.
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5.1.15.1 Prerequisites

The SGML-based file for import must have been created according to the description in Creating an SGML-based dictionary.

5.1.15.1.1 Calling sequence
Select:
1. The "Dictionary List" window
2. A dictionary if you want to merge dictionaries

3. Import... from the File menu

The "Import Dictionary" window is displayed.

Dictionary Import
lookin: |23 SGML-ANSI =] £ ER-

_ﬂ aaa.5iGM
2] allz.56M
2] all3.56M
2] all.56M

File name: | Import
Format: |SGML ANSI (" SGM) | Cancel
To dictionary: [[SHeIlel=si] j

Figure 107. Import Dictionary window

5.1.15.1.2 Options and parameters
e Look in
Select the directory where the dictionary to be imported resides.
e File name
Enter the name of the external dictionary to be imported.
e Format
Select the format of the dictionary to be imported.
¢ To dictionary

Contains the name of the selected dictionary to be imported. You can overwrite this name to create a new dictionary or select a name from the
list box to merge your file into an existing dictionary.

Click Import to begin the import function.

If OpenTM2 detects an incorrect SGML tag in the SGML-based file, a message is displayed, asking you if you want to skip the entry containing the error
or to cancel the import process.

If you selected to import an external dictionary under a new dictionary name, the "New Dictionary" window is displayed where all the properties are
shown as they are coded in the SGML-based file. For more information, see Creating a dictionary.

If you selected to merge the external dictionary into an existing dictionary in OpenTM2, remember that the dictionary structures may differ and that there

may be identical terms. In case of conflicts you are prompted to specify additional options for merging dictionaries in the "Merge Dictionary Entries"
window. For more information, see [Working with dictionaries#Merging dictionaries|Merging dictionaries]].
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5.1.15.1.3 Results

The external dictionary data is imported either under a new name or merged with an existing dictionary. You can begin to use it in OpenTM2. The
external dictionary is unchanged.

5.1.16 Looking up a dictionary entry
There are several ways to look up dictionary entries in OpenTM2:

¢ During translation, OpenTM2 automatically displays the translation of all terms in the currently active segment for which entries are found in
the dictionaries selected for search in the folder. The dictionaries are searched in the order defined in the folder properties (see Changing the
properties of a folder), and the first entry found is displayed in the dictionary window.

¢ To view the complete dictionary entry or to check if there are any further entries in other dictionaries, you can double-click the term, and the
"Lookup Entry"window for this term is displayed, which allows you to select the dictionary (if the entry occurs in more than one of the folder
dictionaries) and the lookup panel you want to see.

¢ You can also mark a term or a multiword term in the "Translation"window and select Look up a term... from the Translate menu. If the term
is not found in the dictionaries, the "Look up a Term" window is displayed. If the term is found in the dictionaries, the "Lookup Entry"window is
displayed containing the data for this term.
Outside the Translation Environment you can look up entries only in one dictionary at a time.
How to search for terms in a dictionary is described in Searching for a dictionary entry. How to edit an existing entry in a dictionary after you have
retrieved it is described in Editing a dictionary entry.
5.1.16.1 Prerequisites
¢ The dictionary must exist.
¢ The term you want to look up must exist in the dictionary.
5.1.16.1.1 Calling sequence
Outside the Translation Environment, follow this procedure to look up a dictionary entry:
1. Select the "Dictionary List" window.
2. Double-click the dictionary you want to open. The "Look up a Term"window is displayed, where you can type the term, select your search
type, and define a filter if you want to restrict your search. For more detail on defining a filter, see Defining a dictionary filter.
3. Type the term you want to look up in the Term field.
4. Select the Headword search option.
5. If the term exists in the dictionary, click Look up in the "Look up a Term"window. Otherwise OpenTM2 offers you to add the term to the
dictionary (see also Editing a dictionary entry).
During translation in the Translation Environment, there are several ways to look up a dictionary entry:
e Using a displayed term in the "Dictionary" window, double-click the term you want to look up. The "Lookup Entry"window is displayed (see
Figure 108).

¢ Using a term in the "Translation" window:

1. Mark the term, possibly a multiword term.
2. Select Look up a a term... from the Translate menu.

If the specified term does not exist in the selected dictionary, the "Look up a Term" window is displayed (see Figure 111) showing existing terms
preceding and following the marked term in alphabetical sequence. For more information on searching, see Searching for a dictionary entry.

In all cases, if the specified term exists in the dictionary, the "Lookup Entry" window is displayed.
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Copy Edit__. Print.__. Cancel Help |

Figure 108. Lookup Entry window

5.1.16.1.2 Options and parameters
¢ Dictionary
This field contains the name of the first dictionary where the term and its entry data are found. If the lookup function was called from the
Translation Environment and the folder properties contain more than one dictionary, you can switch between the different dictionaries to see
whether the same term is in more than one dictionary.
e Display
In this field, you can switch between the lookup panels 1, 2, and 3 to display entry data of this term as defined in the dictionary structure.
The large center box contains entries for the found term in the displayed dictionary according to the panel selection.

Click Print to print the data of the term on your workstation printer.

Click Edit? if you want to edit the entry data of the found term in the "Edit Entry in Dictionary" window. For more information on editing, see Editing a
dictionary entry.

Click Copy to copy a marked text to the clipboard.

Click Cancel to leave the window.

5.1.16.1.3 Results

The entries for the selected term are displayed. The entries are changed, printed, or copied to the clipboard depending on the options you selected in
this window.

5.1.17 Merging dictionaries

Merging two dictionaries is only supported when you import an external dictionary into an existing one in OpenTM2. When you do this, remember that
the dictionary structure of the destination dictionary has precedence. You are warned if the dictionary structures differ, and OpenTM2 allows you to

create a new dictionary instead, to prevent any loss of data.

If, during dictionary merge, the same term exists in both dictionaries, the "Merge Dictionary Entries" window is displayed.
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Figure 109. Merge Dictionary Entries window

5.1.17.1 Options and parameters
e Term
Displays the term that exists in both dictionaries.
¢ Merge from SGML dictionary
Contains the entries in the external dictionary for this term.
¢ Merge into target dictionary
Contains the entries in the existing dictionary for this term.
¢ Options

Depending on how you want to process the entries for the current term (displayed in the two boxes), select one of the following options or click
Cancel to stop the merging:

0 Replace target entry with source entry
This option only takes the source dictionary entry into consideration. The destination dictionary entry is overwritten.

0 Ignore source entry
This option only takes the destination dictionary entry into consideration. The source dictionary entry is discarded.

¢ Combine entries
This option takes both the source dictionary and the destination dictionary entries into consideration, combining them to form one
entry. Provided that the dictionary structures do not differ, no data is discarded or overwritten.

* Use the selected option for all entries

Select this option, if you do not want the "Merge Dictionary Entries" window to appear every time the same term is found in both dictionaries
and you are sure that your selected merge option applies for all entries.
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Click Merge to begin or to continue the merging.

Click Cancel to leave the merging and importing program.

5.1.17.1.1 Results

The external dictionary data is merged with the existing dictionary according to the specified options. The external dictionary is unchanged.

5.1.18 Opening a dictionary

To look at dictionary data, you must open it. In a dictionary, you can search for specified terms, you can look up the data of an existing term, you can
change the entry data of an existing term, and you can add entries for new terms.

Opening a dictionary can be done in several ways outside the Translation Environment and during translation in the Translation Environment.
Opening a dictionary is automatically done, when you use one of the following functions:

¢ Editing a dictionary entry

e Looking up a dictionary entry

e Searching for a dictionary entry
5.1.19 Organizing a dictionary

Organizing makes the dictionary compact and increases performance. Dictionaries to which you frequently make changes should be organized
periodically.

If an error occurs during dictionary processing, you are prompted to organize the dictionary because organizing often rectifies the error.

5.1.19.1 Prerequisites

The dictionary must exist.

5.1.19.1.1 Calling sequence
Select:
1. The "Dictionary List" window
2. The dictionary you want to organize

3. Organize from the File menu

The organize procedure starts immediately.

5.1.19.1.2 Options and parameters

None.

5.1.19.1.3 Results

The dictionary is organized, informing you how many terms have been organized, and you can continue using it.

5.1.20 Printing a dictionary
You can choose to print a complete dictionary or parts of it.

If you only want to print part of a dictionary, for example all entries with a headword starting with the letter a, or only some of the entry fields, or only the
headwords and the translations, you can define a filter for the print function.

You must define the layout of your print output in format files that you edit with a text editor. In the print format file you define the entry fields to be
printed and how they are arranged in the printout.

You can send your printout to an attached workstation printer or have the printout data sent to a file.
Before printing a dictionary or part of a dictionary, the output file structure must be determined. If you decide not to use one of the format files provided
by OpenTM2, you must create this file in the subdirectory \egf\prtform. For more information on how to use the sample format print files see Defining the

printout format. For a detailed description of the structure and syntax of a print format file see Format files for printing a dictionary#Defining your own
format file.
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5.1.20.1 Prerequisites
¢ The dictionary must exist.
e The format file for the specific printout layout must exist.
5.1.20.1.1 Calling sequence
Select:
1. The "Dictionary List" window
2. The dictionary you want to print

3. Print... from the File menu

The "Print Dictionary" window is displayed.

Print Dictionary |

M arme; SarPLET
D eszcription: Dictionary for Sample Seszzion 1
— Dlutpuit ko
& Printer
" Fil= Selecth, |
i Emie: |
— Formnat
Hame: [FORMATT FRM ~]
Description: Format for SAMPLET and SAMPLE 2

— Filter .
™ Use filker Edit. |
[ amme: I j

[Mesanptam

Frint... Cancel | Help |

Figure 110. Print Dictionary window

5.1.20.1.2 Options and parameters
* Name
The selected dictionary name.
¢ Description
The dictionary description text.
¢ Output to
In this box, select where you want to send your printout to:

0 Printer
If you want the printout on your attached workstation printer.

0 File
If you want the printout on file. Enter the complete file name specification?consisting of drive, path, file name?in the Name field
yourself or click Select?, which takes you to the "Select File" window assisting you in selecting the drive, directory, and file name
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(see #Specifying an output file).
¢ Format
Specify the print format file to be used:

0 Name
Select a format file from the list of available files. If you created a new format file, it should appear in this list.

¢ Description
Describes the selected format file.

o Filter
Specify whether to use a filter. You can use an existing filter or change it or create a new filter.

O Use filter
To use a filter, select this option and specify which filter to use:

0 Name
Lists all available filters. To use or change an existing filter, select it. To define a new filter, type the name in the list box.

¢ Description
Describes the selected filter.

Click Edit? to define the new filter or to change an existing one, which takes you to the "Edit Dictionary Filter" window. For more information on how to
define filter conditions, see Defining a dictionary filter.

Click Print to start the printing function.

5.1.20.1.3 Results

If you selected the Printer option, the dictionary printout is sent to your attached printer. If you selected the File option, the dictionary printout is stored in
the specified file.

5.1.21 Defining the printout format
OpenTM2 provides sample print-format files that you can use to print dictionary data or as a basis for defining your own print output format.

To become acquainted with format files, use the FORMAT1.FRM print format file for printing one of the sample dictionaries provided in a sample folder
(for example SAMPLE?2).

When you change a format file or create one of your own, make sure you follow the required syntax of the format file. All print-format files are located in
the subdirectory \eqgf\prtform.

The following sample files are provided by OpenTM2:

File name  Description
formati.frm Prints each headword and its translation.
format2.frm Prints all templates for each entry without formatting.

For this format file, it is recommended to select the File output option because it generates a BookMaster (R) source file (containing all
templates for each entry). This file must be processed by BookMaster (R) outside OpenTM2 to obtain a formatted dictionary printout.
format4.frm Prints a dictionary extract consisting of cover page, body part, header section, and current page number for each page.

All the print-format files provided by OpenTM2 are described in detail in Sample format files. For a complete and detailed description of the structure
and syntax of print-format files see [JFormat files for printing a dictionary#Defining your own format file|Defining your own format file].

format3.frm

Experienced users can use the print function also for generating new external dictionaries, which again can be imported and used in OpenTM2. For
example, you can:

¢ Generate a reverse dictionary from an existing one (this means, generate a German to English dictionary from an English to German
dictionary).

e Generate a new dictionary containing selected entries from another dictionary. This can be useful, for example, when you have a dictionary
containing translations into several languages and want to extract the entry data related to translations into one of the languages.

5.1.22 Protecting a dictionary

To avoid uncontrolled modification, you can protect dictionaries, that is, everyone can browse these dictionaries, but only authorized persons
responsible for updating dictionaries (for example, a terminologist) can make changes to them.
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You protect them by assigning a password to them. You can protect dictionaries in the "New Dictionary" window when creating a new dictionary or in the
"Dictionary Properties" window when viewing its properties by pressing the Protect? button.

If you are not authorized to edit a protected dictionary but want to make changes to existing entries or add new entries, you can do this by creating a
new dictionary using the protected dictionary as a model. For more details see Creating a dictionary. You can then use the new dictionary as an
addendum dictionary to the protected one. Redefine any dictionary search sequence so that this addendum dictionary precedes the protected dictionary.

You can send this addendum dictionary to a person who is authorized to edit protected dictionaries and can update these dictionaries on the basis of the
modifications and additions made in your addendum dictionary.

When you start creating a new dictionary, the unprotected mode is the default setting. In this mode you can carry out any modifications to that dictionary.

Dictionary task Unprotected Protected
Export to SGML-based dictionary Yes No
Delete a dictionary Yes Yes
Export folder with dictionary Yes Yes
Look up a dictionary entry Yes Yes
Edit a dictionary entry Yes No
Organize a dictionary Yes Password

The following table shows you which tasks you can perform with unprotected and protected dictionaries:
The following table shows the merge options that are available:

Dictionary merge from To unprotected dictionary To protected dictionary

SGML-based dictionary Yes Password
Unprotected folder dictionary Yes No
Protected folder dictionary No No

5.1.22.1 Calling sequence
To protect an existing dictionary, select:

1. The "Dictionary List" window

2. The dictionary you want to protect

3. Properties... from the File menu

4. Protect in the "Dictionary Properties" window
To protect a new dictionary, select:

1. The "Dictionary List" window

2. New from the File menu

3. Protect in the "New Dictionary" window

The "Protect Dictionary" window is displayed. Enter your new password twice and confirm by clicking Protect.

5.1.22.1.1 Results

The dictionary is protected, for example, only those that know the password have read-write access to the dictionary. Those who do not know the
password have read-only access.

The protection status of a dictionary can be revoked if the password assigned to the respective dictionary is known.

5.1.22.1.2 Calling sequence
Select:
e The "Dictionary List" window
e The dictionary you want to unprotect
¢ Properties... from the File menu
e Click Unprotect...
The "Query Password for Dictionary" window is displayed.

This window is also displayed when you try to perform an action that makes changes to the dictionary.

In this window you can enter the dictionary password and confirm by pressing the OK button.
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5.1.22.1.3 Results

The dictionary is unprotected and everyone can change it.

5.1.23 Searching for a dictionary entry
If you want to know whether a certain term is included in a dictionary, you can search for this term in several ways, this means with a:
e Complete or incomplete term
¢ Predefined search type
¢ Dictionary filter defined by you
e Combination of these
Searching for a term can be done outside the Translation Environment and during translation in the Translation Environment.
To search for a term, you specify the term and the search parameters in the "Look up a Term" window.
If more than one term matches with the specified search criteria, you can select the term you are currently interested in to display its data.
If the term is found in the dictionary, you can display and edit the complete entry in subsequent windows (Look up Entry and Edit Entry in Dictionary).
If the specified term is not found in the dictionary, you can add a new entry for this term. What you can do in the following windows is described in
Looking up a dictionary entry, and Editing a dictionary entry.

5.1.23.1 Prerequisites

The dictionary must exist.

5.1.23.1.1 Calling sequence
To search for a term outside the Translation Environment, select::
1. The "Dictionary List" window
2. The dictionary you want to open
3. Open from the File menu
Alternatively, double-click the dictionary in the "Dictionary List" window in the main window.
To search for a term in the Translation Environment, select:
1. A term or a multiword term in the "Translation" window by marking it
2. Look up a term... from the Translate menu.If the term exists in the dictionary, the "Look up Entry"window for this term is displayed. For more
information, see Looking up a dictionary entry. If the term does not exist in the dictionary, OpenTM2 starts searching for the term as if you

specified the search option.

The "Look up a Term" window is displayed.
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Figure 111. Look up a Term window

5.1.23.1.2 Options and parameters
e Term
If you came from the "Dictionary List" window, type the term you are looking for. You can type a single term or a multiword term. You can use
an asterisk (*) to get a list of all terms in the dictionary, or use the asterisk as part of a term to get a list of terms. For example, enter app* to
get a list of all terms starting with the letters app. You can enter the term in uppercase, lowercase, or mixed-case characters.

If you came from the Translation Environment, the term that you highlighted or on which you positioned your cursor is displayed and a list of
up to 30 terms preceding and following the term in alphabetical order.

¢ Type of search
The synonym, related term, and abbreviation search types are greyed out if the corresponding entry field does not exist in the dictionary.
Select one of the following search types:

¢ Neighborhood
To display the 30 terms preceding and the 30 terms following the specified term.

¢ Compound word
To retrieve all compound words that start with the specified term. For example, if the term data is looked up, the possible compound

words that would be retrieved are:
e Data processing
e Data processing network
¢ Data processor
The displayed list is empty if no matches are found in the dictionary.
¢ Synonym
To retrieve all terms where the specified term is in the synonym entry field of the respective term. For example, if you specified the
term stream with the Synonym search option, you would get brook and rivulet, if stream is contained in their dictionary entries. The
displayed list is empty if no matches are found in the dictionary.

¢ Related Term
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To display all terms related to the selected term. For example, if you specified the term forest with the Related Term search option,
you would get forestry commission and forester as related terms if forest was entered in the related term entry field of their
dictionary entries. The displayed list is empty if no matches are found in the dictionary.

¢ Abbreviation
To display all terms that have an abbreviation. For example, if you specified the term appl. with the Abbreviation search option,
you would get application if appl. was entered in the abbreviation entry field of its dictionary entry. The displayed list is empty if no
matches are found in the dictionary.

¢ Headword
To search only for the specified term. This is the default search option.

¢ Dictionaries

This box displays the name of the selected dictionary if you came from the "Dictionary List" window, or the name of one or more dictionaries
used during the translation of the document if you came from the Translation Environment.

¢ Filter
Specify whether to use a filter to restrict the number of terms to be found. You can use an existing filter, change it, or create a new filter.

O Use filter
To use a filter, select this option and specify which filter to use:

0 Name
Lists all available filters. If you want to use or change an existing filter, select it. If you want to define a new filter, enter a name in the
list box.

¢ Description
The description of the selected filter.

Click Edit? to define the new filter or to change an existing one, which takes you to the "Edit Dictionary Filter" window. For more details on
how to define filters, see Defining a dictionary filter.

Click Look up? to start the search.

Click Edit? to display the "Edit Entry in Dictionary" window in which you can edit the selected term, if it already exists in the dictionary, or define it to the
dictionary as a new term.

5.1.23.1.3 Results

If you selected the Headword search type and an entry for the specified term is found in the dictionary, the "Lookup Entry" window is automatically
displayed containing the data for this entry. For more information, see Looking up a dictionary entry.

If you selected the Headword search type and the term is not found in the dictionary and you clicked Look up?, a message appears asking if you want
to add the term to the dictionary. If you add the term, you are automatically taken to the "Edit Entry in Dictionary" window. For more information, see
Editing a dictionary entry.

If you selected Neighborhood search, and the term is not found in the dictionary, a list of up to 60 terms is displayed in alphabetical order where the
specified term would appear in the middle. If more than one term satisfies the specified search criteria, a list of up to 60 terms is displayed from which
you can select a term and use it for a Headword search request.

If the specified term exists in the selected dictionary and you selected Edit?, the "Edit Entry in Dictionary" windows is displayed. For more information,
see Editing a dictionary entry.
5.1.24 Viewing the properties of a dictionary
The main properties of a dictionary are:
e Name
The name of the dictionary. It cannot be changed for an existing dictionary.
¢ Source language
The source of the dictionary, this means, the language of the terms (headwords). It cannot be changed for an existing dictionary.
e Drive
The drive where the dictionary resides. It cannot be changed for an existing dictionary.

¢ Description
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The description of the dictionary. It can be up to 255 characters long.
e | ocation

Can be local (only one translator at a time can use it) or shared (several translators can use it simultaneously).
¢ Entry fields

Contains the entry fields that make up the dictionary structure. For an existing dictionary you can only change the name of a field and the
lookup panel number.

¢ Protected?

Specifies whether the dictionary is protected against unauthorized modifications.

5.1.24.1 Prerequisites

The dictionary must exist.

5.1.24.1.1 Calling sequence
Select:
1. A dictionary from the "Dictionary List" window
2. Properties Summary... from the File menu
5.1.24.1.2 Results

A document in HTML format is displayed containing a summary of the dictionary properties.
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Dictionary Properties

|General Properties

Name: ENGLGEEM

Short name: ENGLGEEM

Source langnage: English(U.S)

Drive: I:

Description: Basic Dictionary - English -> German
Location: Local

Protected?: No

Entry Structure

s Entryv Field Headword:
Panel 1, Entry Level, Small Size, Default Aut. Lookup

« Entrv Field Part of Speech:
Panel 3, Homomvm Level, Small Size, No Aut. Lookup

+ Entry Field Context:
Panel 2, Sense Level, Large Size, No Aut. Lookup

E . Eigld T latiou:
Figure 112. Dictionary Properties document

If you want to view more properties or change the properties of a dictionary, refer to Changing the properties of a dictionary.

5.1.25 Changing the properties of a dictionary

The properties of a dictionary are its individual characteristics. Some properties, for example the dictionary structure and the size of an entry field,
cannot be changed when the dictionary has been created. Others, for example which lookup panels are to display which data, can be changed.
5.1.25.1 Prerequisites

The dictionary must exist.

5.1.25.1.1 Calling sequence

Select:
1. The "Dictionary List" window
2. The dictionary from the list of dictionaries
3. Properties... from the File menu

This takes you to the "Dictionary Properties" window.

65


http://power/opentm2wiki/index.php/File:Eqfb7s10m.GIF
http://power/opentm2wiki/index.php/Working_with_dictionaries#Changing_the_properties_of_a_dictionary

Dictionary Properties

General Properties | Enty Struchure

M ame: EMGLGERM
Short name:; EMGLGERM
Dezcription: Eazic Dictionary - Enalizh -» German

Location: Local
Dzl drive: |

Source language: Englizh(Ll.5.]

LChange FPratect... Cancel | Help

Figure 113. Dictionary Properties window

5.1.25.1.2 Options and parameters
The "Dictionary Properties" window lists the characteristics of the selected dictionary.
For an existing dictionary, only the following properties can be changed:
¢ The dictionary description
¢ The lookup display panel of an entry field
¢ The name of an entry field
On the "General Properties" page:
¢ Name
The name of the dictionary. It cannot be changed for an existing dictionary.
e Short name
The short name of the dictionary.
¢ Description
The description of the dictionary. It can be up to 255 characters long.
e Location
Can be local (only one translator at a time can use it) or shared (several translators can use it simultaneously).
¢ Disk drive
The drive where the dictionary resides. It cannot be changed for an existing dictionary.
¢ Source language
The source of the dictionary, this means, the language of the terms (headwords). It cannot be changed for an existing dictionary.

On the "Entry Structure" page:
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e Entry fields

Contains the entry fields that make up the dictionary structure. For an existing dictionary you can only change the name of a field and the
lookup panel number.

¢ Display
Click the Panel number on which you want this entry field displayed in the "Lookup Entry" window. Omit means you do not want this entry
field to be displayed at all. The entry field is not deleted from the entry structure. Aut. Lookup displays the complete entry field information in
the window showing the found dictionary proposals during translation.

e Level
Shows the level of the selected entry field. It cannot be changed for an existing entry.

* Size
Shows the size of the selected entry field. It cannot be changed for an existing entry.

To change the name given to an entry field click Change name?. For example, you can change the name of the Headword entry field to Term. For more
information on renaming entry fields see Renaming a dictionary entry field.

To avoid unauthorized modification of a dictionary, you can protect it by clicking Protect and typing a password in the "Protect Dictionary" window. Then
the dictionary can only be modified when the correct password is entered. For more detail on how to protect and unprotect dictionaries see Protecting a
dictionary.

Click Change to change dictionary properties.

5.1.25.1.3 Results

The dictionary properties are changed according to your specifications.

5.1.26 Viewing the details of a dictionary
In its simplest form, the "Dictionary List" window lists all of the available dictionaries. However, if you want to see more specific details of each dictionary,
you can change your view of the "Dictionary List" window to have it display individual properties, such as the source language, location, or description of
a dictionary.
The details selectable for a dictionary are:
¢ Name
The name of the dictionary.
¢ Description
The description of the dictionary.
e Drive
The drive on which the dictionary resides.
e Owner
Shows who created the dictionary (if it is a shared one). If it is a local dictionary, n/a is displayed.
¢ Source language
The source language of the dictionary, this means the language of the headwords.
You can toggle between two display modes:

¢ Display the dictionary names only
e Display the names and details

You can change the arrangement of the dictionary details in the "Change Details" window.

For a general description see Viewing and changing the details of a list item.
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5.1.27 Option to select dictionary lookup for compound words in editor

User Interface

The new option can be activated or de-activated using the "Show single words of compound terms in auto-lookup" option of the Dictionary tab of the
"Profile settings" dialog of the TranslationEnvironment:

Customize Translation Functions 7] x|

Editor | Display Dictionary | TransiMem | Messages | Aut Substitution |

— Display Ophons

I Infarmation for dictionany terms

v Dictionany terms of all dictionanes

[+ Dictionany indicator

¥ Show singls words of compound temes in suto-lookup

Set Cancel Help

Figure 114. Dictionary Lookup

If the option is active the single words of a compound term are looked up together with the compound term. If the option is inactive the single words of a
compound term are not looked up in the dictionary auto-lookup.

An example:
Assume a dictionary containing the terms "data", "data processing", "data processing unit", and "unit". If a segment contains the term "data processing

unit" the dictionary window will show the translations for "data", "data processing", "data processing unit", and "unit" if the option is active and "data
processing unit" if the option is inactive..

5.1.28 Viewing style indicators for dictionary terms
The style of dictionary terms can be specified using the "Style" field ( <estyle> ) on sense level and the "Trans Style" field ( <tstyle>) on target level.
The following style values are predefined:

¢ Positive styles values: "peferred”
¢ Negative style values: "deprecated", "non standard", and "no longer used"

When a term with predefined style information is displayed in the dictionary lookup window of the TranslationEnvironment, a style indicator is displayed
before the term for styles on sense level and before the term translation for styles on target level.

For the positive style values this indicator is a plus sign ('+') with green background. The indicator for negative style values is the minus sign (*-') with red
background.
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Figure 115. Style indicators for dictionary terms
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6 Working with terminology lists

You use terminology lists to tell OpenTM2 to look for or ignore specific terms when checking a document.
OpenTM2 creates terminology lists during document analysis. The lists are compiled by comparing terms in a document with selected dictionaries.

In OpenTM2, you can generate and work with the following types of terminology lists:

6.1 New terms lists

New terms are terms in a document that are not contained in specified dictionaries. You can use new terms lists to create a project-specific dictionary, to
create your personal dictionary with terms that are often used for specific terminology, or to extend an existing dictionary.

6.1.1 Found terms lists

Found terms are terms in a document that are also contained in specified dictionaries. You can use found terms lists to copy existing entries from one
dictionary to another or to check the used terminology in a dictionary before you use the dictionary for translation.

6.1.1.1 Exclusion lists

Exclusion lists contain terms that OpenTM2 can ignore when searching for new and found terms. Exclusion lists can be generated by copying selected
new terms and found terms, or by editing in OpenTM2 or outside the system. By using such an exclusion list, you can reduce the number of terms to be
included the next time you create a new terms list or a found terms list. Exclusion lists usually contain so-called noise words. For each installed

language support, OpenTM2 already provides such a list.

A terminology list usually contains terms of only one language. When you copy a term from a terminology list to a dictionary, the source language of the
dictionary must be the same.

6.1.2 Overview and terminology

All types of terminology lists can be exported, this means they are converted to an external format that is SGML based. A file with this format can be
used to exchange the data of a list with other users or applications.

External terminology lists can be edited or created by other systems; to use them in OpenTM2, you import them.

A description of the external format is given in Creating an external terminology list.

6.1.3 What you can do with terminology lists

You can start most of the functions related to terminology lists from the related list window, as shown in the following example.

6.1.3.1 Prerequisites

None.

6.1.3.1.1 Calling sequence
Select:
1. Utilities from the action bar
2. Display terminology lists from the menu

3. One of the list types offered in the cascaded window: Exclusion Lists, Found Terms Lists or New Terms Lists.

One of the list windows is displayed, for example the "New Terms Lists" window. The list window contains the list of existing terminology lists, in this
example all new terms lists. Actions on a terminology list can be started by selecting a list name and an action from the File menu.
6.1.4 Creating a terminology list
Depending on the type of terminology list to be created, there are different ways to do this:
¢ New terms lists or found terms lists are usually created during the analysis of a document. An overview of how to do this is given in
?Analyzing documents using dictionaries?.

¢ Exclusion lists can be created in a OpenTM2 window as described in ?Creating an exclusion list?.

You can also create an exclusion list from an existing new terms list or found terms list. This is explained in Opening and changing a terminology list.
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Another general way is to create an external terminology list outside of OpenTM2, which can be imported. This is explained in Creating an external
terminology list.

6.1.4.1 Creating a list of new terms or found terms
New terms lists and found terms lists are created during analysis of a document.
6.1.4.1.1 Prerequisites

¢ At least one document must exist.

e At least one dictionary must exist.

6.1.4.1.2 Calling sequence

Select:
1. The document in the "Document List" window
2. Analyze... from the File menu
3. Create lists in the "Analyze Documents" window
4. Create list of new terms or Create list of found terms in the "List Settings" window
5. Any dictionaries to be used
6. Set to return to the previous window
7. Analyze to begin the analysis and the creation of the selected terminology lists

6.1.4.1.3 Options and parameters

For a detailed description of the options see Analyzing a document.

6.1.4.1.4 Results

The terminology lists are created according to your specifications.

6.1.4.2 Creating an exclusion list

You can create an exclusion list from an existing new terms list or found terms list. This procedure is explained in Opening and changing a terminology
list.

You can also create an exclusion list from the "New Exclusion List"window or the "Edit Exclusion List" window.

6.1.4.2.1 Prerequisites

The "Exclusion Lists" window is active.

6.1.4.2.2 Calling sequence

Select New? from the File menu. The "New Exclusion List" window is displayed.

6.1.4.2.3 Options and parameters
The upper list box is empty. Here you can define the terms for the new exclusion list:
¢ To add a term, press Enter and type a term in the empty line.

¢ To delete a term already entered, mark it with the mouse and press Enter.
¢ To change a term already entered, overtype it. Pasting from the clipboard is also supported.

6.1.4.2.4 Name
Type the name of the new exclusion list.

To save the terms in the new exclusion list, select the Create button. If you do not want to create the exclusion list anymore, select the Cancel button.

6.1.4.2.5 Results

If you selected the Create button, the exclusion list is created with the terms entered and you can use it in the analysis of a document. If you selected
the Cancel button, no new exclusion list is created.
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6.1.5 Creating an external terminology list

Although OpenTM2 offers functions for the creation of terminology lists where you only specify some parameters in a window, you can also create them
outside of OpenTM2.

This can be useful when you already have terminology lists available in a format of your own, which you must only convert to the format you can import
in OpenTM2.

External new terms lists and external found terms lists must be created in an SGML format to import them.

External exclusion lists are created without SGML tags. If you want to create an exclusion list outside of OpenTM2, you can write a list of terms in an
editor of your choice, where each line contains one term, and then import it in external format. The list can have any number of terms. For details on
importing terminology lists see Importing a terminology list.

A new terms list requires as first tag in the first line <NTLIST> and as the very last tag in the last line of the list the tag </NTLIST>. The same applies to a
found terms list, except that you must use the tags <FTLIST> and </FTLIST>.

The description of an entry always starts with the start tag <TERM> and ends with the corresponding end tag </TERM>.
The term itself is between the start tag <LEMMA> and the end tag </LEMMA>.

To add context information to a term, the context information must have the start tag <CONTEXT>, and the end tag </CONTEXT>. Adding context
information is optional; you can include more than one context.

To insert the term address to a terminology list without context information, your entry would look as follows:

<TERM>
<LEMMA>address</LEMMA>
</TERM>

When you want to insert the term hardware to a terminology list with information about two contexts, your entry would look as follows:

<TERM>

<LEMMA>hardware</LEMMA>

<CONTEXT>However, before selecting your hardware devices,

you should understand your data processing requirements. </CONTEXT>
<CONTEXT>This publication assists you in selecting

a hardware configuration. </CONTEXT>

</TERM>

You can insert as much context information as you want, but each piece of context information needs the start and the end tag.

A new terms list with the entries hardware, software, term, context, and with some context information for the first and last entry would have the
following layout:

<NTLIST>

<TERM>

<LEMMA>hardware</LEMMA>

<CONTEXT>Your hardware requirements are as follows:</CONTEXT>
</TERM>

<TERM>

<LEMMA>software</LEMMA>

</TERM>

<TERM>

<LEMMA>term</LEMMA>

</TERM>

<TERM>

<LEMMA>context</LEMMA>

<CONTEXT>The context information must be stored between a start
and end tag.</CONTEXT>

</TERM>

</NTLIST>

You do not have to sort your entries in alphabetical order. This is done during importing.

How to import the new list is described in Importing a terminology list.

6.1.6 Deleting a terminology list

6.1.6.1 Prerequisites

The list window that contains the terminology list to be deleted is active.
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6.1.6.1.1 Calling sequence
Select:
1. The terminology list to be deleted
2. Delete from the File menu
6.1.6.1.2 Options and parameters
Before the system deletes the selected list, it asks you to confirm whether you really want it:

¢ If you select No, you can leave the delete function.
¢ If you select Yes, the list is deleted.

6.1.6.1.3 Results

If you selected Yes, the list is deleted; otherwise it remains unchanged.

6.1.7 Exporting a terminology list

You can export a terminology list to give it to another user, for example, another translator who needs it for the translation of another document. You can
choose to export the list in OpenTM2 or external format.

In order to exchange the data with other OpenTM2 users, select the OpenTM2format. If you want to pass the list to another program, you should select
the external format.

When you export in external format, the found terms lists and the new terms lists are exported in SGML format. You can find a description of this format
in Creating an external terminology list.

When you export an exclusion list in external format, it is written as an ASCIl-coded file.

6.1.7.1 Prerequisites

The list window that contains the terminology list to be exported is active.

6.1.7.1.1 Calling sequence
Select:

1. The terminology list to be exported
2. Export... from the File menu

For an exclusion list, the "Export Exclusion List" window is displayed .
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Figure 116. Export Exclusion List window

6.1.7.1.2 Options and parameters

Depending on the format selected, this window offers a different number of options and parameters. For exporting in OpenTM2 format, specify the
following:

¢ Format
Select OpenTM2 .
*To
Select the drive to which you want to export the terminology list.
For exporting in external format, specify the following:
¢ Format
Select External.
0To
Specify the needed parameters where to store the terminology list and select the drive to which you want to export the list.
0 Name
Define the file name for the exported list.
¢ Current directory
Displays the directory selected from the Directories list box.
¢ Directories

Contains all available directories on the drive selected. Select the directory where to store the exported list.

To start the exporting function, select Export.

6.1.7.1.3 Results
The selected terminology list is now exported in the selected format. The file in the internal format can only be used by OpenTM2 users. The file in the

external format can be used or changed by other applications. In Creating an external terminology list you find a description of how to work with external
lists.
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6.1.8 Importing a terminology list

If a terminology list has been created by another OpenTM2 user, you must import it to make it available in OpenTM2.

6.1.8.1 Prerequisites
To import a new terms list, the "New Terms Lists" window must be active.

e To import a found terms list, the "Found Terms Lists" window must be active.
¢ To import an exclusion list, the "Exclusion Lists" window must be active.

6.1.8.1.1 Calling sequence
Select Import? from the File menu.

For an exclusion list, the "Import Exclusion List" window is displayed.

Import Exclusion List |
— Formnat

¥ External ™ Translationtanager

— From

= =I¢ =P =k =F Ed ER
Er W EK EY

M ame: Ix_ LST

Current directany: E: Mt projecth,

Directories Files
qolf. Izt
US.LST

Ta lizt: I j

|t | Cancel | Help |

Figure 117. Import Exclusion List window

6.1.8.1.2 Options and parameters
Depending on the format selected, this window offers a different number of options and parameters:
For importing in OpenTM2 format, specify the following:
e Format
Select OpenTM2.
* From

Select the drive from which you want to import the terminology list. When you have selected a drive the terminology lists are automatically
displayed in the list box. Select the list you want to import.
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e To list
Type the name under which you want the data stored in OpenTM2.
For importing in external format, specify the following:
¢ Format
Select External.
0 From
OpenTM2 needs information where the terminology list to be imported currently resides:
Select the drive where the external list is stored.
0 Name
Type the name of the external list.
0 Current directory
Displays the directory selected from the Directories list box.
O Directories
Select the directory containing the external terminology list from the list of directories on the selected drive.
0O Files
Select the file name of the external terminology list from the list of names in the currently selected path.
e To list
Type the name under which you want the data stored in OpenTM2.

To start the importing function, select the Importbutton.

6.1.8.1.3 Results

The terminology list is stored in OpenTM2 and can be used for further processing.

6.1.9 Opening and changing a terminology list

You open a list to work with it, for example, to copy entries from the terminology list to a dictionary or to another list.

6.1.9.1 Prerequisites

The list window that contains the terminology list to be opened is active.

6.1.9.1.1 Calling sequence
Select:

1. The terminology list to be opened
2. Open from the File menu

One of the following windows is displayed, depending on the type of list selected:
¢ "Work with Found Terms List"
¢ "Work with New Terms List"
¢ "Edit Exclusion List"

See the "Work with New Terms List" window, as an example.

The "Edit Exclusion List" window is explained in Editing an exclusion list.
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Figure 118. Work with New Terms List window

6.1.9.1.2 Options and parameters

In the list box you see the terms contained in the opened new or found terms list.

6.1.9.1.3 View

The meaning of the processing symbols in this row is as follows:

=
Shows all terms in the list.

L]
é Shows all terms not marked for any processing.
[ ]

Shows all terms to be deleted.

Shows all terms to be added to a dictionary.
] —

Shows all terms to be added to an exclusion list.

The contents of the list box depends on the processing selected for the terms and the processing symbol selected in this row.
You can select and mark one or more terms in order to specify the processing:
e Mark for delete
Select this button to remove this term from the lists.
¢ Mark for dictionary?

Select this button to add this term to a dictionary. This takes you to the "Mark Term for Dictionary" window where you specify further
parameters and then return to this window (see Marking a term for a dictionary).

¢ Mark for exclusion list

Select this button to add this term to an exclusion list. You can select the exclusion list to be filled from the list box, which contains all available
exclusion lists. You can also type a new name for an exclusion list in order to create a new one.

e Unmark
Click this option to unmark a previously marked term.
The view symbol preceding a term represents the processing you have selected for it.
To begin the processing of the selected terms, you click Process. If you marked any term to add to a dictionary, you can specify more options in the
"Mark Term for Dictionary" window (see Editing a dictionary entry). When the processing is completed, the list contains the remaining terms for which no

processing was specified.

The marked terms need not be processed immediately. To save the list in its current status of marking, click Save.
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To leave the terms list in its original status, click Cancel.

6.1.9.1.4 Results
If you selected Process, the terminology list is changed depending on your selections. If you made changes to any dictionary or exclusion list, they are

active during the next analysis or translation of a document. If you selected Save, the terminology list is saved including the new processing marks. If
you selected the Cancel button, the terminology list remains unchanged.

6.1.10 Marking a term for a dictionary

You can mark new terms and found terms to add them to a dictionary. You do this by clicking Mark for dictionary? in one of the following windows:

¢ "Work with New Terms List"
* "Work with Found Terms List"

The "Mark Term for Dictionary" window is displayed.

Mark Term for Dictionary |
Term: IEaniguratiDn
Tranzglation: |

[ &dd contest to dictionany entry

Diictinnary
EMGLFREHM

FREMEMGL
GERMENGL hd
b ark | Skip | Cancel Help

Figure 119. Mark Term for Dictionary window

6.1.10.1 Options and parameters
e Term

The current term from the terminology list is displayed.
e Translation

Optionally, type the translation for the term to be copied to the dictionary.
¢ Add context information to dictionary entry

If you have created the terminology list with context information, this information is copied to this field. You can also type your own context information.
To save the context information to the dictionary, mark the check box.

e Dictionary

The list box contains all available dictionaries that are not protected. Select the dictionary where you want the term to be added.
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To save the processing information for this term, click Mark.
To skip the current term, select the Skip button.

If several terms are marked for the dictionary, the next term is displayed in the Term field. If all marked terms were displayed, you are returned to the
previous window.

6.1.10.1.1 Results

The selected term is prepared for addition to a dictionary. When all terms marked for the dictionary are processed, you can add more information,
depending on the structure of the selected dictionary in the "Edit Entry in Dictionary" window. You can find more information about editing entries in
dictionaries in Editing a dictionary entry.

6.1.11 Editing an exclusion list

When you have opened an exclusion list, the "Edit Exclusion List"window is displayed.

6.1.11.1 Options and parameters

The list box contains terms from the selected exclusion list.
¢ To change a term, overtype it.
¢ To add a term, press Enter and type a term in the empty line.
¢ To delete a term, mark it and press Enter.

Clipboard operations (cut, copy, paste) are supported.

¢ Save to

Displays all the exclusion lists to which terms can be saved. Select an existing exclusion list or overtype it with another name (to create a new
list).

To save the terms in the selected exclusion list, select the Save button.

To leave the exclusion list in its original status, select Cancel.

6.1.11.1.1 Results

If you selected Save, the exclusion list is changed depending on your selections. If you made changes to the exclusion list, they are active during the
next analysis of a document.

If you selected Cancel, the exclusion list remains unchanged.

6.1.12 Printing a terminology list

To do paperwork on terminology lists, you can print them on the printer attached to your workstation.

6.1.12.1 Prerequisites

The respective list window that contains the terminology list to be printed is active.

6.1.12.1.1 Calling sequence
Select:

1. The terminology list to be printed
2. Print from the File menu

The printing function is started immediately. The respective list window remains displayed.

6.1.12.1.2 Options and parameters

None.
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6.1.12.1.3 Results

The selected terminology list is directly routed to your attached printer. The first line of the printout contains the type of terminology list and the list name.
Then the contents of the list follow. Each entry is printed in a separate line. If your list contains context information, it is also printed.

6.1.13 Viewing the details of a terminology list
For all types of terminology lists, the system keeps some view details that can be displayed in the corresponding list window.
These details are:
e Name
The name of the list.
e Drive
The drive the list resides on.
¢ Last Update (Date)
The date when the list was last changed.
¢ Last Update (Date + Time)
The date and time when the list was last changed.
¢ Size
The number of bytes that the list occupies on your disk.
You can toggle between two display modes:

e Display the names only
e Display selected details

You can change the arrangement of the details of terminology lists in the "Change Details" window described in #Viewing and changing the details of a
list item.
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7 Working with markup tables

OpenTM2 can handle documents that are created by the most popular word-processing systems and a wide range of other document types.

Documents usually are a mixture of text and layout information, which describes the formatting of the document. This layout information is called markup
data. It defines, for example, the start of a new page, the start of a paragraph, or character layout like boldness, italics, or underline.

7.1 Contents

e 1 Markup table names
e 2 Overview and terminology
* 3 What you can do with markup
tables
+ 3.1 Prerequisites
+ 3.2 Calling sequence
¢ 4 Changing a markup table
e 5 Creating a markup table
¢ 6 Deleting a markup table
+ 6.1 Prerequisites
+ 6.2 Calling sequence
+ 6.3 Options and
parameters
¢ 6.4 Results
e 7 Exporting a markup table
+ 7.1 Prerequisites
¢ 7.2 Calling sequence
+ 7.3 Options and
parameters
¢ 7.4 Results
¢ 8 Importing a markup table
+ 8.1 Prerequisites
+ 8.2 Calling sequence
+ 8.3 Options and
parameters
¢ 8.4 Results
¢ 9 Changing the properties of a
markup table
+ 9.1 Prerequisites
+ 9.2 Calling sequence
+ 9.3 Options and
parameters
¢ 9.4 Results

In most of the word-processing systems that display a text in WYSIWYG mode (What You See Is What You Get), you usually do not see this markup but
only its effects. Some systems allow you to display and check the markup data, for example in WordPerfect with the Reveal codes option.

In other systems that generate the formatting printout in a separate step, you usually edit the markup yourself.

The table that stores the description of the markup data is called markup table in OpenTM2. OpenTM2 needs this markup table to differentiate between
the text to be translated and the markup data.

Markup tables are used:

e During analysis to divide the document into translatable and nontranslatable parts
¢ During translation to protect the markup information, so that translators are warned if they try to overtype it

It is important for you to know which markup table is to be used for which type of document. You must tell OpenTM2 what kind of markup table should
be associated with a folder or a document.

For more information on associating a markup table with a document see either Changing the properties of a document, or Importing a document.
For information on associating a folder with a markup table, see Creating a folder, or Changing the properties of a folder.

The association of a document or folder with a markup table is essential because the different word processors have different layout descriptions. All
these layout descriptions are understood by OpenTM2 and processed in a general way.
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7.1.1 Markup table names

The following table shows the available markup table names and the supported document types.

Markup table Type of document

EQFALINE ANSI files in which everything is translatable.

EQFAMI Ami Pro texts (Ami Pro for Windows (®), Version 2.0).

EQFAMRI ANSI files in which translatable text is enclosed in double quotes.

EQFANSI ANSI documents. This markup table is combined with a user exit.

EQFAQUOT ANSI files in which translatable text is enclosed in single quotes.

EQFASCII ASCII files in which everything is translatable.

EQFASM Assembler documents.

EQFBOOK BookMaster (®) and Information Presentation Facility (IPF) texts.

EQFFRBLD FrameBuilder files (Version 5.5).

EQFHTML2 HTML texts (level 2.0).

EQFHTML4 HTML texts (level 4.0). This markup table is combined with a user exit.

EQFINT2 Interleaf files.

EQFLINE ASCI! files in which everything is translatable.

EQFMRI ASCI! files in which translatable text is enclosed in double quotes.

EQFMSWRD Microsoft (R) Word for Windows (R) documents.

EQFPPT Microsoft (R PowerPoint (?) documents.

EQFQUOTE ASCI! files in which translatable text is enclosed in single quotes.

EQFRTF Rich Text Format (RTF) files coming from Word for Windows (R), Ami Pro, or other word
processors.
SGML documents that were designed for processing by Lotus (F) Notes (™) . Also

EQFSGML applies to help texts for programs running under Windows (®) that can be saved as RTF
documents.

EQFWP WordPerfect texts (Version 5.0).

EQFWP6 WordPerfect texts (Version 6.0 and 6.1).

EQFUTF8 Unicode document in UTF-8 encoding

LOTUSAMI Ami Pro documents designed for processing by Lotus (R Notes (™),

LOTUSNGD Lotus (R Notes (™) documents.

UNICODE Unicode documents in UTF-16 encoding.

OpenTM2 allows you to add more formats. For detailed information on creating external markup tables see Creating a markup table, and Working with
external markup tables.

For information on how to use the markup tables and how to prepare the different document types for translation, see Dealing with specific document

formats.

7.1.2 Overview and terminology

Markup tables can be exchanged with other users or applications. This may be necessary, when you have changed a markup table for your special
translation needs and another translator may want to share your changes for similar translation environments.

To give the markup table to someone else you must transfer it out of OpenTM2. This process is called export. The recipient must import the exported
markup table into OpenTM2 again.

Markup tables can also be exchanged via exported folders. When you export a folder with a document using a specific markup table, this markup table
is included in the exported folder and can be loaded implicitly during folder import in the recipient's system.

Markup tables can be changed. You can choose from two methods:
¢ One way is to export it from OpenTM2 and to use an external editor to apply the changes. You need to import the markup table into OpenTM2
to use it again, and you need to be familiar with the SGML-based format of the exported markup table.
¢ Another way is to change the properties of a markup table without leaving OpenTM2.

Each method has its advantages. See Changing a markup table for the details.

You can also create new markup tables, as described in Creating a markup table. New markup tables also need to be imported into OpenTM2 before
they can be used for translations.
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7.1.3 What you can do with markup tables

Start the functions related to markup tables from the "Markup Table List" window.

7.1.3.1 Prerequisites

None.

7.1.3.1.1 Calling sequence

Select Display markup table list from the Utilities menu. The "Markup Table List" window is displayed. The window contains all existing markup tables
in your system. Most of the actions related to markup tables can be started by selecting a list name and an action from the File menu, such as Delete,
Export?, or Import?.

7.1.4 Changing a markup table
A markup table can be changed by using two different methods:

* You can export an existing markup table from OpenTM2's internal format to an SGML-based external format, which can be edited with any
text editor. The contents of an exported markup table are described in terms of SGML statements, so you need to be familiar with SGML. After
changes are made you need to import the markup table into OpenTM2 before you can use it again. Follow these steps if you choose this
method:

O Export an existing markup table from OpenTM2, as described in?Exporting a markup table?.This ensures that you start with a
markup table that has the correct SGML syntax.
0 Make a backup copy. The original markup tables provided by OpenTM2 cannot be reinstalled.
¢ Change and replace the markup data in the exported file as required, as described in Creating new markup tables
O Before importing the external markup table, consider to rename the file to protect the original markup table until you are finished.
O Import the external markup table, as described in ?Importing a markup table?OpenTM2 performs a syntax check during the import.
It does not import an incorrect markup table, so you need to correct it in its external format.Note that an external markup table can
be imported either under the old name or a new name.
The disadvantages of this method are that you need to export and import the markup table and that you need to know SGML. Further, no
syntax checking is provided (other than OpenTM2 refusing to import an improperly coded markup table).
The advantage is that extensive changes are faster. You can also use tools of choice to automate changes to markup tables, for example
word processing macros.
For more detailed information see Working with external markup tables.

¢ Within OpenTM2, you can use the "Markup Table Properties" window to change, add, and remove properties of a markup table. The
properties comprise all aspects of the content of a markup table. In addition, you can test your modifications immediately, and you can
password-protect a markup table.
The advantages of this method are that you do not need to leave OpenTM2 to change a markup table and that less knowledge about SGML is
required.
On the other hand, the graphical user interface might not be appropriate for extensive changes.
To actually change a markup table by means of the "Markup Table Properties" window, see Changing the properties of a markup table.

Before you change a markup table provided by OpenTM2, it is recommended to make a backup copy of the original version because the original
markup tables cannot be reinstalled.

7.1.5 Creating a markup table

New markup tables can be created by using two different methods:

¢ You can create an external markup table in SGML-based format and import it into OpenTM2.
¢ Within OpenTM2, you can use the "Markup Table Properties"window to create a new markup table.

Creating a new markup table is similar to changing an existing markup table. Therefore, see Changing a markup table for the details and advantages of
both methods. Note that it is often more practical to modify a copy of an existing markup table.
7.1.6 Deleting a markup table

If you no longer need a markup table, you can delete it. For markup tables provided by OpenTM2, it is recommended to create a backup copy by
exporting the table, because it cannot be reinstalled separately but only by a system reinstallation.

7.1.6.1 Prerequisites

e The "Markup Table List"window must be active.
e The markup table to be deleted must be selected.
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7.1.6.1.1 Calling sequence

Select Delete from the File menu.

7.1.6.1.2 Options and parameters
Before the system deletes the selected markup table, it asks you to confirm whether you really want to delete it.
If you select No, you will leave the delete function.

If you select Yes, the markup table will be deleted.

7.1.6.1.3 Results

If you selected Yes, the markup table is deleted. Otherwise it remains unchanged. References to this markup table may still exist in certain folders.
Update the folder properties so that the deleted markup table is no longer associated with a folder.

7.1.7 Exporting a markup table

You can export a markup table to give it to other users, for example, other translators who must use the same modified markup table in their translation
environment.

Markup tables can only be exported in external format.

Each markup tag described in the markup table is exported together with its nondefault data. You can find a table that contains the definition of markup
table SGML tags and the data defaults that are used for OpenTM2 in Working with external markup tables.

7.1.7.1 Prerequisites

e The "Markup Table List"window must be active.
e The markup table to be exported must be selected.

7.1.7.1.1 Calling sequence
Select Export? from the File menu.

The "Export Markup Table" window is displayed.

84


http://power/opentm2wiki/index.php/Working_with_external_markup_tables

Export Markup Table Ed |

— Format

= Translstionhanager

E zport: ECFALIME

= =I¢ =P =k =F E4 ER

Mame:  |EQFALINE.TEX

Current directary: E: Mt project’,

Directories

englizh
gErMan

E=port | Cancel | Help |

Figure 120. Export Markup Table window

7.1.7.1.2 Options and parameters
¢ Format
External is selected automatically.
*To
Enter the required parameters where to store the exported markup table:
Select the drive to which you want to export the markup table.
0 Name
Define the file name for the exported markup table.
¢ Current directory
Displays the directory selected from the Directories list box.
¢ Directories
This list box contains all available directories on the selected drive. Select the directory where to store the markup table.

To start the exporting function, select the Export button.

7.1.7.1.3 Results

The selected markup table is exported to the specified file and saved on the selected drive and directory.

7.1.8 Importing a markup table
If another user has prepared a markup table for your translation environment, you must import it in order to be able to use it in OpenTM2.

Markup tables can only be imported in external format.

7.1.8.1 Prerequisites

The "Markup Table List" window must be active.
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7.1.8.1.1 Calling sequence

Select Import? from the File menu. The "Import Markup Table" window is displayed.

Import Markup Table |
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% Enternal = Trans stionhkderager
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Er EW ER EY

M ame: |°‘, TEx
Current directary: E: Mt project!,
Directories File=z
eqfward. the
To markup table: IEI]F.-*-.LINE j

Import | Cancel | Help |

Figure 121. Import Markup Table window

7.1.8.1.2 Options and parameters
¢ Format:
External is selected automatically.
* From
Specify where the markup table to be imported currently resides and select the drive where the external markup table is stored.
0 Name
Type the name of the external markup table or select the name from the following list boxes.
¢ Current directory
Displays the directory selected from the Directories list box.
0O Directories
Select the directory containing the external markup table from the list of directories on the selected drive.
0O Files
Select the file name of the external markup table from the list of names in the currently selected path.
¢ To markup table

Contains the name of the selected markup table to be imported. You can overwrite this name to create a new markup table or select a name from the list
box to merge your file into an existing markup table.

To start the importing function, select the Import button.
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7.1.8.1.3 Results

The markup table is now available in OpenTM2, you can start to associate it with documents or folders.

7.1.9 Changing the properties of a markup table

The "Markup Table Properties" window allows you to change, create, test, and protect a markup table without the need to export the markup table to an
external format. You can change an existing markup table, which includes the addition, removal, and modification of markup tag definitions and markup
attribute definitions. You can create a new markup table from scratch (however, it might be more efficient to choose the external method, as described in
Creating a markup table and Changing a markup table). You can dynamically test a markup table against a test document and continue to change it
without leaving the "Markup Table Properties" window. And you can password-protect a markup table against unauthorized modifications.

Before you apply any changes to a markup table or attempt to create a new one, you should know its syntax and semantics, as described in Creating
new markup tables. Note that most options and parameters on the "Markup Table Properties" window pages have their equivalent SGML tags described
in the subchapters of Creating new markup tables.

Before you change a markup table provided by OpenTM2, it is recommended to create a backup copy by exporting the markup table.

Note: The contents of markup tables are sensitive. Improper modifications avoid the correct handling of documents that are associated with them. Apply
the password protection to prevent unauthorized modifications.

7.1.9.1 Prerequisites

The "Markup Table List" window must be active.

7.1.9.1.1 Calling sequence
To change an existing markup table:

¢ Select a markup table in the "Markup Table List"window.
 Select Properties from the File menu.

To create a new markup table:
¢ Select New... from the File menu.
If an existing name of a markup table is chosen, a warning message is shown.

The "Markup Table Properties" window is displayed.

87


http://power/opentm2wiki/index.php/Working_with_markup_tables#Markup_table_names
http://power/opentm2wiki/index.php/Working_with_markup_tables#Markup_table_names
http://power/opentm2wiki/index.php/Working_with_external_markup_tables#Creating_new_markup_tables
http://power/opentm2wiki/index.php/Working_with_external_markup_tables#Creating_new_markup_tables
http://power/opentm2wiki/index.php/Working_with_external_markup_tables#Creating_new_markup_tables

Markup table properties il

General | Tags I .&ttributesl Test |

Mame: [EQFMSWRD

Dezcriphior: IMS WORD files [071/171/09)]

Dezcriptive name:; IE CIFMSWRD

Lzer exit: IEE!FMSWFED|

Characterset: I'{-,'S il j
Single substitution char I?_

Multiple substitution char.: 2

Allow CRLF change: I vI

— Tranzlator notes

Start tag:

Level 1 Mote:

Level 2 note:

End tag:

Change Cancel Praotect Help

Figure 122. Markup Table Properties window

7.1.9.1.2 Options and parameters
On the "General" page you can set or change general markup table properties:
e Name

Contains the name of the markup table being changed. This field cannot be changed if an existing markup table is changed.
The field accepts a markup table name if you started to create a new markup table.

¢ Description
Contains a markup table description, which is shown in the "Markup Table List" window.
¢ Descriptive name

Contains a descriptive name for this markup table. For example, if Name is EQFBOOK, you could simply describe it as BOOK.
If you create a new markup table, the descriptive name must be unique.

¢ User exit
Contains the name of the user exit, if the markup table uses one.If you create a new markup table, and you enter the name of a user exit that
does not exist, a warning message is shown.
You can confirm this message to continue.

¢ Character set

Contains the specified character set that is to be used for import and export of documents that use this markup table. You can specify ASCII,
ANSI, UNICODE, or UTF8.

¢ Single substitution character

Contains the substitution character to use for single character substitution. The default character is ?.
If you create a new markup table, the character must be different from that used as multiple substitution character.
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e Multiple substitution character

Contains the substitution character to use for multiple character substitution. The default character is %.
If you create a new markup table, the character must be different from that used as single substitution character.

¢ Allow CRLF change
If set to NO, do not allow reflow in the editor.
¢ Translator notes

The following fields contain the markup for translator's notes. Before changing or adding information here you should be familiar with the
internals of a markup table and how translator's notes are added to a source document. For the latter see Including notes for the translator.
Note especially that the level 1 and level 2 translator's note tags are nested between the start tag and end tag. The latter two are usually the
annotation or comment tags and have their own definitions in a markup table. If the translator's notes start and end tags do not match the
annotation start and end tags, OpenTM2 fails to properly recognize translator's notes.

¢ Start tag
Contains the start tag that begins an annotation or comment in the source document. For example, :annot for a BookMaster
document, or <!- for an HTML document (but not :annot., respectively ).

On the "Tags" page you can work with markup tag definitions. On the left of this page you see the list of tags that are defined in this markup table. You
can select a tag by clicking it. You can add new tags (by clicking Add new tag) and delete selected tags (by clicking Delete tag). On the right of this
page you see the definition, respectively properties, of a selected tag. You can change the properties of a tag by changing the entry fields, by selecting
or clearing the check boxes, and by selecting options from drop-down lists.

If you create a new markup tag, you must at least specify the tag string and its delimiter, respectively its length.

e Tag string
Contains the string that represents the markup tag.
¢ End delimiter
Contains one or more characters that end the tag string. Two or more characters cause OpenTM2 to check for all possible combinations of
these characters to determine the end of the tag. You cannot specify a string as end delimiter.
Alternatively, you can specify a length that specifies the end of the tag string (see parameter Length).

e Length

Contains the length of the tag string.
Alternatively, you can specify end delimiters that specify the end of the tag string (see parameter End delimiter).

¢ Column position

Contains the column position where the markup tag starts. If a markup tag has no special start position and can occur anywhere in a line, this
parameter is omitted or can be set to 0. The default is 0.

e Tag type

Contains the type of the markup tag, which specifies whether the tag starts or ends a segment and whether the tag influences OpenTM2's
segmentation. See "TYPE" in Markup Table Names for a description of possible selections in the drop-down list.

¢ Segmentation flag
Contains a flag for this markup tag that controls OpenTM2's segmentation and text protection.
O If segmentation is toggled off, text following this markup tag is not segmented by OpenTM2 until it encounters a markup tag that
toggles on segmentation.
0O If text protection is toggled on, text following this markup tag is protected by OpenTM2 until it encounters a markup tag that toggles
off text protection.
See "SEGINFQO" in SGML tags for markup tags and markup attributes for a description of possible selections in the drop-down list.

¢ Text processing flag

Contains a flag for this markup text that specifies how text following this tag is associated with the tag. See "ASSTEXT" in SGML tags for
markup tags and markup attributes for a description of possible selections in the drop-down list.

¢ Unique ID
Contains a unique ID in the range from 1 to 65565 that is associated with this tag. The use of these identifiers is at your disposal.

¢ Additional information
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Specifies whether specific text is to be ignored when segments are aligned during the creation of an Initial Translation Memory. See
"ADDINFO" in SGML tags for markup tags and markup attributes for a description of possible specifications.

e Class ID

Contains a class identifier. CLS_HEAD causes this markup tag to become an entry of the table of contents that you can display during the
translation of a document using the Special go to? dialog.

¢ Tag has attributes

This check box is selected if this markup tag has attributes attached (which requires that these attributes are listed on the "Attributes” page).
This parameter is equivalent to the specification of "ATTRINFQO" in SGML tags for markup tags and markup attributes.

¢ Can contain translator's notes
This check box is selected if this markup tag can contain translator's notes. See Translator's notes in a source document for details.
¢ Can contain translatable text

This check box is selected if the segment associated with this markup tag must be translated. This parameter is equivalent to the specification
of "TRANSLATEINFO" in SGML tags for markup tags and markup attributes.

On the "Attributes" page you can work with markup attribute definitions. On the left of this page you see the list of attributes that are defined in this
markup table. You can select an attribute by clicking it. You can add new attributes (by clicking Add new attribute) and delete selected attributes (by
clicking Delete attribute). On the right of this page you see the definition, respectively properties, of a selected attribute. You can change the properties
of an attribute by changing the entry fields and by selecting or clearing the check box.
If you create a new markup attribute, you must at least specify the attribute string and its delimiter, respectively its length.
e Attribute string
Contains the string that represents the markup attribute.
¢ End delimiter
Contains one or more characters that end the attribute string. Two or more characters cause OpenTM2 to check for all possible combinations
of these characters to determine the end of the attribute. You cannot specify a string as end delimiter.
Alternatively, you can specify a length that specifies the end of the attribute string (see parameter Attribute length).

¢ Attribute length

Contains the length of the attribute string.
Alternatively, you can specify end delimiters that specify the end of the attribute string (see parameter End delimiter).

¢ Additional information

Specifies whether specific text is to be ignored when segments are aligned during the creation of an Initial Translation Memory. See
"ADDINFO" in SGML tags for markup tags and markup attributes for a description of possible specifications.

¢ Can contain translatable text

This check box is selected if the segment associated with this markup attribute must be translated. This parameter is equivalent to the
specification of "TRANSLATEINFO" in SGML tags for markup tags and markup attributes.

On the "Test" page you can test the markup table. To test a markup table you need to load a test document that contains text that is marked up with
tags and attributes. When loaded, the test document is shown in its source form with all markup tags and attributes visible. The test document is
analyzed by using the markup table as it is currently defined. As a result of the analysis the contents of the test document is shown with visible
distinctions of segments, translatable text, and protected text. You can inspect the test document and decide whether your definitions of markup tags
and markup attributes are properly recognized in the test document.

When you test a markup table, you might encounter markup tags or markup attributes in the test document that are not recognized by your markup
table. You can add the missing markup tags or markup attributes to your markup table by marking the text section that represents the tag or attribute
with the mouse and clicking Add Selection as tag or Add Selection as attribute. This adds a new markup tag or markup attribute to your markup
table. When you click Refresh the document is analysed again and the added markup tag or markup attribute should be distinct.

If you encounter markup tags or markup attributes that are improperly recognized during the analysis, you might need to change one or the other
property of the affected tag (on the "Tags" page) or attribute (on the "Attributes" page). Thereafter, you can test the effect of the property changes by
clicking Refresh on the "Test" page.

¢ Load test document

Lets you choose a test document through the operating system's file open dialog, loads the document, and analyses its content by applying
the current markup table definitions. The result of the analysis is shown in the text box on the left.

¢ Add Selection as tag
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Builds a markup tag from a selected text section in the test document and adds the tag to the markup table. The markup tag is added to the
list of tags on the "Tag" page with its default properties.

¢ Add Selection as attribute

Builds a markup attribute from a selected text section in the test document and adds the attribute to the markup table. The markup attribute is
added to the list of attributes on the "Attributes" page with its default properties.

¢ Refresh

Restarts the analysis of the loaded test document and shows the result in the text box on the left. Click this button after you added or deleted
markup tags or markup attributes, or changed their properties.

e Legend

Explains how to interpret markups in the text box. For example, <P> indicates the boundary between segments, and nontranslatable text is
marked red.

On all pages of the "Markup Table Properties" window the following buttons are active:
* Save
Saves the markup table with its current definitions and leaves the "Markup Table Properties" window.
e Cancel
Leaves the "Markup Table Properties" window without saving the markup table.
¢ Protect / Unprotect
Lets you protect or unprotect the markup table by a password against unauthorized changes.|f the markup table is unprotected, a Protect

button is shown. If the markup table is protected, an Unprotect button is shown.
Clicking the button invokes a Protect, respectively Unprotect dialog that requests a password. Type a password. Remember the password.

7.1.9.1.3 Results

The markup table is now available in OpenTM2, you can start to associate it with documents or folders.
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8 Working with language-support files

Language-support files are monolingual morphological data files. With OpenTM2they are used to perform:

¢ Stem reduction during dictionary lookup of terms in original documents. When an original document contains the English word bought, for
example, OpenTM2actually looks up the infinitive form of the verb, buy, in the dictionary. The English (U.S.) language-support file contains
the information necessary to associate bought with buy.

e Compound separation during dictionary lookup of terms in original documents for all Germanic languages. When an original document
contains the German word Autoradio (car radio), OpenTM2 looks up Autoradio. If it does not find this compound, it decomposes it and looks
up its parts Auto and Radio.

e Text segmentation into sentences, including recognizing abbreviations in the original documents.A paragraph of text is divided into
sentences during analysis to allow a sentence-by-sentence translation.

¢ Spellchecking of translated documents.

For translations from a given source language, you must install the corresponding language-support file.

For translations into a target language, the installation of the language-support file is optional unless you need to check the spelling of the target file.

8.1 Overview and terminology

The "Language List" window contains lists of all the language-support files available in OpenTM2 and their current installation status.

8.1.1 Prerequisites

None.

8.1.1.1 Calling sequence
Select Display language list from the Utilities menu.

The "Language List" window is displayed.

8.1.1.1.1 Options and parameters

None.

8.1.1.1.2 Results

The "Language List" window shows all available languages and their current status. The State column indicates whether the language-support file for
the respective language is installed (indicated by active or inactive).

There are several reasons for a language being shown as inactive:
e |t is not included in your base package.
e |tis included in your base package, but you did not install it.
e |tis included in your base package and you installed it, but you subsequently deleted it because you had no need for it at that time.

If you need a language-support file for any of the languages supported by OpenTMZ2, you can install it on top of your current installation.

If you translate into languages for which language support is not available, such as Hungarian, you cannot check the spelling of the translated
documents.

8.1.2 What you can do with language-support files

Language-support files can be installed, extended, or deleted.

8.1.3 Deleting language-support files

You can delete a language-support file when you no longer need it. You may want to do this, for example, if you no longer translate from or into this
language.

8.1.3.1 Prerequisites

None.
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8.1.3.1.1 Calling sequence
Select:
1. Display language list from the Utilities menu

2. The language-support file to delete
3. Delete from the File menu

8.1.3.1.2 Options and parameters
Before OpenTM2 deletes the selected language-support file, you are asked to confirm your request:

¢ Select Yes to delete the language-support file.
¢ Select No to cancel the delete request.

8.1.3.1.3 Results

If you select Yes, the language-support file is deleted. Otherwise, it remains unchanged. A reference to this source language may still exist in certain
folders, dictionaries, and Translation Memory databases. Update the respective properties so that the deleted language-support file is no longer
referred to.

8.1.4 Extending language-support files

Occasionally, documents contain words with a spelling not recognized by OpenTM2although you consider them spelled correctly.

Such words can be added to an addendum of the respective language support and are then accepted by the spellchecking function. For more
information, see Spellchecking a document.

8.1.5 What you can do for other languages

The list of target languages includes all languages for which language-support files exist, and certain other languages that are supported by Windows
(R), If you want to translate into other languages, select Other Languages from the list of languages.
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9 Working with the samples

OpenTM2 comes with sample translation material that you can use for practising. The samples are contained in folders to help you become familiar with
the concepts of file organization and navigation in OpenTM2.

9.1 Overview and terminology

The following table lists the sample folders you can select when installing OpenTM2.

Folder Format Original Translation
samplami Ami Pro English (U.S.) Spanish
samplprt 0S/2 () resource file  English (U.S.) German (national)
samplrtf RTF English (U.S.) Spanish
samplwp WordPerfect English (U.S.) Spanish
samplw4w Word 2.0 English (U.S.) German (national)
samplehtmli  HTML English (U.S.) German (national)
sample2 0S/2 () program file  English (U.S.) German (national)
samplehtml3  HTML English (U.S.) Italian
samplehtml4  HTML English (U.S.) Spanish
samplehtml5 HTML English (U.S.) French (national)
samplehtmlé  HTML German (national) English (U.S.)
samplehtml7 HTML English (U.S.) Japanese
samplehtml8 HTML English (U.S.) Russian
samplehtml9 HTML English (U.S.) Arabic

(

samplehtml10 HTML English (U.S.) Polish

Each sample folder contains several documents, a dictionary, and a Translation Memory specially prepared for demonstration purposes. The
samplehtmll folder, for example, contains:

e Two small documents called device.html and trans.html
¢ A small English (U.S.) to German (national) dictionary called samplel
¢ A small Translation Memory samplehtmll

The text of the sample documents is the same for all formats, except:

* SAMPLEZ2 contains OS/2 (®) program files
e SAMPLPRT contains a sample dictionary for printing

The document device.html is already analyzed, the document t rans.html is not analyzed.

To install the sample folders, select the Samples option during installation. The installation procedure prepares the folders for subsequent import and
use.

OpenTM2 performs a morphological stem reduction so that you can look up terms in the original document and check the spelling in translated
documents. To use these features with the material in a sample folder, you must first install the appropriate language-support files for the source and
target languages. For example, to use folder samplwp you must install the English (U.S.) language-support file because the original sample documents
are in English. To check which language-support files have been installed, select Display language list from the Utilities menu of the OpenTM2
workbench. State active tells you that a language has been installed.

To have OpenTM2 check the spelling of a translated document, you must install the language-support file for the target language. For example, for
SAMPLWP the Spanish language-support file must be installed.

To study the material in one of the sample folders, import it first. You can then open a document. The Translation Environment is displayed and you
can start to translate the document. From the "Dictionary" window you can also look up terms in the supplied sample dictionary, and from the
"Translation Memory" window you can copy entire sentences.

During translation, sentences you translate are added to the sample Translation Memory.

To return a sample folder to its initial status, delete the associated dictionary, Translation Memory, and folder. Then import the entire folder again.
Otherwise, the contents of the initial and updated folders are merged.

To see samples of SGML-based files for data exchange, you can export a sample dictionary or a sample Translation Memory in external format.

9.1.1 What you can do with the samples

The following describes a number of tasks related to working with the sample material. They contain short overviews of how to proceed and references
to the detailed task descriptions to be found elsewhere in this book.
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9.1.2 Deleting a sample folder

If you no longer need any of the sample material, for example, because you are translating other document types or because you are now sufficiently
familiar with it, you can delete selected sample folders.

For details on how to delete parts of the samples, see:

¢ Deleting a folder

e Deleting a document

¢ Deleting a dictionary-entry

e Deleting a Translation Memory

To remove the sample folders from your disk entirely, see Deleting a folder exported to the egf\export subdirectory.

9.1.3 Importing and opening a sample folder and its documents

To import a sample folder and to start a translation exercise is described using the folder samplehtml1 as an example.

9.1.3.1 Prerequisites

* The samples must have been installed.
¢ The language-support file for English (U.S.) must have been installed.

9.1.3.1.1 Calling sequence
Select the "Folder List"window.

. Select Import... from the File menu. The "Import Folder" window is displayed.

. Select the drive where OpenTM2 is installed, for example,C. The Foder list box displays all folders that can be imported.
. Select samplehtml1 from the Folder list box.

. Click Details.... This displays the note that is attached to samplehtmi1.

. ClickOK to leave the "Folder Details"window.

Click the destination drive where you want to store samplehtml1 .

Click Import to begin importing the folder. Several windows are displayed showing the progress of the import procedure.
. Click OK when you have read the completion message.This takes you back to the OpenTM2 main window.

. Double-click folder samplehtml1 in the "Folder List" window. The "Document List" window is displayed.

. Double-click device.html in the "Document List"window. The Translation Environment is displayed and the document appears in the
Translation window ready for translation.

COONOUAWN=

—_

9.1.3.1.2 Results

The folder samplehtml1 is imported into OpenTM2. The analyzed document device.html is opened. You can start translating it.

9.1.4 Translation exercise with a sample document

Before documents can be translated, OpenTM2 analyzes them to prepare them for translation. The device.html documents have already been
analyzed. The trans.html documents are analyzed automatically when you open them, or you can explicitly select one of the analysis functions.

After importing and opening a document, you are taken to the Translation Environment , where the following windows are displayed:
e The "Translation"window
e The "Translation Memory"window

e The "Dictionary"window

The document device.html contains one chapter of a complete book. Other document files of the book have been translated already, that is, a
Translation Memory exists for them.

When you translate a sample document, remember that you can stop at any point in the session by:

¢ Double-clicking the system menu icon of the Translation Environment
¢ Selecting Close from the system menu

To copy a proposal from the Translation Memory into the "Translation" window, press and hold down the Control key and type the number of the
required proposal.

To copy a proposal from the "Dictionary" window into the "Translation" window, press and hold down the Control key and type the letter of the required
proposal.

You can edit the translation document file in either insert or replace mode.
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If the suggested translation contains special characters that are not available on your keyboard, ignore them or type other characters instead.
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10 Creating reports

OpenTM2 enables you to collect information about the effort, state, and history of your translations. The collected information can be displayed in
different reports and used as a basis for calculating translation costs.

10.1 Overview and terminology

OpenTM2 collects information during the following events, called process tasks:

e Import of a folder or document
e Export of a folder or document

¢ Change of folder or document properties

e Analysis of a document

e Automatic substitution during analysis

¢ Saving of a document
¢ Deletion of a folder or document

The records containing the information and the result of the collection depend on the process task and are stored in a logging file in compressed form.
There is one logging file per folder, the history log file, stored as HISTLOG.DAT in the PROPERTY directory of the folder. New records are added at the

end of the history log file.

The following table shows what happens with the history log file during the various process tasks.

Process Task

Importing a folder

Importing a document (external format)

Importing a document (internal format)

Exporting a folder

Exporting a document (external or internal
format)

Changing folder or document properties

Analyzing a document

Saving a document
Deleting a folder

Deleting a document

Action

e The imported history log file is merged with the existing one
* The entries are sorted by date

¢ Duplicate entries are stored only once

¢ An import record is added to the history log file

e An import record is added to the history log file

¢ The history log file of the imported document is merged with the folder history log file

¢ An import record is added to the history log file

* |f a new target document replaces an existing one, an additional record is added containing the
results of the target document

¢ The history log file is exported together with the folder data
o |f only selected documents are exported, only that part of the history log file belonging to these
documents is exported

¢ An export record is added to the history log file
¢ A record containing the new settings is added to the history log file

e An analysis record is added to the history log file
o |f automatic substitution is selected, an additional record containing the collected information is
added to the history log file

¢ A save record containing the summary of the collected information is added to the history log file
¢ The history log file is deleted

¢ A deleted record is added to the history log file

During editing and analyzing, information is collected on the following:

¢ The source and target words
¢ The quality of the best proposal:

O Null'if an exact proposal exists

0 The number of source words if no proposal exists
0 The number of different words if a fuzzy proposal exists

¢ The type of the best proposal
¢ The type of the copied proposal

e Whether a segment is translated using automatic substitution during analysis or while using the editor

The collected information is kept in the segmented target file and deleted when the source file is analyzed again. Each time a document is saved during
translation, the information collected is stored in a record that is added to the history log file. If more than one proposal exists for a specific word, only
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the best proposal is counted and assigned to the appropriate class, independent of your selection. Only those proposals are counted that existed when
the segment was translated for the first time. An exact proposal is assigned to the column "Analyze Auto", "Analyze Edit", or "Edit Exact".

The number of source words is counted when a segment is activated, which means that segments not yet translated always have zero source words.
The number of target words is updated each time a segment is saved and when the segment is autosubstituted. For the current segment, the number of
target words is zero if not yet translated. If a source segment is copied into a target document, the number of target words is set to zero. The following
rules apply for counting source and target segments:

e The same counting facility is used as for counting the number of words in documents.
¢ Punctuation and NOLOOKUP tokens are not counted.
e Inline tags are not counted. For inline tags with attributes, only the translatable information is counted.

The number of modified words, which is the number of words differing in the current source and the source of proposal, is counted using an LCS
algorithm. Only the best proposal is counted. The modified words are counted when the segment is saved for the first time. It is not counted when the
segment is activated, but not translated. The count is not changed when the segment is translated again. The information on which proposal has been
chosen is not saved in the history log file. The current segment belongs to the count of segments not translated. If two segments are joined, they are

counted as one.

The reports created from the collected information can be either displayed in a window or stored in a file. Each report is attached to the specified folder
and can be created for the whole folder or selected documents in the folder. You can create the following types of report:

¢ The History Report keeps track of the most important process tasks performed by the translator.

* The Counting Report enables you to roughly calculate the effort of a translator. You cannot customize this report to fit your needs.

¢ The Calculating Report enables you to exactly calculate the effort of a translator. You can customize this report to fit your needs.

¢ The Preanalysis Report calculates the effort before a translation starts by checking the Translation Memory databases for exact and fuzzy

matches.
e The Redundancy Report analyzes redundancies in a folder or document to calculate the effort required by a translation. Use this report to

calculate the translation costs before a project starts.
* The Redundant Segment List lists the 100 most frequently used segments in a folder.

The following table gives an overview of when a report should be created.

After

When to create Before translation  During translation translation

Preanalysis Report
Redundancy Report
Redundant Segment List
Calculating Report
History Report X X

Counting Report X X
The Calculating Report is the most important report for all parties involved in a translation project. All other reports help you manage your translations in
a more effective way.

xX X X

X X

—
x
<

To create a report or list, a folder containing at least one document must exist.

Select:

1. The folder from the "Folder List" window or a document from the "Document List" window.
2. Create Counting Report... from theUtilities menu.

The "Create Counting Report" window is displayed.
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Create Counting Report |

General | F'rl:nfilel Setting&l FactSheetI Securit_l,ll Shipment$|

Folder: SaMPLEHT LY
DEVICE HTRL
— Report
Hiztom Report j
Types of Reports IBrief, zort by D ate j
Description: I
— Output to
¥ | Screen
Select. . |
|E:"»SﬂuMF‘LEHTML1 .RFT
Farmat; I'E"S Il j

Create Cancel | Help |

Figure 123. Create Counting Report window

The options and parameters available depend on the report you want to create.

The following sections describe the individual reports.

10.1.1 Creating a History Report

The History Report contains a history of the process tasks with regard to the selected folder or document. It keeps track of the most important tasks
performed by the translator. It is available in different views depending on the level of complexity of the process tasks to be tracked. It should be created
if problems with word-count results or consistency arise and when a translation project is finished.

If you want to create a report for an entire folder, all documents that it ever contained are listed.

10.1.1.1 Calling sequence
Select History Report from the Report field.

The following table shows which tabbed pages must be filled in to produce a History Report.

Table 2. Overview of the tabbed pages to be filled in for a History Report

Tabbed page Purpose Required? Described in...
"General" To define the basics required for a report Yes General page

"Profile" To save or load the report layout defined on the "Settings" tabbed page No Profile page

"Settings" To define the report layout No

"FactSheet"  To set the factors for cost calculation No Setting the factors for cost calculation
"Security" To select special options Optional  Security page
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"Shipments"  To create a report on specific shipments No Shipments page

10.1.1.1.1 Options and parameters

10.1.1.1.2 "General page I"

On the "General" page (see Figure 123), you can choose or specify the following options and parameters:

¢ Folder

This box contains the documents contained in the selected folder or the document that you selected from the Document List.

¢ Report types
Choose one of the following History Report types:

0O Brief, sort by date
To get a brief report that is sorted by the creation date and time of the documents and contains the following information:

¢ A unique record number within the history log file

¢ The name of the documents for which you create a history report
¢ The creation date and time of the documents

* The process tasks for each document listed in the report

¢ Brief, sort by document
To get a brief report where the information is sorted by document name.

¢ Detalil
To get a detailed report of the process tasks performed on the selected documents, such as the Translation Memory and markup

language used and the number of matches found. The information is sorted by the unique record number.

0 Version
To get a report on the OpenTM2 versions used.

¢ Description
To specify additional information on the report that will display in the header of the report. You can type up to 80 characters.

¢ Output to Screen
To display the report in a window.

¢ Output to File

To store the report in a specific file for which you can specify or select the name and directory and select the file format.

Click the "Security" tab to display the "Security" tabbed page.
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Figure 124. Create Counting Report window ? Security page

10.1.1.1.3 "Security page”
On the "Security" page, you can choose or specify the following options and parameters:
¢ List of documents
Select this option if you want to add, to the end of the report, a list of all documents contained in this report. This is useful if your documents
have long names because the report abbreviates file names to 10 characters. The list at the end of a report, however, contains the full

document names.

Click Create to start the creation of the History Report.

10.1.1.1.4 Results

The History Report is created according to your specifications. The following examples show a brief History Report, sorted by date, on one document
and an excerpt of a detailed History Report, also on one document.

Example 1:

101


http://power/opentm2wiki/index.php/File:Eqfb7s16z.gif

Task Id Document Date Time Process task
1 DEVICESCE 02091999 161108 Diocuthent it ot
4 DEVICEECE 02.09.1999 16:2531 save of docutnent expanded form
6 DEVICEECE 02.09.1999 16:10:.47 Diocutnent analysis
T DEVICESCE 09.09.1999 14:10:47 writh autosmatic substitution
8 DEVICE 5CR 09.09.1999 14:11:16 Document analysis
o DEVICESCE 09091999 16:11:1% Lwith automatic substitution
10 DEVICESCE 09091999 16:11.39 Diocument analysis
11 DEVICESCE 09091999 161139 Lwith automatic subetitution

Figure 125. Brief History Report, sorted by date

Example 2:
1 Document impoxt
Date 08.09.1999 16:11:08
Document DEVICE.SCR
Format Folder
Folder =AMPLE]
Source replaced Mo
Hource replaced Mo
4 save of document expanded form
Date 08.09.1999 16:25:31
Document DEVICE.SCR
Segments Source Modified Target
Words Words Words
Mone 1.4 0 1] 1] 1]
Maiches 514 1 5 h f
==15 1] 0 1] 1]
Mot 1.4 2 7 1] 1]
Translated 5.14 10 70 1] 1]
==15 4 a4 1] 1]

Figure 126. Detailed History Report

10.1.2 Creating a Counting Report

The Counting Report contains tables that enable you to roughly calculate the translator?s effort. You cannot change the tables to meet your
requirements.

10.1.2.1 Calling sequence
Select Counting Report from the Report field.

The following table shows which tabbed pages must be filled in to produce a Counting Report.

Table 3. Overview of the tabbed pages to be filled in for a Counting Report

Described in...
General page

Purpose Required?
To define the basics required for a report Yes

Tabbed page
"General"
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"Profile" To save or load the report layout defined on the Settings tabbed page No Profile page

"Settings" To define the report layout No

"FactSheet"  To set the factors for cost calculation No Setting the factors for cost calculation
"Security" To select special options Optional  Security page

"Shipments"  To create a report on specific shipments No Shipments page

10.1.2.1.1 Options and parameters

10.1.2.1.2 "General page" Il
On the "General" page (see Figure 123), you can choose or specify the following options and parameters:
e Folder
This box contains the documents contained in the selected folder or the document that you selected from the Document List.
* Report types
Choose one of the following Counting Report types:

0 Base list
To get a redundant segment list containing only the 99 most used segments with a frequency of 3 or above.

O Detailed list
To get a redundant segment list containing all redundant segments.

¢ Description

To specify additional information on the report that will display in the header of the report. You can type up to 80 characters.
¢ Output to Screen

To display the report in a window.
¢ Output to File

To store the report in a specific file for which you can specify or select the name and directory and select the file format.

Click Create to start the creation of the Counting Report.

10.1.2.1.3 Results
The Counting Report is created according to your specifications.

The following example shows a Counting Report on the contents of a folder, with a summary at its end. For an explanation of the individual rows, refer to
The report layout.

When interpreting the results note that the criteria for fuzzy matches can be customized, as described in Viewing and changing the system preferences.
This also influences the "No match" counter.

103


http://power/opentm2wiki/index.php/Creating_reports#.22Profile_page.22
http://power/opentm2wiki/index.php/Creating_reports#Setting_the_factors_for_cost_calculation
http://power/opentm2wiki/index.php/Creating_reports#.22Security_page.22
http://power/opentm2wiki/index.php/Creating_reports#.22Shipments_page.22
http://power/opentm2wiki/index.php/Creating_reports#The_report_layout
http://power/opentm2wiki/index.php/General_concepts#Viewing_and_changing_the_system_preferences

Document DEVICE.SCR
Date 09.09.1999 16:11:39
Last process task - with autematic substitution

HSegments HOUTCE Modified Target

Words Wornds Wornds

Analysis 1.4 o o a o
Awtesubst | 514 0 0 a 0
==15 || 0 0 0 I

Edit 1.4 0 0 a 0
Awtosubst | 5.14 0 0 a 0
==15 0 0 0 I

Exact 1.4 o o a o
Matches | .14 o o a o
==15 0 0 a I

Replace 1.4 o o a o
Maiches | .14 0 0 a 0
==15 I 0 a a

Fuzzy 1.4 0 0 1] 0
Matches | .14 o o a o
==15 0 o a a

Machine 1.4 0 0 a 0
Baiches | 5.14 o o a o
==15 I 0 a 0

None 1.4 0 0 a 0
Matches | .14 1 3 3 &
==15 0 o a a

Mot 1.4 1 4 a o
Translated | 5.14 5 31 a o
==15 0 o a I

Summary 1.4 0 0 1] 0
5.14 1 3 3 &

==15 I 0 a a

Figure 127. Counting Report with totals ? Table on first document in folder
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selected documenis of folder SARMPLE]
Humnary generated at 01.12.1990 14:56:19

Begnents Source Modified Target

Words Words Worids
Analysis 1.4 0 a 0 0
Autosubst | .14 0 0 0 0
==13 o a 0 o
Edit 1.4 o a 0 o
Autosubst | 514 o a 0 o
==15 o a 0 o
Exact 1.4 0 a 0 0
Maiches | .14 1 11 0 11
==15 0 0 0 0
Replace 1.4 o a 0 o
Matches | 5.14 o a 0 o
==15 0 a 0 0
Fuzzy 1.4 0 1] 1] 0
Maiches | .14 0 a 0 0
==15 0 a 0 0
Machine 1.4 0 0 0 0
Matches | 5.14 o a 0 o
==15 o a 0 o
Mone 1.4 0 a 0 0
Matches | 5.14 1 5 5 &
==14 0 a 0 0
Mot 1.4 3 & 0 0
Translated | 5.14 14 110 1 0
==13 2 47 0 o
Summary 1.4 o 1] 1] o
5.14 2 16 5 17
==15 o a 0 o

Figure 128. Counting Report with totals ? Summary table

10.1.3 Creating a Calculating Report
The Calculating Report is the most important report for all parties involved in a translation project. It enables you to exactly calculate the effort for a

translation project. It contains detailed tables, a summary, a fact sheet, or a combination of the three, on the contents of a folder or on one or more
documents, depending on your specifications. Create such a report before a translation project starts, during a translation project, or after it is finished.

10.1.3.1 Calling sequence
Select Calculating Report from the Report field.

The following table shows which tabbed pages must be filled in to produce a Calculating Report.

Table 4. Overview of the tabbed pages to be filled in for a Calculating Report

Tabbed page Purpose Required? Described in...
"General" To define the basics required for a report Yes General page

"Profile" To save or load the report layout defined on the Settings tabbed page Optional  Profile page

"Settings" To define the report layout Optional

"FactSheet"  To set the factors for cost calculation Optional  Setting the factors for cost calculation
"Security" To select special options Optional  Security page
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"Shipments"  To create a report on specific shipments Optional  Shipments page

10.1.3.1.1 Options and parameters

10.1.3.1.2 "General page" lll
On the "General" page (see Figure 123), you can choose or specify the following options and parameters:
e Folder
This box contains the documents contained in the selected folder or the document that you selected from the Document List.
¢ Report types
Choose one of the following Calculating Report types:
0 Base
To get a detailed overview, for each selected document, of the activities performed by OpenTM2 and by the translator to complete a

translation. The translator?s effort can be calculated based on these activities.

¢ Summary
To get a summary row for each selected document, and a summary row for all documents.

0 Fact sheet
To get a complete overview of the costs of a translation project using different complexity and pay factors.

0 Base & Summary & Fact Sheet
To get a report containing all the information previously described.

0 Base & Summary
To get the detailed overview, a summary row for each selected document, and a summary row for all documents.

¢ Summary & Fact Sheet
To get a report containing both the summary and the fact sheet. This report is designed for the project coordinator.

0 Base & Summary & Fact Sheet
To get a report containing all the information previously described.

¢ Description

To specify additional information on the report that will display in the header of the report. You can type up to 80 characters.
¢ Output to Screen

To display the report in a window.
¢ Output to File

To store the report in a specific file for which you can specify or select the name and directory and select the file format.

Click the "Profile" tab to display the "Profile" page.
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Figure 129. Create Counting Report window ? Profile page

10.1.3.1.3 "Profile page”
On the "Profile" page, you can choose the following option:
¢ Actual profile
This display-only field shows the name of the loaded profile. If no profile has been loaded "- none ?" is shown.
e Internal name

This display-only field shows the internal name of the loaded profile. Note: only official approved profiles have an internal profile name which is
normally the same as name of the profile.

¢ Profile

Type a name for the settings that you specified on the "Settings" tabbed page and then click Save to save them. Or select or specify the name
of existing settings that you want to use and then click Load.

Click the "Shipments" tab to display the "Shipments" page.
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Figure 130. Create Counting Report window ? Shipments page

10.1.3.1.4 "Shipments page"
On the "Shipments" page, you can choose or specify the following options and parameters:
¢ Use folder shipments
Select this option if you want to use the original shipment number of the folder.
¢ Shipment
You can select one of the following:
. All shipments
To get a report on all shipments

¢ Single shipment
To get a report on all shipments, ordered by the shipment number.

¢ Shipment number
The shipment number of the folder for which you want to create the report. The shipment number of a folder only appears in this
field if you defined it during the creation of the folder (see Creating a folder) or when changing the properties of the folder (see
Changing the properties of a folder).

Click Create to start the creation of the Calculating Report.
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10.1.3.1.5 Results

The Calculating Report is created according to your specifications. The following example shows a Calculating Report containing the overview,
summary, and fact sheet of two documents. For an explanation of the individual columns, refer to The report layout.

Document DEVICE.SCR
Folder CrEQFSAMPLE] .F0O
source Words
Numher Amnalyze Edit Fuzzy
Doc Id Document shipm Catego. | Aute | Post | Edit | Exarci Replace 50-T0%o 70-90%0
1 DEVICE.2CE 1 1.4 2
5.14 44
=13 &4
Document TRANS.DOC
Folder CrEQPSAMPLE] .FOO
source Wonds %
Nuniher Analyze Edit Fuzzy
Doc Id Document Shipm Catego. | Aute | Post |Edit | Exact | Replace S0-70%9 70-90 %49
2 TREANE DOC 1 1.4
5.14
B=154
Figure 131. Calculating Report ? Base
Document Summary
Folder CrEQPSAMPLEL FOO
Source Words
Nuniher Analyze Edit Fuzzy
Doc Id Document shipm Catego. | Aute | Post |Edit | Exact | Replace S0-70% 70-90 %%
1 DEVICE.ECE 1 1.4 3
5.14 44
=15 a4
2 TREANI DOC 1 1.4
5.14
== 15
S 1 1.4 3
5.14 44
=15 54
1 S 131

Figure 132. Calculating Report ? Summary
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Document Final Fact Sheet

Folder CAEQFSARMPLEL FOO
source Words
Numbher Amnalyze Edit Fuzzy
Doc Id Document shipm Catego. | Auwile | Post |Edit | Exaci | Replace 50-T0%o 70-90%
& ctual Words 1 1.4 2
5.14 44
=15 g4
Comiplexits 1.4 1 1 1 1 1 1
Factor 5.14 1 1 1 1 1 1
=15 1 1 1 1 1 1
Complexity 1.4 3
Factor * 5.14 44
&ctual Words ==15 ad
Pay 1.4 1 1 1 1 1 1
Factor 5.14 1 1 1 1 1 1
x=15 1 1 1 1 1 1
Pay 1.4 3
Factor * 5.14 44
Cotrpl. Word =15 a4
Pagrable Words L 131
Final Summary
Payahle Words 147.00
Local Currency 000 ARP
Total Pay 0.00 ARP

Figure 133. Calculating Report ? Fact Sheet

Note: If you create this report before a translation starts, only the ?Analyze Auto? and ?Not Translated? columns contain figures. During and after a
translation, all other columns can also contain figures. After a translation is complete, the ?Not Translated? column should show ?0?.

10.1.4 Creating a Preanalysis Report

The Preanalysis Report is used to calculate the translator?s effort on a ?what-if? basis. It simulates a translation using exact and fuzzy matches from all
Translation Memory databases belonging to the folder or documents. Create this report before work on a translation project starts.

10.1.4.1 Prerequisites

To prepare a folder or document for this report type, analyze it with the ?Count Translation Memory match information? option selected. See Analyzing
documents using Translation Memory databases for more information.

10.1.4.1.1 Calling sequence

Select Preanalysis Report from the Report field. The following table shows which tabbed pages must be filled in to produce a Preanalysis Report.

Table 5. Overview of the tabbed pages to be filled in for a Preanalysis Report

Tabbed page Purpose Required? Described in...

"General" To define the basics required for a report Yes General page

"Profile" To save or load the report layout defined on the Settings tabbed page Optional  Profile Page

"Settings" To define the report layout Optional

"FactSheet"  To set the factors for cost calculation Optional  Setting the factors for count calculation
"Security" To select special options Required? Security page

"Shipments"  To create a report on specific shipments Optional  Shipments page
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10.1.4.1.2 Options and parameters

10.1.4.1.3 "General page IV
On the "General" page (see Figure 123), you can choose or specify the following options and parameters:
e Folder
This box contains the documents contained in the selected folder or the document that you selected from the Document List.
¢ Report types
Choose one of the following Preanalysis Report types:
0 Base
To get a detailed overview, for each selected document, of the activities performed by OpenTM2 and by the translator to complete a

translation. The translator?s effort can be calculated based on these activities.

¢ Summary
To get a summary row for each selected document, and a summary row for all documents.

0 Fact sheet
To get a complete overview of the costs of a translation project using different complexity and pay factors.

0 Base & Summary & Fact Sheet
To get a report containing all the information previously described.

0 Base & Summary
To get the detailed overview, a summary row for each selected document, and a summary row for all documents.

0 Summary & Fact Sheet
To get a report containing both the summary and the fact sheet. This report is designed for the project coordinator.

¢ Description

To specify additional information on the report that will display in the header of the report. You can type up to 80 characters.
¢ Output to Screen

To display the report in a window.
¢ Output to File

To store the report in a specific file for which you can specify or select the name and directory and select the file format.

Click Create to start the creation of the Preanalysis Report.

10.1.4.1.4 Results

The Preanalysis Report is created according to your specifications. The following example shows you a Preanalysis Report containing the overview,
summary, and fact sheet of two documents. For an explanation of the individual columns, refer to The report layout.
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Document

DEVICE.SCR

Folder CAEQF.SAMPLE] .F00
Memory's SARMPLE] ,
Source Words
Analyze Edit Fuzzy Mach. MNone
Doc Id Document Catego, Auto Exact | Replace | S0-TO%% 70-90% | =90% | Maiches | Maiches
1 DEVICE ZCER 1.4 3 4
5.14 44 5 5 21
=15 a4
Document TRANSDOC
Folder CAEQF.SAMPLE] F00
Memory's SARMPLE] ,
Source Words
Analyze Edit Fuzzy Mach. Mone
Doc Id Document Catego. Auto Exact | Replace | S0-TO%% 70-90% | =90% | Maiches | Matches
2 TRANZDOC 1.4 4
5.14 all] 12 11
=15 47
Figure 134. Preanalysis Report ? Base
Document Hummary
Folder CrEQPSAMPLE] F0O0
Memory's SARMPLE] ,
Source Worids
Analyze Edit Fuzzy Mach. Mone
Doc Id Document Catego. Auto Exact | Replace | S0-TO%0 70-90% | =90% | Maiches | Maiches
1 DEVICEECE 1.4 3 4
5.14 44 3 3 21
=15 a4
2 TEANE DOC 1.4 4
.14 &l 19 11
=15 47
S 1.4 i 4
5.14 104 3 24 32
=15 131
S 242 9 24 32

Figure 135. Preanalysis Report ? Summary
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Document Final Fact Sheet

Folder CrEQPSAMPLE] FOO
Memory's SAMPLE] ,
Source Words
Amnalyze Edit Fuzzy Mach. MNone
Doc Id Document Catego. Auto Exact | Replace | 50-70%0 70-90%% | =90% | Maiches | Maiches
A ctual Words 1.4 7 4
5.14 104 3 24 3d
==13 131
Cotnplexitsy 1.4 1 1 1 1 1 1 1 1
Factor 5.14 1 1 1 1 1 1 1 1
==15 1 1 1 1 1 1 1 1
Complexaty 1.4 7 4
Factor * 5.14 104 3 24 3d
A ctual Words ==15 131
Pay 1.4 1 1 1 1 1 1 1 1
Factor 5.14 1 1 1 1 1 1 1 1
=15 1 1 1 1 1 1 1
Pay 1.4 7 4
Factor * 5.14 104 5 24 32
Compl. Word == 15 131
Payrable Words R 242 o 24 32
Final Summary
Payahle Words 307.00
Local Currency 0.00 ARFP
Total Pay 0.00 ARFP

Figure 136. Preanalysis Report ? Fact Sheet

10.1.5 Creating a Redundancy Report

The Redundancy Report is used to calculate the translator?s effort on a ?what-if? basis. It simulates a translation using exact and fuzzy matches from
all Translation Memory databases belonging to the folder or documents. In addition, it counts the redundant sentences, that is, the sentences that

appear more than once, within each document (inner-document redundancies) and across all documents in the folder (cross-document redundancies).

Create this report before work on a translation project starts.

10.1.5.1 Prerequisites

To prepare a folder or document for this report type, analyze it with the ?Count Translation Memory match information? and ?Prepare Redundancy
Report? options selected. See Analyzing documents using Translation Memory databases for more information.

10.1.5.1.1 Calling sequence
Select Redundancy Report from the Report field.

The following table shows which tabbed pages must be filled in to produce a Redundancy Report.

Table 6. Overview of the tabbed pages to be filled in for a Redundancy Report

Tabbed page Purpose Required? Described in...
"General" To define the basics required for a report Yes General page

"Profile" To save or load the report layout defined on the Settings tabbed page Optional  Profile page

"Settings" To define the report layout Optional

"FactSheet"  To set the factors for cost calculation Optional  Setting the factors for count calculation
"Security" To select special options Optional  Security page
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"Shipments"  To create a report on specific shipments Optional  Shipments page

10.1.5.1.2 Options and parameters

10.1.5.1.3 "General page V"
On the "General" page (see Figure 123), you can choose or specify the following options and parameters:
e Folder
This box contains the documents contained in the selected folder or the document that you selected from the Document List.
¢ Report types
Choose one of the following Redundancy Report types:
0 Base
To get a detailed overview, for each selected document, of the activities performed by OpenTM2 and by the translator to complete a

translation. The translator?s effort can be calculated based on these activities.

¢ Summary
To get a summary row for each selected document, and a summary row for all documents.

0 Fact sheet
To get a complete overview of costs of a translation using different complexity and pay factors.

0 Base & Summary & Fact Sheet
To get a report containing all the information previously described.

0 Base & Summary
To get the detailed overview, a summary row for each selected document, and a summary row for all documents.

¢ Summary & Fact Sheet
To get a report containing both the summary and the fact sheet. This report is designed for the project coordinator.

e Description

To specify additional information on the report that will display in the header of the report. You can type up to 80 characters.
¢ Output to Screen

To display the report in a window.
¢ Output to File

To store the report in a specific file for which you can specify or select the name and directory and select the file format.

Click Create to start the creation of the Redundancy Report.
10.1.5.1.4 Results

The Redundancy Report is created according to your specifications. The following example shows you a Redundancy Report containing the overview,
summary, and fact sheet of two documents. For an explanation of the individual columns, refer to The report layout.
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Document DEVICE.SCR
Folder CrEQF.SAMPLE] F00
source Words Inner Document Redundancies
Numbher Amnalyze Edit Fuzzy
Doc 1d Document Shipm Catego. | Auwio | Posi | Edit | Exact | Replace S0-70% 70-90%% =
1 DEVICE SCE 1 1.4 2 4
5.14 44 ]
=13 84
Document TRANSDOC
Folder CAEQF.SAMPLE] F00
sdource Words Inner Document Redundancies
MNuniher Amnalyze Edit Fuzzy
Doc Id Document Shipm Catego. | Aute | Post | Edit | Exact Replace 50-70% 70-909% =!
2 TEANZDOC 1 1.4 4
.14 &l
==13 47
Document Redundancies
Folder CREQF.SAMPLE] J00
source Wonds Cross Document Redundancies
MNumber Analyze Edit Fuzzy
Doc 1d Document Shipm Catego. | Aute | Post | Edit | Exact | Replace S0-7T0 %o 70-90%49 =
3 Redundaticies 1 1.4
5.14 3l
=13
Figure 137. Redundancy Report ? Base
Document Summary
Folder CrEQPSAMPLE] .FOO
source Wonds All Redundancies
MNumber Analyze Edit Fuzzy
Daoc Id Document shipm Catego. | Auwio | Post | Edit | Exact | Replace 50-T0%o 70-90 % =
1 DEVICESCR 1 1.4 3 4
5.14 44 5
»=15 a4
2 TRANZ DOC 1 1.4 4
5.14 alll
==15 47
3 Redundancies 1 1.4
5.14 £
==15
S 1 1.4 i 4
5.14 104 37
==15 131
1 S 242 41

Figure 138. Redundancy Report ? Summary
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Document Final Fact Sheet
Folder CAEQFSARMPLEL FOO
source Words Inner Document Redundancies
Numbher Amnalyze Edit Fuzzy
Doc Id Document shipm Catego. | Auwile |Post | Edit | Exaci | Replace 50-T0%o 70-90%
&ctual Words 1 1.4 7 4
5.14 104 37
==15 131
Comiplexits 1.4 1 1 1 1 1 1 1
Factor 5.14 1 1 1 1 1 1 1
=15 1 1 1 1 1 1 1
Complexity 1.4 7 4
Factor * 5.14 104 37
&ctual Words ==15 131
Pay 1.4 1 1 1 1 1 1 1
Factor 5.14 1 1 1 1 1 1 1
x=15 1 1 1 1 1 1 1
Pay 1.4 7 4
Factor * 5.14 104 37
Compl. Word =15 131
Pasrable Words R 242 41
Final Summary
Payahle Words 307.00
Local Currency 0.00 ARP
Total Pay 0.00 ARP

Figure 139. Redundancy Report ? Fact Sheet

10.1.6 Creating a Redundant Segment List

The Redundant Segment List contains the first 100 most frequently used segments in a folder. As part of your translation project preparation, translate
the segments listed. You can open the documents containing the segments from the Redundant Segment List by double-clicking the document name.

10.1.6.1 Prerequisites

To prepare a folder or document for this report type, analyze it with the ?Count Translation Memory match information? and ?Prepare Redundant
Segment List? options selected. See Analyzing documents using Translation Memory databases for more information.

10.1.6.1.1 Calling sequence

Select Redundant Segment List from the Report field.

The following table shows which tabbed pages must be filled in to produce a Redundancy Segment List.

Table 7. Overview of the tabbed pages to be filled in for a Redundancy Segment List

Tabbed page
"General"
"Profile"
"Settings"
"FactSheet"
"Security" To

"Shipments"

select special options

Purpose

To define the report layout

To define the basics required for a report

To set the factors for cost calculation

To create a report on specific shipments

To produce a Redundant Segment List, fill in the following tabbed pages:
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To save or load the report layout defined on the Settings tabbed page

Required? Described in...

Yes General page

No Profile page

No

No Setting the factors for count calculation
Optional  Security page

No Shipments page
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¢ "General", described in the following
e Optionally, "Security", described in Security page

10.1.6.1.2 Options and parameters

10.1.6.1.3 "General page VI"
On the "General" page (see Figure 123), you can choose or specify the following options and parameters:
e Folder
This box contains the documents contained in the selected folder or the document that you selected from the Document List.
¢ Description
To specify additional information on the report that will display in the header of the report. You can type up to 80 characters.
¢ Output to Screen
To display the report in a window.
¢ Output to File
To store the report in a specific file for which you can specify or select the name and directory and select the file format.

Click Create to start the creation of the Redundant Segment List.

10.1.6.1.4 Results

The Redundant Segment List is created according to your specifications. The following example shows a Redundant Segment List.

Entry 0: Frequency=4
[1] CAEQRSAMPLE .FO0Mranslate.doc : #1
Segment: Do not translate this sentence.

Entry 1: Frequency=3
[1] CAEQRSAMPLE .FO0Mranslate.doc : #6
Segment: Error!

Figure 140. Redundant Segment List

10.1.7 Changing the layout of a report

The Calculating, Preanalysis, and Redundancy Reports have the same layout. However, you can change it according to your needs. The following
sections explain the various rows and columns of a report and tell you what you can change.

10.1.7.1 The report layout

This section describes the individual rows and columns of a Calculating, Preanalysis, or Redundancy Report.

10.1.7.1.1 Analyze Auto

Contains the number of exact and exact-exact matches retrieved from a Translation Memory during the analysis of a document for which the manual
translation has already been started. The "Analyze Auto2" numbers are not used for payment purposes as these numbers contain a mixture of
manually translated segments (which have been added to the memory while manually translating the document) and segments which were already in
the memory before the manual translation started.

When the document is re-imported OpenTM2 assumes the start of a new shipment. The automatically substituted segments during an analysis following
the re-import are when counted in the "Analyze Auto" column although the manual translation may have been started already.
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10.1.7.1.2 Analyze Auto2

Contains the number of exact and exact-exact matches retrieved from a Translation Memory during the analysis of a document. To get a result, you
must select the option ?Substitute exact matches in the documents automatically? on the "General" page of the "Analyze Documents" window (see
Analyzing documents using Translation Memory databases for a description). If more than one exact match is found, it is counted as part of the ?Edit
Exact? column because the translator has to decide which match is the correct one.

Only the first analysis of the document is taken into account. If, however, a previously translated document is imported and analyzed again, the report
contains both the number of exact matches of the first analysis and the results of the reimported document. The results are shown as belonging to
shipment 1 and shipment 2 (column ?Number Shipment?).

10.1.7.1.3 Analyze Post

Has the same contents as, and replaces, the ?Analyze Auto? column after the analyzed document is opened for translation.

10.1.7.1.4 Analyze Edit

Contains the number of exact matches retrieved from a Translation Memory during the translation of the document. To get a result, you must analyze
the document without the ?Substitute exact matches in the documents automatically? option and then select the option ?Automatic substitution? from
the Translate menu during translation. Only the first analysis of the document is taken into account.

If a previously translated document is imported and analyzed again and then edited with automatic substitution, the report contains the number of exact
matches of both the first and the second edit. The results are shown as belonging to shipment 1 and shipment 2 (column ?Number Shipment?).
10.1.7.1.5 Edit Auto

Contains the number of exact and exact-exact matches retrieved from a Translation Memory during the "Automatic Substitution” from within the
Translation Environment.

10.1.7.1.6 Edit Exact

Contains the number of exact matches copied from a Translation Memory during the translation of the document, using the Ctrl+n key (where nis the
number of the exact-match proposal). In addition, it includes the number of exact matches where the translator had to choose between several matches

offered. It also includes the number of inner-document and cross-document redundancies produced by the Redundancy Report.

If a previously translated document is imported, analyzed, and edited again, the report contains the number of exact matches of both the first and the
second edit. The results are shown as belonging to shipment 1 and shipment 2 (column ?Number Shipment?).

If you selected the ?Use existing proposals? option on the "Settings" page, this column shows all exact matches offered by the Translation Memory
regardless of whether the translator accepted and copied them. The number of exact matches not accepted by the translator is reflected in the
Calculating Report when you choose ?Include statistics? and ?Advanced statistics? on the "Settings" page.

10.1.7.1.7 Edit Replace

Contains the number of fuzzy replacement matches copied from an existing Translation Memory during the translation of the document, using the
Ctrl+n key (where n is the number of the fuzzy-replacement-match proposal).

If a previously translated document is imported, analyzed, and edited again, the fuzzy replacement matches become exact matches. OpenTM2 keeps
the original number of fuzzy replacement matches and adds the number of exact matches to the ?Analyze Auto? column as shipment 2.

If you selected the ?Use existing proposals? option on the "Settings" page, this column shows all fuzzy replacement matches offered by the Translation
Memory regardless of whether the translator accepted and copied them. The number of fuzzy replacement matches not accepted by the translator is
reflected in the Calculating Report when you choose ?Include statistics? and ?Advanced statistics? on the "Settings" page.

10.1.7.1.8 Fuzzy Matches

Contains the number of fuzzy matches copied from an existing Translation Memory during the translation of the document, using the Ctrl+n key (where
nis the number of the fuzzy-match proposal). The fuzzy matches are broken down to matches that fit 50 to 70%, 70 to 90%, and over 90%.

If a previously translated document is imported, analyzed, and edited again, the fuzzy matches become exact matches. OpenTM2 keeps the original
number of fuzzy matches and adds the number of exact matches to the ?Analyze Auto? column as shipment 2.

If you selected the ?Use existing proposals? option on the "Settings" page, this column shows all fuzzy matches offered by the Translation Memory

regardless of whether the translator accepted and copied them. The number of fuzzy matches not accepted by the translator is reflected in the
Calculating Report when you choose ?Include statistics? and ?Advanced statistics? on the "Settings" page.
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10.1.7.1.9 Machine Matches

Contains the number of exact matches copied from an Initial Translation Memory during the translation of the document, using the Ctrl+n key (where n
is the number of the machine-match proposal).

If a previously translated document is imported, analyzed, and edited again, the machine matches become exact matches. OpenTM2 keeps the original
number of machine matches and adds the number of exact matches to the ?Analyze Auto? column as shipment 2.

If you selected the ?Use existing proposals? option on the "Settings" page, this column shows all machine matches offered by the Translation Memory
regardless of whether the translator accepted and copied them. The number of machine matches not accepted by the translator is reflected in the
Calculating Report when you choose ?Include statistics? and ?Advanced statistics? on the "Settings" page.

10.1.7.1.10 Non Matches

Contains the number of segments translated manually. This number remains the same even if you analyze the translated document again and translate
it using the ?Automatic substitution? option from the Translate menu.

If a previously translated document is imported, analyzed, and edited again, the non-matches become exact matches. OpenTM2 keeps the original
number of non-matches and adds the number of exact matches to the ?Analyze Auto? column as shipment 2.

10.1.7.1.11 Not Translated

Contains the number of segments not yet translated because the translation has not started yet or was interrupted. If the partly translated document is
imported and analyzed again, only the number of segments not yet translated is shown.This column should show ?0? once the translation is finished.
10.1.7.2 Changing the layout

This section describes what you can change with regard to the layout of a report.

To begin, click the "Settings" tab in the "Create Counting Report" window to display the "Settings" tabbed page.
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Create Counting Report |

Generall Profile  Settings | FactSheetI Securit_l,ll Shipment$|

— Dizplay

Count Mumber of: ISl:uun:E words
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Categories
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[ Build summary of categories

— Select Columns

Repaort lapout Standard ﬂ
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— Statiztics

™ Include Statistics Standard Statistics "l

[T Use Existing Proposals

Create Cancel | Help |

Figure 141. Create Counting Report window ? Settings page

On this page, you can choose or specify the options and parameters described in the following. A Calculation Report (Base) is used as an example to
demonstrate the effect that the different specifications have on the report layout.

¢ Count number of
Specify what is to be counted to calculate the effort and payment of the translator:

¢ Source words
The source words are used for the calculation. This is the preferred setting.

Differences in the complexity of different languages can be taken into account using language-dependent complexity factors on the
"FactSheet"page of the "Create Counting Report" window (see Setting the factors for cost calculation).

¢ Target words
The target words are used for the calculation. Select this option only for tracking and informational purposes.

0 Segments
The translated segments are used for the calculation.

¢ Modified words
The modified source words are used for the calculation.

» Categories

Specify whether your report is to contain a ?Category? column breaking your calculation down to segments with 1..4 words, 5..14 words, and
more than 15 words.

0 Show categories
The report contains a ?Category? column.The following Calculating Report contains such a column:
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Document DEVICE.SCR

Folder CEQRSARPLEL FOO
Source Words
Munher Analyze Edit Fuzzy
Doc 1d Document shipm Catego. | Auio | Posi | Edit | Exact | Replace S0-70% 70-90% =
1 DEVICESCR | 1.4 3
a.14 44
==15 24
Figure 142. Calculating Report (Base), with categories
0 Hide categories
The report does not contain a ?Category? column but shows the calculation summed up in one row.The following Calculating
Report differs from [[Figure 142] in that it does not contain any categories:
Document DEVICESCR
Folder CAREQFSARMPLEL FOO
Source Words
MNuniher Analyze Edit Fuzzy ]
Doc Id Document Shipm Aute | Post | Edit | Exact | Replace S0-T0%0 70-90 %% =00 % !
1 DEVICESCE 1 131
Figure 143. Calculating Report (Base), without categories
¢ Build summary of categories
If you selected ?Show categories?, you can select this option to add a row containing the sum of the calculation. It is similar to the row you get
when specifying ?Hide categories?. Your Calculating Report would then look as follows:
Document DEVICE.SCR
Folder CREQFPSAMPLEL FOO
Source Words
Nuniher Analyze Edit Fuzzy
Doc Id Document shipm Catego. | Aute | Post | Edit | Exaci Replace 50-T0 %o T0-90 % =
1 DEVICEICE 1 1.4 3
514 44
==15 24
DEVICE BCE 1 S 131

Figure 144. Calculating Report (Base), with summary of categories
¢ Report layout
Specify whic columns the report is to contain:

¢ Standard
The report contains the following columns:

e Analyze Auto
¢ Analyze Post
e Analyze Edit
¢ Edit Exact
¢ Edit Replace
e Fuzzy 50?70%
e Fuzzy 70?790%
e Fuzzy >90%
e Machine matches
e Manually translated (None Matches)
¢ Not Translated
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These columns are described in The report layout.

¢ Standard and group summary

The report contains the columns previously described and summaries for the Analyze, Edit, and Fuzzy columns. Your Calculating Report

would then look as follows:

Document DEVICE.SCR
Folder CrEQPSAMPLE] F0O
Source Words
MNuniher Sum Analyze Sum Edit Sum
Doc Id Document shipm Catego. | Amalyze | Auio | Post | Edit | Edit Exact Replace Fuzzy

1 DEVICEZCE 1 1.4 3 3

.14 44 44

==15 24 a4

DEVICE ZCE 1 S 131 131

Figure 145. Calculating Report (Base), standard and group-summary layout

¢ Shrunk to groups

For the Analyze, Edit, and Fuzzy columns, the report only shows the summaries to improve readability. Your Calculating Report would then

look as follows:

Document DEVICE.SCR
Folder CHEQFRSAMPLEL FOO
Source Words
Muniher Hsum Mach. Mone Mot
Doc Id Document Shipm Catego. | Analyze |Edit | Fuzzy Maiches Maiches | Transl
1 DEVICE2CR 1 1.4 3 4
5.14 44 3 31
=15 a4
DEVICE.ZCR 1 St 131 5 35

Figure 146. Calculating Report (Base), shrunk to groups

10.1.7.2.1 Automatic shrink

Select this option if you want your report without the columns containing no values. Figure 146 would then look as follows:

Document DEVICE.SCR
Folder CHEQFRSAMPLEL FOO
Source Worids
MNunbher S Analyze Mone Mot
Doc Id Document shipm Catego. | Analyze Post Maiches | Transl
1 DEVICESCR 1 1.4 3 3 4
5.14 44 44 5 31
=15 24 24
DEVICESCER 1 Ham 151 131 5 33

Figure 147. Calculating Report (Base), standard and group-summary layout, automatic shrink

¢ Include statistics

This option is only available to the Calculating Report.
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Select this option if you want to add a statistics table of your project to the end of your report. This table can help you check the quality and
consistency of the translation. A low percentage of matches used indicates that the translator used few of the proposals offered by OpenTM2.

You can choose between the following types of statistics:
¢ Standard statistics

The statistics table contains the percentage of proposals offered (exact, replace, fuzzy, and machine proposals) that were actually
used by the translator. Such a statistics table can look as follows:

Statistics
Document TRANSDOC
Folder CrEQF.SAMPLE] F00
MNumbher Edit Sum Fuzzy Mach
Daoc Id Document shipm Catego. | Exaci | Repl | Furzy S0-70%0 70-90% =90%p Maiches

1 TEANI DOC 1 1.4 - - - - - - -
5.14 62% - 100%; - 100% - -
=15 | 100% - - - - - -

Figure 148. Standard statistics

¢ Advanced statistics
The statistics table contains both the percentage of proposals used and the absolute number of proposals not used during the
translation. This option enables you to estimate whether the number of matches not copied by the translator is acceptable. Your
table can look as follows:

Statistics
Document TRANSDOC
Folder CAEQF.SAMPLE] .F00
Numiher Edit Sum Mach. Edit Sum
Doc Id Document shipm Catego. | Exact | Replace | Fuzzy | Maiches | Exaci | Repl | Fuzzy | 50

1 TEANE DOC 1 1.4 - - -
.14 1% 9 B2% - 100%;
=13 22 100% - -

Figure 149. Advanced statistics
¢ Use existing proposals

Select this option if you want your report to show all proposals offered by OpenTM2 regardless of whether the translator accepted and copied
them. This option enables you to calculate the effort based on the assumption that all proposals were accepted.

10.1.8 Setting the factors for cost calculation

Documents can differ considerably with regard to their complexity. Some documents are easy to translate while the translation of others is difficult and
time-consuming. The complexity of a document can also vary depending on the source language. OpenTM2 enables you to take into account such
language-dependent differences.

For each translation project you can specify different complexity and pay factors. The factors can be reflected in the History, Calculating, Preanalysis,
and Redundancy Reports.

Click the "FactSheet" tab of the "Create Counting Report" window to display the "FactSheet" tabbed page.
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Create Counting Report |

Generall F'rl:nfilel Seftings FactShest | Securit_l,ll Shipment$|

— Final Fact Sheet

Calumn | Edit At Subst =
Categary [Simple (1.4 words) =l
Complesxity Factar I‘I 000
Pay Factar I'I 000
— Final Factors

Uit |1 word j

Local Currency II]_l:Il:ll:l AEP j

Create Cancel | Help |

Figure 150. Create Counting Report window ? FactSheet page

On this page, you can choose or specify the following options and parameters:
¢ Column
Select the calculating factor for which you want to choose different complexity and pay factors. You can choose one of the following:

0 Analysis Auto Subst
Contains the number of exact and exact-exact matches retrieved from a Translation Memory during the analysis of the document.

¢ Analysis Auto Subst 2
Has the same contents as, and replaces, the ?Analysis Auto Subst? column after the analyzed document is opened for translation.

¢ Edit Auto Subst
Contains the number of exact matches retrieved from a Translation Memory during the translation of the document using the
?Automatic substitution? option from the Translate menu.

0 Exact Matches
Contains the number of exact matches copied from a Translation Memory during the translation of the document using the Ctrl+n
key.

0 Replace Matches
Contains the number of fuzzy replacement matches copied from a Translation Memory during the translation of the document.

0 Fuzzy Matches
Contains the number of fuzzy matches copied from a Translation Memory during the translation of the document. The fuzzy
matches are broken down to matches that fit less than 70%, less than 90%, and over 90%.

¢ Machine Matches
Contains the number of exact matches copied from an Initial Translation Memory during the translation of the document.

0 Manually Translated
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Contains the number of segments to be manually translated.

For a more detailed description of these options, refer to The report layout. You can change the complexity and pay factors for several or all columns of
a report. For example, if you want to specify different complexity and pay factors for the Exact Matches and Manually Translated columns, proceed as
follows:

1. Select Exact Matches.

2. Select a category.

3. Specify a complexity factor.

4. Specify a pay factor.

5. Select Manually Translated. At this point of time, OpenTM2 saves your settings for the Exact Matches column.

6. Select a category and specify a complexity factor and a pay factor.

¢ Categories
Select the sgments for which you want to choose different complexity and pay factors. You can choose one of the following:

¢ Simple (1..4 Words)
Segments with one to four words.

¢ Medium (5..14 Words, mean)
Segments with five to 14 words.

¢ Complex (>= 15 Words)
Segments with more than 15 words.

* Complexity factor

Specify a complexity for the selected column and category. This option enables you to take into account the translation challenges that each
language poses.

For example, a Finnish sentence with more than 15 words might be more difficult to translate than an English sentence of the same length.
So, for a translation from Finnish, you might want to specify a complexity factor of 2 for segments with more than 15 words that need to be
manually translated, whereas for a translation from English, you might want to leave the complexity factor at 1.
The default complexity factor is 1.
¢ Pay factor
Specify a number by which the amount of money defined in the Local Currency fields is to be multiplied for the unit specified.
It is recommended that you specify the same pay factor for an entire translation project.
The default pay factory is 1.
e Unit
Select the unit on which your payment is based:

¢ 1 word
Payment is per word.

¢ Standard line (10 words)
Payment is per line, which consists of 10 words on average.

¢ Standard page (250 words)
Payment is per page, which consists of 250 words on average.

¢ Local currency
Specify the amount of money to be paid for each unit and the currency.

Example: The following figure shows the fact sheet of a Calculation Report that was created after the translation was finished:
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Document Final Fact Sheet
Folder CrEQPSAMPLE] F0O
source Wonds
MNurmiher Analyre | Edit Fuzzy None
Doc Id Document shipm Catego. Post Exact | 70-909%% Maiches
&rctual Words 1 1.4 3 4
5.14 44 3 3 26
==13 ad
Actual Words 1 L 131 3 ] 30
Cotnplexity 1.4 0.50 0.73 1 1
Factor 5.14 0.50 0.75 1 2
==153 0.50 0.75 1 3
fHEeatl comg S 0.50 075 1 2
Complexty 1.4 1 4
Factor * 5.14 24 3 3 54
Actual Words =15 41
Cottipl. Wiford St (2] 3 ] S6
Pay 1.4 1 1 1 1
Factor 5.14 1 1 1 1
==15 1 1 1 1
tnear pay S | 1 1 |
Pay 1.4 1 4
Factor * 5.14 24 3 3 54
Cottpl. Wiord =15 41
FPagable Words St 2] 3 ] 36
Final Summary
Payahle Words 130.25
Standard Lines 1302
Local Currency 10.00 USD
Total Pay 13025 USD

Figure 151. Calculating Report ? Fact Sheet

To achieve this result, you specify the following on the "FactSheet" page:

O©CoONOOODWND =

NMDMNDMNDN = — b b o
WN 200N UTRARWN—=O

. Select Analysis Auto Subst2 as column.
. Select Simple (1..4 Words) as category.
. Specify 0,5 for the complexity.

. Select Medium (5..14 Words, mean) as category.
. Specify 0,5 or the complexity.

. Select Complex ( >= 15 Words) as category.

. Specify 0,5 for the complexity.

. SelectExact Matches as column.

. Select Simple (1..4 Words) as category.
. Specify 0,75 for the complexity.

. Select Medium (5..14 Words, mean) as category.
. Specify 0,75 for the complexity.
. Select Complex (>= 15 Words) as category.
. Specify 0,75 for the complexity.

. Select Manually Translated as column.
. Select Simple (1..4 Words) as category.
. Specify 1 for the complexity.
. Select Medium (5..14 Words, mean) as category.
. Specify 2 for the complexity.
. Select Complex (>= 15 Words) as category.
. Specify 3 for the complexity.
. Specify Standard line (10 words) as unit.
. Specify 10 USD as local currency.
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OpenTM2 calculates the costs by multiplying each category with the complexity factor specified for that category. Each result is multiplied with the pay
factor specified. The sum is the number of payable words. Because the unit is defined to be a standard line, the number of payable words is divided by
10. The result is multiplied by the cost (?Local currency?) specified for a standard line. You then receive the costs for the translation of this document.
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11 Working from the command area

e Working from the command area: BatchUtil
e Working from the command area: Other Tools
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12 Appendices

¢ Overview of the OpenTM2 menus

e Editor functions reference

e Format files for printing a dictionary

e Displaying markup information for Word documents
¢ Exchanging data with other OpenTM2 products
e Directory structure of OpenTM2

¢ System limitations

¢ Hints, tips, and technical notices

e Problem determination

® Accessibility

e Trademarks
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13 Glossary

This glossary defines all new terms and abbreviations used in this manual. It does not include all terms previously established for operating systems. If
you do not find the term you are looking for, refer to the index or to the Dictionary of Computing, New York: McGraw-Hill, 1994.

addendum
The extension of a language-support file that contains individually added spellings of terms. For example, terms which have been indicated as
misspelled by the spellchecker although spelled correctly.

aligning
The process of combining source segments with their corresponding target segments in an Initial Translation Memory (ITM).

analysis
A process for dividing text into segments. It checks the text against specific exclusion lists and dictionaries, and produces, on your request, a
new terms list and a found terms list.

ANSI
American National Standards Institute.

API
Application programming interface.

application programming interface (API)
A software interface that enables applications to communicate with each other. An APl is the set of programming language constructs or
statements that can be coded in an application program to obtain the specific functions and services provided by an underlying operating
system or service program.
In VTAM (R the language structure used in control blocks so that application programs can reference them and be identified to VTAM (),

automatic lookup
During translation, OpenTM2 performs an automatic lookup in the referenced Translation Memory and in the referenced dictionaries. For
each segment, matching segment translations from the Translation Memory are displayed as translation proposals in the "Translation
Memory" window, translations of its terms are displayed in the "Dictionary" window.

automatic substitution
An option in the Translate menu. It lets you start the automatic substitution process, which translates those segments that have been
previously translated by you or another translator and are stored in the Translation Memory. It is particularly useful for translating updated text.
However, you still must translate new text manually.

company code
Abbreviation for a particular area of usage a translation applies to. For example, certain terms are used differently depending on the
companies or clients you do translations for.

controlled folder handling
Is a concept that is only available to project coordinators. It allows them to specify, and change at any time, all properties and details for a
folder, including the translators for the documents to be imported into this folder. It also allows them to ship the folder once all translations are
finished.

details
See view details.

dictionary
A database that contains terms, their translation, and other related information.

dictionary entry
All data relating to a headword in a dictionary

dictionary filter
A method to select specific entries from a dictionary or only parts of these entries. The filter conditions that must be met if an entry is to pass
the filter can be individually defined when printing or searching a dictionary.

dictionary print format
Specifies the layout of a printed dictionary. OpenTM2 provides standard formats described in format files that can be tailored individually. The
format files are on the same disk where OpenTM2 is installed under the subdirectory egf\prtform.

DLL
Dynamic-link library.

document file
A generic term used to describe all types of files containing information that is to be translated. Document files can be analyzed and opened
for translation in the Translation Environment. The source of the document file you translate is called the original document. The document file
that you edit during translation is referred to as the translation document.

document type
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Depending on the different types of markup used to describe the layout of document, OpenTM2 differentiates between different document
types.

dynamic-link library (DLL)
A file containing executable code and data bound to a program at load time or runtime, rather than during linking. The code and data in a
dynamic-link library can be shared by several applications simultaneously.

entry fields
The various fields and styles of an entry in a dictionary, such as meaning, usage, context, abbreviation, idioms, and grammatical information.
For example, the entry field Abbr. would contain the abbreviation of a headword. The combination of all entry fields of a specific headword
makes up the headword?s entry in the dictionary.

entry level
The information that applies to all the templates of an entry. For example, the term itself, the author, and the date the entry was created.

entry section
Section in a dictionary. Contains all dictionary entries appearing one after another.

exact match
Each segment in the translation document is compared with the selected Translation Memory. If an identical segment is found, an exact
match has occurred and the corresponding translation proposal is shown in the "Translation Memory" window. It originates from a previous
translation.

exact match (1)
An exact match for which the following condition applies:The exact match occurs only once in the attached Translation Memory databases.

exact match (>=2)
An exact match for which the following condition applies:The exact match occurs at least twice in the attached Translation Memory
databases.

exact-exact match
An exact match for which the following condition applies:The number of the active segment in the source document is identical (give or take 2)
with that of the corresponding segment in the Translation Memory. In addition, the name of the document (document name = file name plus
relative path (if available)) being translated is identical with that of the document stored in the Translation Memory.

exact context match
An exact match for which the following condition applies:The number of the active segment in the source document is not identical with that of
the corresponding segment in the Translation Memory. However, the name of the document being translated is identical with that of the
document stored in the Translation Memory.

exclusion list
A list containing common words such as articles, prepositions, proper nouns, and terms that occur frequently. These words are ignored when
creating new terms lists and found terms lists during analysis, and are not shown in the "Dictionary" window during translation. Exclusion lists
can be edited.

export
To copy folders, documents, dictionaries, and Translation Memory databases to the DOS file system to make them available to another user.
folder
Contains documents belonging to one project and references to the Translation Memory databases and dictionaries you want to use during
translation.
format file

A file that contains the specification of a dictionary print format. It can be created and changed with a text editor.

found terms list
A list of all terms in the documents being analyzed that were found in the selected dictionaries. The list is used to update dictionaries and
exclusion lists. Found terms lists can be edited, that is, terms can be deleted, moved to a dictionary, or to an exclusion list. A found terms list
can be used to fill a separate dictionary related to a document.

fuzzy match
Each segment in the translation document is compared with the selected Translation Memory. If an almost identical segment is found, a fuzzy
match has occurred and the corresponding translation proposal is shown in the "Translation Memory" window with a preceding [f]. It originates
from a previous translation.

fuzzy replacement match
A replacement match where a couple of words are not identical. It is displayed in the "Translation" window with a preceding
[rfl.Example:Document text: This is what happened in 1998.
TM proposal: This happens in 1999. In this example, the date in the TM proposal (1999) is automatically changed to the date in the document
text (1998). However, happened is not replaced with happens.

header section
Section in a dictionary. Contains general dictionary information such as source language, target language, and creation date of the dictionary.

headword
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Word or term placed at the beginning of an entry in a dictionary.

history log file
A file storing, in compressed form, records that contain the information collected during events, such as exporting or deleting a folder, and the
result of this collection. There is one history log file per folder, which is stored as HISTLOG.DAT in the PROPERTY directory of the folder.
New records are added at the end of the history log file.

homonym
Words that are spelled and pronounced alike but different in meaning. For example, the noun conduct and the verb conduct are homonyms.

homonym level
Part of a dictionary entry. Contains grammatical and syntactic information, such as part of speech, hyphenation, and abbreviation information.

HTML
Hypertext Markup Language.

Hypertext Markup Language (HTML)
A subset of the Standard Generalized Markup Language (SGML) allowing the presentation of electronically stored information within the
World Wide Web (Internet).

icon
A small graphical symbol. Icons can represent windows that you want to work with (such as Folder list, Document list, Dictionary list,
Translation Memory list, Terminology lists) or tasks that you want to perform.

import
To copy folders, documents, dictionaries, and Translation Memory databases from the DOS file system to make them available to OpenTM2.

Initial Translation Memory (ITM)
A Translation Memory created from existing translations and their corresponding originals. Proposals originating from an ITM are shown in the
"Translation Memory" window with a preceding [m] like machine-generated matches.

irregular match
One of the following:
¢ A 1:2 match, where one source segment has been connected to two target segments
¢ A 2:1 match, where two source segments have been connected to one target segment
¢ A 2:2 match, where two source segments have been connected to two target segments
¢ An unaligned sentence (the default color is red)
O A sentence that is ignored (the default color is grey)

IT™M
Initial Translation Memory.

JavaScript
A scripting language that resembles Java (™) and was developed by Netscape for use with the Netscape browser.

language support files
Source languages supplied with OpenTM2. Language support files are required when looking up dictionary entries during analysis of
document files and during spellcheck.

lookup
See automatic lookup and search.

machine-generated match
Originates from an Initial Translation Memory and is displayed in the "Translation Memory" window with a preceding [m]. Can be used in the
same way as a fuzzy match.

maptable section
Section in a dictionary. Determines the structure of dictionary entries. Contains the total of all allowed entry fields in a dictionary.

markup
Information added to a document, for example, formatting tags, to enable a system to process it. It describes the document characteristics or
specifies the actual processing to be performed.

markup language
The language specific to a word processor that describes a document layout.

markup table
Contains all tags and attributes of a particular markup language. Is used in OpenTM2 during analysis and translation.

match
The fact that a source segment in a Translation Memory and a source segment in a document to be translated at least resemble each other
(fuzzy match or replacement match). If they are completely identical, it is an exact match if the translation was done by a translator, or a
machine-generated match if the translation is generated by a program.

merge
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Combining information of either two dictionaries or two Translation Memory databases. When merging dictionaries, OpenTM2 preserves the
structure of the destination dictionary.

model dictionary
An already existing dictionary whose structure can be taken as a sample when creating a new dictionary.

model folder
An already existing folder whose properties can be taken as a sample when creating a new folder.

new terms list
A list of all the terms found in the documents being analyzed but not found in the selected dictionaries during analysis. New terms lists can be
used to update dictionaries and exclusion lists. New terms lists can be edited, that is, terms can be deleted, moved to a dictionary, or to an
exclusion list.

organize
Internal restructuring of frequently changed dictionaries and Translation Memory databases to shorten search times.

original document
The source of the document that you translate. You cannot edit this document but you can display it and use it for comparison or checking
purposes.

postediting
Editing an already translated document. Any changes cause an automatic update of the already translated segments in the Translation
Memory.

properties
A summary of the different characteristics of a folder or a document, such as a description, the markup language used in documents, and
references to Translation Memory databases and dictionaries.

replacement match
An exact match where only a number or date differs. It is displayed in the "Translation" window with a preceding [r].
Example:
Document text:

This happened in 1998.
TM proposal:

This happened in 1999.
In this example, the date in the TM proposal (1999) is automatically changed to the date in the document text (1998).

reversing
Turning source segments contained in a Translation Memory into target segments and vice versa.

revision marks
Characters at the beginning and end of a segment that can be individually defined and indicate that the enclosed segment has been
translated from scratch, or by copying a translation proposal and changing it, or by copying a proposal without changing it.

search
In the "Look up a Term" window, you can search for terms in a dictionary using predefined search criteria and user-definable dictionary filters.
See also automatic lookup.

segment
A translation unit produced during analysis. It is usually a sentence, part of a sentence, an element of a list, or a citation.

sense level
Part of a dictionary entry. Contains semantic variations of a headword such as varying areas of meaning and usage.

SGML
Standard Generalized Markup Language.

shared translation material
A dictionary or Translation Memory file located on a shared disk. It can be concurrently accessed by all OpenTM2 users who are connected to
the same LAN.

source document
See original document.

spellcheck
A proofreading aid to identify unrecognized or misspelled words in translation documents. Lists possible corrections for misspelled words.

Standard Generalized Markup Language (SGML
A set of rules that allows the format specification of a markup language independent of any individual processing system. The external file
formats created during export are based on SGML.
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stem
The part of an inflected word that remains unchanged except by phonetic changes or variations throughout an inflection.

subject code
Abbreviation for a particular subject area a translation applies to.

tag
Statement used to determine the format of a document file. Is contained in a markup table.

target document
See translation document.

target level
Contains all information applying to one translation variant of a headword, such as definition and usage.

template
Dictionary entry information on all levels (entry, homonym, sense, and target) relating to one specific translation of a headword.

terminology list
A generic term for the following types of lists: exclusion lists, found terms lists, and new terms lists.

translation document
The document that you translate.

Translation Environment
Environment where the actual translation is performed. It consists of a window where you can edit the document file, a window with proposals
from the associated Translation Memory, and a window with translations for terms in the document. All translation proposals can be copied
into the translation document.

Translation Memory
A database that contains previously translated segments added during translation and analysis.

Translation Memory databases
More than one Translation Memory .

translation proposal
The translation of a segment found in a Translation Memory during translation, where the source segment is identical (exact match) or
almost identical (fuzzy match) to the current segment.

user exit
A point in an OpenTM2-supplied program at which a user exit routine may be given control.
A programming service provided by an software product that may be requested during the execution of an application program for the service
of transferring control back to the application program upon the later occurrence of a user-specified event.

view details
Contents of the list windows displayed in the main window. You can define how detailed the contents of these lists is to be displayed. The
default is to display only the names of the individual list items.

word count
Utility to count words (words to be translated, words already translated, markup tags) in original documents or translation documents.

workbench
The OpenTM2 main window.
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